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Legal Notice
For information about legal notices, trademarks, disclaimers, warranties, export and other use restrictions, U.S. 
Government rights, patent policy, and FIPS compliance, see https://www.microfocus.com/en-us/legal.

© Copyright 2008 - 2025 Open Text.

The only warranties for products and services of Open Text and its affiliates and licensors (“Open Text”) are as may be set 
forth in the express warranty statements accompanying such products and services. Nothing herein should be construed as 
constituting an additional warranty. Open Text shall not be liable for technical or editorial errors or omissions contained 
herein. The information contained herein is subject to change without notice.
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About This Guide

This OpenText™ Endpoint Management Software Distribution Reference includes conceptual and 
task-based information to help you effectively manage software distribution in your Endpoint 
Management system. 

Audience
This guide is intended for Endpoint Management administrators.

Feedback
We want to hear your comments and suggestions about this manual and the other documentation 
included with this product. Please use the User Comments feature at the bottom of each page of the 
online documentation.

Additional Documentation
Endpoint Management is supported by other documentation (in both PDF and HTML formats) that 
you can use to learn about and implement the product. For additional documentation, see the 
Endpoint Management documentation Web site.
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1 1Basic Concepts

OpenText™ Endpoint Management provides great flexibility in distributing software. You can 
distribute applications and individual files, or simply make modifications to existing files on a device.

The following sections contain additional information that is important as you begin creating and 
managing bundles to distribute software:

 Section 1.1, “Bundles,” on page 11
 Section 1.2, “Bundle Group,” on page 11
 Section 1.3, “Folder,” on page 12
 Section 1.4, “Actions,” on page 12
 Section 1.5, “Action Sets,” on page 12
 Section 1.6, “Assigning Bundles,” on page 17

1.1 Bundles
Bundles are used to configure and manage applications and to distribute software. A bundle consists 
of all the files, configuration settings, installation instructions, and so forth required to deploy and 
manage the application or files on a device. 

Bundles are categorized into various types based on the device operating system and the 
functionality required. 

You can use Endpoint Management Console to create the following bundles:

 Windows Bundle: Allows you to configure and manage applications on Windows devices.

To create a software bundle, you use the Create New Bundle Wizard in Endpoint Management 
Console. For more information on using Endpoint Management Console, see Chapter 2, “Creating 
Bundles,” on page 19.

The sections in this guide provide conceptual and task-based information to help you effectively 
manage software distribution in your Endpoint Management system. You can also use the Online 
Help system for information about creating bundles.

1.2 Bundle Group
A bundle group lets you logically group the bundles. You can add bundles as members of a bundle 
group. Creating bundle groups eases administration efforts by letting you assign the group, rather 
than each individual bundle, to devices. For more information on bundle groups, see Chapter 4, 
“Managing Bundle Groups,” on page 39.
Basic Concepts 11



1.3 Folder
A folder is an organizational object. You can use folders to structure your bundles and bundle groups 
into a manageable hierarchy. For example, you might want a folder for each type of bundle. Or, if 
applications are department- specific, you might want a folder for each department (Accounting 
Department folder, Payroll Department folder, and so forth).

1.4 Actions
An action is a part of an activity that is carried out during application management. Actions enable 
you to perform tasks such as copying files, creating directories, and installing files on managed 
devices. For more information, see “Actions” on page 47.

To Create an action during the bundle creation process: In the Bundle Creation Wizard, select the 
bundle category based on the action that you want to add to the bundle. For more information, see 
“Creating Bundles” on page 19.

To Create an action after a bundle is created:  

1 On the Bundles page, click the Actions tab
2 Click the relevant action set tab.
3 Click the Add drop-down list, and then select the action you want. For more information, see 

“Actions” on page 47

1.5 Action Sets
Action sets help users manage the application, based on the operations performed during 
application lifecycle management. You can group actions under various action sets.

The Actions panel displays the action sets available for the selected bundle. You can use the 
following action sets, based on the bundle type:

 Section 1.5.1, “Distribute,” on page 13
 Section 1.5.2, “Install,” on page 13
 Section 1.5.3, “Launch,” on page 14
 Section 1.5.4, “Repair,” on page 15
 Section 1.5.5, “Uninstall,” on page 15
 Section 1.5.6, “Terminate,” on page 16

The Distribution, Install, and Launch action sets run in sequence, when a bundle runs.The order of 
execution is as follows: Distribute, Install and Launch. The Repair, Uninstall, and Terminate action 
sets are performed based on user requests through bundle options.
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1.5.1 Distribute
The Distribute action set distributes the content associated with all bundle actions. Within this 
action set, the default action of Distribute Files distributes the content. The actions that can have 
content are Install MSI, Install MSP, Install Files, and Install Directory.

You can add actions to this action set, in addition to the default action of Distribute Files.The added 
actions are executed only after the default action is executed. 

When you create or modify a bundle, you can click Add on the Distribute page to configure actions 
to be performed after the distribution of content. Some of the available actions include Launch 
Executable, Launch Java Application, Prompt User, and Run Script.

The distribution of the content for each assignment is managed through the distribution . For 
information about the distribution , see Step 5 on page 140.

1.5.2 Install
The Install action set installs the application associated with the bundle. When you create or modify 
a bundle, you can click Add on the Install page to configure actions associated with the installation 
activities of an application.

Some of the additional actions you can use during installation include Install Files, Install Directory, 
Registry Edit, Edit INI File, Edit Text File, Start/Stop Service, End Process, and Reboot/Shutdown.

For more information about the Install actions, see Chapter 6, “Actions,” on page 47.

Install Options
The Install Options dialog box allows you to specify how often the install actions associated with the 
bundle are performed on the managed devices. If the install action set or its options are modified 
and the bundle is re-published, then when the bundle is installed or launched, the install action set is 
invoked again, even if it has been set to install only once. 

1 When you create or modify a bundle, click Options on the Install page. 
2 Select the Install Frequency, based on the number of times you want to execute the Install 

action set:
Install once per device: Executes the Install action set only once on the managed device.
Configuration changes in the action set result in re-execution of this action set. 
Install once per user per device: Executes the Install action sets once for each user on each 
managed device. This option is applicable only for Windows devices. 
Install always: Executes the Install action set each time the bundle runs.

3 Select Download Options to specify whether to allow users to postpone performing the Install 
actions of the bundle and to specify the number of allowed postponements: 
 Always allow postpones: Allows the user to postpone the installation any number of 

times.
 Never allow postpones: Prevents the user from postponing the installation.
 Limit postpones to: Specify the number of times that the user can postpone the 

installation.
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You manage the execution of the Install action set for each assignment through the Install 
Immediately after Distribution option in the Bundle Distribution dialog box. For information about 
the distribution, see “Distribution Schedule:” on page 140.

1.5.3 Launch
You use the Launch action set to launch an application that is associated with the bundle. When you 
create or modify a bundle, you can click Add on the Launch page to configure actions that launch the 
application. Some of the most frequently used actions associated with the launch activities include 
Launch Executable, Run Script, Launch Java Application, and Launch Thin Client Application.

Launch Options 
The Launch Options dialog box allows you to specify how often the Launch actions associated with 
the bundle are performed on the managed devices. By default, the Launch actions occur based on 
the bundle’s or when the user launches the bundle by using its shortcut from the application 
window, desktop, and so forth). If the launch action set or its options are modified and the bundle is 
re-published, then when the bundle is launched, the launch action set will be invoked again even if it 
has been set to launch once.

1 When you create or modify a bundle, click Options on the Launch page to navigate to the 
Launch Options dialog box.

2 Select the Run once check box to specify the bundle’s Launch actions. If you do not select this 
option, the Launch actions are performed each time a user launches the application contained 
in the bundle. 
When you select the Run once check box, other Launch options are enabled. 
Select the relevant Launch options:
 For each device: Select this option to launch the bundle’s actions once on each managed 

device.
 For the first user that logs in: Select this option to launch the bundle’s actions once on 

each managed device, when the first user logs in to that device. If subsequent users log in 
to the device, the action set is not launched. When you select this option, the bundle’s icon 
is removed from the device’s application window, desktop, and so forth.
This option is applicable only for Windows devices.

 For every user that logs in: Select this option to launch the bundle’s actions once for every 
user that logs in to the device. 
This option is applicable only for Windows devices.

You manage the execution of the Launch action set for each assignment through the Launch or 
through the Launch Immediately after Installation option in the bundle distribution . For information 
about the Distribution, see “Distribution Schedule:” on page 140.
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1.5.4 Repair
You use the Repair action set to repair the installation of a specific application. When you execute 
this action set, the default action of Repair Install Actions triggers the execution of the Install and 
Launch action sets. 

You can add actions such as Repair Bundle to this action set in addition to the default Repair Install 
Actions. The added actions are executed only after the default action is executed. 

NOTE: The Repair action set has no options.

1.5.5 Uninstall
You use the Uninstall action set to uninstall an application. When you execute this action set, the 
install operations of the Install action set are reversed by the default uninstall action of Undo Install 
Actions. 

You can add actions such as Uninstall Bundle to this action set, apart from the default action Undo 
Install Actions. The added actions are executed only after the default action is executed. 

If a bundle contains an MSI-based installation, the uninstallation is simple as Endpoint Management 
extracts the uninstall command from the MSI and places it under Uninstall. However, for installations 
that are not MSI based, you have to create one or more Actions under Uninstall for the Uninstall to 
happen. The original Undo Install Actions runs the bundle’s Install actions in reverse order, which will 
not function here. You have to mark the action and click on Disable in the menu. Hence, it is 
recommended that you enable uninstall via Uninstall Options.

Uninstall Options
You can enable the user on the managed device to uninstall the application. You specify the details 
in the Uninstall Options dialog box:

1 When you create or modify a bundle, click Options on the Uninstall Page to navigate to the 
Uninstall Options dialog box.

2 Select the Enable Uninstall check box to enable the uninstallation of the application from the 
device. 
For example, if a bundle is already installed on a device, you can select Enable Uninstall to 
uninstall the bundle from the device.
The other uninstall options are enabled only when you select the Enable Uninstall check box.

3 Select the Uninstall options:
1. Select one of the following options to specify if the user should be allowed to uninstall or 

cancel the uninstallation of an application on a device by choosing one of the following:
 Allow user to perform uninstall: Enables users to remove the application from their 

devices. 
 Display message to the user before uninstalling the application:  displays a message 

to the warn the user that the application will be uninstalled from the device. 
This option is applicable only on Windows devices.
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 Allow user to cancel the uninstallation of the application:  Enables the user to cancel 
the uninstallation of the application. 
You can enable this option only if the Display message to the user before uninstalling 
the application option is enabled. This option is applicable only on Windows device.

2. Under Blocked Assignment Options select Uninstall application to uninstall a blocked 
application from the device.

3. Select any additional uninstallation options that you want:
 Uninstall application if not used within _days :Automatically removes the 

application, if it is not used within the specified number of days (the default period is 
30 days).

 Ignore chained dependencies:  Enables uninstallation of a dependent application that 
is referenced by two or more applications. For example, assume that there are three 
applications - A, B, and C- where C is the dependent application, A installs application 
C, and application B uninstalls application C. Application C is uninstalled only if Ignore 
Chained Dependencies is selected.

 Do not uninstall application on unassignment:  Prevents an application from being 
uninstalled after it is unassigned from the device or user.

The Undo Install Actions option is available, only after you select Enable Uninstall in the Uninstall 
Options dialog box. Click Undo Install Actions on the Uninstall page to go to the Undo Install Actions 
dialog box.

1.5.6 Terminate
You use this action set to stop the execution of an application that is running because of actions in 
the Launch action set. When you execute this action set, the launch operations are reversed by the 
default Terminate Application action.

You can add actions to this action set, in addition to the default Terminate Application action. The 
added actions are executed only after the default action.

Terminate Options
The Terminate Options dialog box allows you to enable or disable the Terminate action set. 

1 When you create or modify a bundle click Options on the Terminate page to go to the Terminate 
Options dialog box.

2 Select the Enable Terminate check box to terminate the actions of the bundle.
The Terminate action set is applicable only for Windows bundles. This action set is enabled by 
default.
The Terminate Application option is available only after you select the Enable Terminate check 
box in the Terminate Options dialog box.

1. Click OK to undo all operations that are performed in the Launch action set.
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2. If you want to display a message to users before terminating an application, click Terminate 
Application Prompt on the Terminate page to go to the Terminate Application Prompt 
dialog box.

3. Specify the information you want users to see before terminating the application, then 
click OK.

1.6 Assigning Bundles 
You can assign bundles to devices. When you assign a bundle to a device, the bundle is available to 
all users who log in to the assigned device.

For more information on assigning bundles and bundle groups to users and devices, see Chapter 9, 
“Managing Bundle Assignments,” on page 139.
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2 2Creating Bundles

A bundle consists of all the files, configuration settings, installation instructions, and so forth 
required to deploy and manage the application or files on a device. 

Endpoint Management lets you create bundles by using Endpoint Management Console.

The following sections contain step-by-step instructions about creating bundles by using Endpoint 
Management Console:

 Section 2.1, “Installing Console Helper,” on page 19
 Section 2.2, “Creating Windows Bundles,” on page 19

2.1 Installing Console Helper
For more information, see Installing Console Helper in Endpoint Management Console Reference.

2.2 Creating Windows Bundles
A Windows bundle lets you distribute a Microsoft* Windows Installer (MSI) package, Microsoft 
Windows Software Patch (MSP) package, thin-client application, or other Windows-based 
applications to a Windows device.

You can use Endpoint Management Console to create bundles. The following procedure explains 
how to create a bundle using Endpoint Management Console.

To create a Windows bundle:

1 In Endpoint Management Console, click the Bundles tab.
2 In the Bundle list, click New, then click Bundle to display the Select Bundle Type page.
3 Select Windows Bundle, then click Next to display the Select Bundle Category page.
4 Select the desired bundle category:

Copy Directory: Copies a source directory to the specified location on the managed device.
Copy Files: Copies files to the specified location on the managed device.
Create/Delete Directory: Creates or Deletes a directory on the managed device.
Install Directory: Uploads the contents of a directory and its sub-directories to the Endpoint 
Management content system and then installs them to the specified destination path on the 
managed device. By default, the content is replicated to all primary servers.
Install Files: Uploads the files to the Endpoint Management content system and then installs 
them to the specified destination path on the managed device. By default, the content is 
replicated to all primary servers.
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NOTE: To add link or shortcut files, in Console, when you enter *.lnk as the File Name, the 
available list of link and shortcut files are displayed. After you select the required file, Endpoint 
Management uploads only the link file, instead of the executable to which the file links.

MSI Application: An application that is packaged as a .msi file so that it can be installed by the 
Microsoft Windows Installer program.
MSIX Application:  An application that is packaged as a .msix file so that it can be installed by 
the Microsoft Windows Installer program.
MSP Application: An application patch that is packaged as a .msp file so that it can be applied 
by the Microsoft Windows Installer program.
Simple Application: An example of a Simple Application would be launching Windows Note 
pad. Typically, Simple Applications requires Endpoint Agent to copy a few files to the 
workstation or make a few changes to the workstations registry, INI files, environment variables, 
and so forth. 
Thin-Client Application: An application, running on a terminal server, that is accessed through a 
terminal server client session (either RDP or ICA). 
Web Application: An application that is launched by using a URL in a Web browser.

5 Click Next to display the Define Details page, then fill in the fields:
Bundle Name: Provide a name for the bundle. The bundle name must be different than the 
name of any other item (bundle, group, folder, and so forth) that resides in the same folder. The 
name you provide displays in Endpoint Management Console and the Endpoint Agent (on 
managed devices).
For more information, see “Naming Conventions in Endpoint Management Console” in the 
Endpoint Management Console Reference.
Folder: Type the name or browse to and select the Endpoint Management Console folder 
where you want the bundle to reside. The default path is the context from where the bundle 
creation wizard is invoked. For example, if you choose to create a new bundle from the bundles 
page, the default folder path is /bundles. However, if you choose to create a bundle from with 
a bundle folder named folder1, the default folder path is /bundles/folder1. You can also 
create additional folders to organize your bundles.
Icon: OpenText Configuration Management lets you select an icon that s see during installation 
of a particular bundle. This icon applies only to the icon displayed by Endpoint Agent on the 
managed device. Endpoint Management Console uses default icons to represent the different 
bundles.
Before an icon can be selected, you need to install Console Helper. 

To select an icon, click , allow browser to launch Console Helper, and then browse and select 
the icon you want to display on managed devices. 
If the file contains multiple icons, using Console Helper you can select the required icon.
If you do not specify an icon, a default icon is used.

NOTE: All icons for bundles need to have a color depth of 256. True color depth for icons is not 
supported.

Description: Provide a short description of the bundle's contents. This description displays in 
Endpoint Management Console and in the Endpoint Agent.
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6 Click Next, then skip to the appropriate step, depending on which bundle category you chose in 
Step 4:
 Copy Directory: Continue with Step 7 on page 21.
 Copy Files: Continue with Step 8 on page 21.
 Create/Delete Directory: Continue with Step 9 on page 22.
 Install Directory: Continue with Step 10 on page 22.
 Install Files: Continue with Step 11 on page 23.
 MSI Application: Continue with Step 12 on page 24.
 MSP Application: Skip to Step 13 on page 26. 
 Simple Application: Skip to Step 14 on page 26. 
 Thin Client Application: Skip to Step 15 on page 27.
 Web Application: Skip to Step 16 on page 28. 

7 (Conditional) If you are creating an Copy Directory bundle, follow the wizard prompts until you 
reach the Summary page, then skip to Step 17 on page 28. 
Click Help for information about each page or refer to the following table:

8 (Conditional) If you are creating an Copy Files bundle, follow the wizard prompts until you reach 
the Summary page, then skip to Step 17 on page 28. 
Click Help for information about each page or refer to the following table:

Wizard Page and Field Details

Select Directory page > 
Source Directory field

If you have not installed Console Helper on this device, you must do 
so before you can browse for a directory.

Click Browse, and allow browser to launch Console Helper. The Select 
Folder dialog box is displayed, click browse and select the directory to 
copy.

Select Directory page > 
Destination Directory 
field

Specify the destination path on the device where you want to copy 
the directory.

Select Directory page > 
Copy Option

Select a copy option from the list. For more information on the 
options, click Help.

Select Directory page > 
Attributes field

Select one or more of the following attributes:

Hidden: Select the Hidden check box to specify that the directory is 
hidden after being copied.

Read-only: Select the Read-only check box to specify that the 
directory is read-only after being copied.
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9 (Conditional) If you are creating an Create/Delete Directory bundle, follow the wizard prompts 
until you reach the Summary page, then skip to Step 17 on page 28. 
Click Help for information about each page or refer to the following table:

10 (Conditional) If you are creating an Install Directory bundle, follow the wizard prompts until you 
reach the Summary page, then skip to Step 17 on page 28. 
Click Help for information about each page or refer to the following table:

Wizard Page and Field Details

Select Files page > File 
field

Click Add, allow browser to launch Console Helper. The Select Files 
dialog box is displayed, specify the files you want to copy to the 
device, then click OK. Repeat this step as many times as necessary to 
copy the desired files.

If the Console Helper is not installed on this device, you must install it 
before you can browse for file paths.

Select Files page > 
Destination Directory 
field

Specify the destination directory on the device in which you want to 
copy the file.

Select Files page > Create 
Shortcuts for Source Files

Select the Create Shortcuts for Source Files option to create shortcut 
icons for the source file on the destination directory. The source files 
are not copied to the destination directory. 

Select Files page > Copy 
Option

Select a copy option from the list. For more information on the 
options, click Help.

Select Files page > 
Attributes field

Select one or more of the following attributes:

Hidden: Select the Hidden check box to specify that the file is hidden 
after being copied.

Read-only: Select the Read-only check box to specify that the file is 
read-only after being copied.

Wizard Page and Field Details

Select Directory page > 
Action Type field

Select one of the following:
 Create Directory:  Creates a directory on the managed device 

when the action is performed.
 Delete Directory:  Deletes a directory on the managed device 

when the action is performed.

Select Directory page > 
Directory Name field

Specify the complete path of the directory you want to create or 
delete on the managed device. This path must be resolved by the 
device on which the bundle is run.
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11 (Conditional) If you are creating an Install Files bundle, follow the wizard prompts until you 
reach the Summary page, then skip to Step 17 on page 28. 
Click Help for information about each page or refer to the following table:

Wizard Page and Field Details

Select Directory page > 
Source Directory field

Click , and allow browser to launch Console Helper. The Select 
Directory dialog box is displayed, click browse and select the file to 
upload. By default, the content is encrypted and compressed before it 
is distributed to assigned devices. However, If you do not want to 
compress or encrypt the content, select the Do not compress or 
encrypt uploaded content option. 

The Status field displays each file’s upload status.

Select the Upload all files within the source directory as a single 
package option to enable all the files within the specified source 
directory to be uploaded as a single content.

If Console Helper is not installed on this device, it must be installed 
before you can browse to and upload files to be copied.

Select Directory page > 
Copy Option

Select a copy option from the list. For more information on the 
options, click Help.

Select Directory page > 
Attributes field

Select one or more of the following attributes:

Hidden: Select the Hidden check box to specify that the directory is 
hidden after being copied.

Read-only: Select the Read-only check box to specify that the 
directory is read-only after being copied.

Wizard Page and Field Details

Select Files page > File 
field

Click Add, allow browser to launch Console Helper. The Select Files 
dialog box is displayed, specify the files you want to install on the 
device, then click Upload. Repeat this step as many times as necessary 
to copy the desired files. 

By default, the content is encrypted and compressed. If you do not 
want to compress or encrypt the content, select the Do not compress 
or encrypt uploaded content option. 

Click OK to upload the files. The File option lists all the uploaded files 
and the size of the files.

If Console Helper is not installed on this device, you must install it 
before you can browse for file paths.

Select Files page > 
Destination Directory 
field

Specify the destination directory on the device in which you want to 
install the file.

Select Files page > Copy 
Option

Select a copy option from the list. For more information on the 
options, click Help.
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12 (Conditional) If you are creating an MSI Application bundle, follow the wizard prompts until you 
reach the Summary page, then skip to Step 17 on page 28. 
Click Help for information about each page or refer to the following table:

Select Files page > 
Attributes field

Select one or more of the following attributes:

Hidden: Select the Hidden check box to specify that the file is hidden 
after being copied.

Read-only: Select the Read-only check box to specify that the file is 
read-only after being copied.

Wizard Page and Field Details

Select .msi File page > 
Upload .msi file for 
normal install field

Use this option if you want the .msi file copied to the content system 
and then distributed from the content system to assigned devices. 
This is referred to a normal install because Endpoint Agent copies the 
.msi file to the managed device’s local drive and then the Microsoft 
Windows Installer program installs the application from the local 
.msi file. 

Click , allow browser to launch Console Helper. The Select .msi File 
dialog box is displayed. Click Browse to select the .msi file to upload. 
Select the Include all files in and below the directory of this file 
option to include all the supporting files that are within the directory 
containing the .msi file and the subdirectories within it. 

NOTE: By default, Endpoint Management Console has a 30-minute 
timeout value. If you leave Endpoint Management Console idle on 
your computer for more than 30 minutes, you are prompted to log in 
again before continuing. Because the upload process can take 
considerable time for a large .msi file, the default timeout value 
does not apply for this page.

Select .msi File page > 
Enter UNC path of .msi 
file for network install 
field

Use this option if you want the Microsoft Windows Installer program 
to install the application from the .msi file on a network location. 
You must specify the complete path to the .msi file to use as the 
source file during distribution to the workstation.

You can use a mapped drive or UNC path. If you use a drive mapping, 
you must ensure that all workstations have the same drive mapped to 
the source location. For this reason, we recommend that you specify a 
UNC path. 

After you create the MSI bundle, you cannot change the .msi 
filename; however, you can change the path to the .msi file. If you 
change the .msi filename, the installation fails.

Select .msi File page > 
Install Parameters field

Click  to display the Install Parameters dialog box, then specify the 
desired parameters. For more information, click the Help button or 
see Section A.1, “Install Parameters,” on page 179. 

Wizard Page and Field Details
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Select .msi File page > 
Unistall Parameters field

Click  to display the Uninstall Parameters dialog box, then specify 
the desired parameters. For more information, click the Help button 
or see Section A.2, “Uninstall Parameters,” on page 181. 

Select .msi File page > 
Repair Parameters field

Click  to display the Repair Parameters dialog box, then specify the 
desired parameters. For more information, click the Help button or 
see Section A.3, “Repair Parameters,” on page 182. 

Select .msi File page > 
MSI Properties field

The MSI package contains the property values that were defined 
during the administrative installation of the application. These 
property values determine the way the Microsoft Windows Installer 
installs the application to the workstation. In some cases, you might 
want to change one or more of the property values. For example, a 
property value might define the default location for a ’s work files. By 
adding the property to the list and changing the property’s value, you 
can override the default location defined in the MSI package.

If necessary, you can add public properties that were not included in 
the MSI package. When doing so, you should be careful to add only 
those properties that are valid for the package.

To override a property value, you change the property value and add 
the property to the Properties list so that Application Launcher knows 
to use that property value rather than the one defined in the MSI 
package. To do so, click Add to display the MSI Properties dialog box. 
In the Name field, select the property whose value you want to 
override, specify the new value in the Value field, then click OK to add 
the property to the MSI Properties list.

To modify a property that is in the MSI Properties list, select the 
property, click Edit, modify the value data, then click OK.

To remove a property from the MSI Properties list, select the 
property, then click Remove. Deleting the property causes future 
installations of the application to use the property value defined in 
the MSI package.

Select .msi File page > 
Select Transforms File 
field

Click Add to browse to and select the desired . You can upload the or 
you can specify its location.

Different groups within an organization often use the same 
application, but that does not mean they require the same feature 
set. One of the benefits of Windows Installer is that if you have 10 
groups needing 10 different feature sets or other alterations for the 
same application, you can deploy the same MSI package to all 10  
groups, but with a different (MST) applied for each group.

A is a collection of changes applied to an MSI installation. It contains 
all modification information, such as whether features are installed; 
how they are installed; which files, shortcuts, and registry entries are 
included; and Add/Remove Programs applet information.

Wizard Page and Field Details
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13 If you are creating an MSP Application bundle, follow the wizard prompts until you reach the 
Summary page, then skip to Step 17 on page 28.
Click Help for information about each page or refer to the following table:

14 If you are creating Simple Application bundle, follow the wizard prompts until you reach the 
Summary page, then skip to Step 17 on page 28.
Click Help for information about each page or refer to the following table:

Select Command page > 
Executable to run field

The Select Command page lets you specify an optional executable to 
run after the .msi file installs. Click Browse to browse for and select 
the executable to run.

If the executable is installed in the Program Files directory on the 
managed device, you must use macros as follows:
 On 32-bit managed device: ${ProgramFiles}\filename.
 On 64-bit managed device: 

${ProgramFiles32}\filename.

If you have not installed Console Helper on this device, you must do 
so before you can browse to and upload files.

Wizard Page and Field Details

Select .msp File page > 
Upload .msp file for normal 
install field

Use this option if you want the .msp file copied to the content 
system and then distributed from the content system to assigned 
devices. This is referred to a normal install because Endpoint Agent 
copies the .msp file to the managed device’s local drive and then 
it is installed from the local .msp file. 

Select .msp File page > Enter 
UNC path of .msp file for 
network install field

Use this option if you want to install from the .msp file on a 
network location. You must specify the complete path to the .msp 
file to use as the source file during distribution to the workstation.

You can use a mapped drive or UNC path. If you use a drive 
mapping, you must ensure that all workstations have the same 
drive mapped to the source location. For this reason, we 
recommend that you specify a UNC path. 

After you create the MSP bundle, you cannot change the .msp 
filename; however, you can change the path to the .msp file. If 
you change the .msp filename, the installation fails.

Select .msp File page > 
Command Line Parameters 
field

After you select the .msp file, the Command Line Parameters field 
is automatically populated, for example /p patch_package /qn 
where /p designates a patch file, patch_package specifies the 
.msp file, and /qn specifies an installation with no  interface 
(silent installation). To install a .msp file, you should normally use 
the /qn option. 

You can, however, specify additional options. For more 
information, see the MSDN Web site (http://
msdn2.microsoft.com/en-us/library/aa372866.aspx).

Wizard Page and Field Details
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15 If you are creating a Thin Client Application bundle, follow the wizard prompts until you reach 
the Summary page, then skip to Step 17 on page 28.
Click Help for information about each page or refer to the following table:

Wizard Page and Field Details

Enter the Command to Run 
page > Command field

Specify the command to launch the application. You should include 
the full path to the executable in case the executable is not in the 
device’s search path. This path, whether the application is on the 
device’s local drive or a network resource, must be relative to the 
device.

For example, if the executable file is on the device’s local drive, you 
would specify something like c:\winnt\notepad.exe. If the 
executable file is on a network resource, you would specify 
something like j:\apps\notepad.exe (if all s will have J: 
mapped to the location) or 
\\server1\vol1\apps\notepad.exe.

Enter the Command to Run 
page > Command Line 
Parameters field

Specify any command line parameters that need to be passed to 
the executable.

Endpoint Agent passes the parameters exactly as they are 
specified. Therefore, the parameter syntax you use must exactly 
match the syntax the executable requires. For example, if 
word.exe has a /f=filepath parameter that requires paths 
with spaces to be enclosed in quotation marks, you would specify 
the following:

/f="c:\my docs\sample.doc"
Enter the Command to Run 
page > Working Directory 
field

Specify the path to the directory you want the application to use 
for its working files.

Wizard Page and Field Details

Configure Thin Client Details 
page > ICA Session: 
Published Application Name 
field

Type the published application name exactly as it is defined in 
Citrix*.

Configure Thin Client Details 
page > ICA Session: Servers 
Hosting the Application field

Add the Citrix servers that host the application. To add a server, 
specify the server’s IP address or hostname, then click Add.

The order in which the servers are listed is the preferred order for 
launching. You can use the Move Up and Move Down buttons to 
change the order if necessary.

Configure Thin Client Details 
page > RDP Session: 
Terminal Server Address 
field

Type the terminal server’s IP address or hostname.
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16 If you are creating a Web Application bundle, follow the wizard prompts until you reach the 
Summary page, then skip to Step 17 on page 28.
Click Help for information about each page or refer to the following table:

17 Review the information on the Summary page, making any changes to the bundle settings by 
using the Back button as necessary.

18 Skip to Step 20 to create the published version of the bundle.
19 (Conditional) Select the Create as Sandbox option to create a sandbox-only version of the 

bundle. 

Configure Thin Client Details 
page > RDP Session: Server 
Port field

If the terminal server is not using the default port 3389, specify the 
correct port number.

Configure Thin Client Details 
page > RDP Session: Server 
Domain field

If the terminal server is part of a Windows NT* domain or an 
Active Directory* domain, enter the domain name. If the ’s name 
and password in the domain matches the  name and password in 
eDirectory, the  is not prompted to log in to the terminal server 
when launching the application.

Configure Thin Client Details 
page > RDP Session: 
Application Path field

Specify the path to the application’s executable file from the 
perspective of the terminal server.

Configure Thin Client Details 
page > RDP Session: 
Application Working 
Directory field

Specify the path to the directory you want the application to use 
for its working files.

Configure Thin Client Details 
page > RDP Session: Color 
Depth field

Select the number of colors for the RDP client session. You can 
select 256 Colors, High Color (15 bits), High Color (16 bits), or True 
Color (24 bits). The default is True Color (24 bits).

Configure Thin Client Details 
page > RDP Session: Screen 
Size field

If you want the RDP client session to use the entire desktop area, 
select Operate in full screen mode. Otherwise, select Use 
specified screen size and manually set the width and height (in 
pixels).

Configure Thin Client Details 
page > RDP Session: 
Advanced Settings for 
redirection field

Select the settings such as drivers, printers, serial ports, and smart 
cards that you want to map to the remote desktop machine. 

Wizard Page and Field Details

Enter URL page > URL field Specify the location (URL) of the Web application. The URL should 
point to the primary file for the Web application or to a Web page 
that allows access to the Web application.

Click the Test URL button to test the URL.

Wizard Page and Field Details
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A sandbox-only version of a bundle enables you to test the bundle on your device before 
actually deploying it. For more information on a sandbox-only bundle, see Chapter 7, 
“Understanding Bundle Change Management,” on page 121.

20 (Conditional) Select the Define Additional Properties option to display the bundle’s Action page 
after the wizard completes. You can use the various tabs to edit the bundle’s assignments, 
system requirements, actions, settings, and content replication settings.

21 Click Finish to create the bundle as configured per settings on the Summary page.
When you click Finish, the bundle is created but it does not have devices assigned, and group 
membership. At some point in the future, you need to configure additional options for the 
bundle by continuing with Section 9.1, “Assigning Existing Bundles to Devices,” on page 139.
For information on the viewing the bundle information, see Chapter 3, “Viewing the Bundle 
Information,” on page 31.
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3 3Viewing the Bundle Information 

When you create a bundle, the bundle is listed on the Bundles page of the Endpoint Management 
Console. 

For more information on the created bundle, review the following sections:

 Section 3.1, “Understanding the Bundle Page,” on page 31
 Section 3.2, “Bundle Summary Page,” on page 31

For more information on the Dashboard tab, see Accessing the Bundle Dashboard.

3.1 Understanding the Bundle Page
The Bundles page displays the following information: 

 Status: Gives a quick indication of message logging and enforcement status of the bundle. The 
status icons are:

 - No warning or error messages; bundle enforcement succeeded 
 - Warning messages; bundle enforcement succeeded 
 - Error messages; bundle enforcement failed 

 Name: Displays the object’s (bundle, bundle group, or the bundle folder) name. Click the name 
to view or edit the object’s information. 

 Type: Displays the type of the object. For example, a Folder, Bundle Group, Windows Bundle.
 Category: Displays the bundle category selected during the creation of the bundle. For 

example, Copy Directory.
 Enabled: Displays whether the bundle is enabled to be deployed on a device or not. The 

possible values are Yes and No.
 Version: Displays the latest published version of the bundle. However, if the bundle is a 

sandbox-only bundle, it displays Sandbox.
 Has Sandbox: Displays whether the bundle has a sandbox or not. The possible values are Yes 

and No.

3.2 Bundle Summary Page
The Summary page of a bundle displays the following panels:

 Section 3.2.1, “General,” on page 32
 Section 3.2.2, “Message Log,” on page 36
 Section 3.2.3, “Upcoming Events,” on page 37
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3.2.1 General 
The General panel provides a summary of the bundle’s general settings. 

Bundle Type
Displays the type of bundle.

Size
Click Compute to display the size of the content associated with the bundle. To view the correct size 
of the bundle, check for the bundle size information in the bundle summary page after the content 
import is complete. 

When you create a bundle, the bundle's files are imported to the Endpoint Management content 
repository. The import is a server process that can take a while. Until the import is complete, the size 
of the bundle is displayed as 0 (zero). 

Version
Displays the latest published version of the bundle. However, if the bundle is a sandbox-only bundle 
or has a sandbox, it displays Sandbox.

Enabled
Displays whether or not the bundle can be deployed to managed devices. If a bundle is enabled, it 
can be deployed to managed devices.

When you disable a bundle that has already been deployed to a managed device, the bundle icon is 
removed from all the shortcut locations of the device. However, all the actions performed on the 
device prior to the disabling of the bundle remain unchanged. If this bundle is assigned to a new 
device, the bundle shortcut icons are not placed in the device's shortcut locations.

If the bundle is disabled, click Enable to allow it to be deployed.

Number of Errors Not Acknowledged
An error is anything that causes the deployment or installation of the bundle to fail. The number 
displayed indicates the number of unacknowledged errors, which are any errors that you have not 
specifically marked as acknowledged. Unacknowledged errors are displayed in the Message Log 
section. 

Number of Warnings Not Acknowledged
A warning is anything that does not cause the deployment or installation of the bundle to fail, but 
indicates minor problems with the bundle. The number displayed indicates the number of 
unacknowledged warnings, which are any warnings that you have not specifically marked as 
acknowledged. Unacknowledged warnings are displayed in the Message Log section.
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GUID
Displays the bundle’s GUID (global unique identifier), a randomly generated string that provides a 
unique identifier for the bundle. You cannot edit the GUID.

Display Name
Displays the bundle’s name as it appears in Endpoint Management Console and the Endpoint Agent 
(on managed devices). Click Edit to change the name. Changing the name does not cause the bundle 
to be redeployed. It is recommended that you specify a name that is brief and more relevant to the 
end user.

Original Created Date
Displays the timestamp (Month, date, year and time) when the bundle was created and saved for 
the first time. The author of the bundle will also be displayed in this field.

Version Created Date
Displays the timestamp (Month, date, year and time) when the current version of the bundle was 
created. The version created date will be updated only when the bundle version is changed.

Modified Date
Displays the timestamp (Month, date, year and time) when the bundle was modified. The modifier 
name is also displayed in this field. When the version of the policy is updated, then the modified 
date will also be updated.

Description
Displays the bundle’s description, if one was provided when the bundle was created. The description 
appears in Endpoint Management Console and the Endpoint Agent (on managed devices). Click Edit 
to change the description.

It is recommended that you provide enough information to the user by detailing the actions that will 
be performed when the user double-clicks the bundle icon on the device. To view the description on 
the device, the user can right-click the bundle icon and select Properties.

Icon
Determines the shortcut icon that Endpoint Agent displays on managed devices. During creation of 
the bundle, if you specified a custom icon rather than using the standard Endpoint Management 
bundle icon, this field displays the image and name of the custom icon. If you did not specify a 
custom icon, this field is empty and the standard icon is used.

To easily identify the bundle, you could use an icon that represents the application associated with 
the bundle. It is recommended that you upload a .JPG, .PNG, or .BMP format and a square image. 
However, Endpoint Management automatically converts the uploaded icon images to the correct 
format and size.
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Click Edit to change the icon, delete the icon, or add an icon if one is not specified.

To select an icon, click , allow browser to launch Console Helper, and then browse to and select the 
icon you want to display on managed devices. 

If you do not specify an icon, a default icon is used.

Contacts
Displays the contact information (names, phone numbers, and e-mail addresses) of the people who 
you want users to contact with problems or questions about the bundle. The contact information is 
displayed by Endpoint Agent on managed devices.

As the contact information can be viewed by all the users to whom the bundle is assigned, ensure 
that you provide the appropriate contact information.

Click Edit to change the contact information, delete contact information, or add contact information.

Administrator Notes
Displays any information that has been added specifically for Endpoint Management administrators 
to view. The notes are displayed only in Endpoint Management Console.

It is recommended that you provide detailed information related to every aspect of the bundle, 
thereby providing all the required information for administrators. You can specify information that 
will enable other Endpoint Management administrators to decide whether or not they would need 
to use the bundle. You can also specify information such as what is the OS version, whether it’s a 32-
bit or 64-bit bundle, where is it installed (especially if the location is not very common), and whether 
license costs are involved. It is also a good practice to end the note with the date and your name and 
if you have changed an existing bundle, place your changes at the end of the list.

Click Edit to change the notes, add notes, or delete notes. Editing the note does not create a 
sandbox. You can edit the administrator notes for any version of a bundle.

Application Explorer Folder Path
Displays the folder path used by Endpoint Agent when displaying the bundle on the Start menu.

For example, if you specify Applications/Accounting as the path and choose to display the 
bundle on the Start menu, Endpoint Agent creates an Applications/Accounting folder on the 
Start menu and adds the bundle to it. 

You can place multiple bundles in a single folder by specifying the same folder path for each of the 
bundles.

Click Edit to change the folder path, add a folder path, or delete the folder path.
34 Viewing the Bundle Information



Show Bundle Activity
Click Yes to display the bundle activity indicator window during the distribution, installation, repair, 
and uninstallation of a bundle on the managed device. If set to Yes, this window is also displayed for 
actions defined in the Launch Action set. The user on the managed device cannot close this bundle 
activity indicator window. 

On Windows 2000 devices, the control that indicates the progress of the bundle execution on the 
managed device is not displayed in the bundle activity indicator window.

Dependency Bundles
Displays None if there are no bundle dependencies for this bundle. If there are dependencies for this 
bundle, click Display Bundle Dependencies to display a list of additional bundles that are required by 
this bundle.

The list is for viewing only. To change a bundle dependency, switch to the Actions tab, click the 
appropriate action (for example, Install or Launch), then locate the Linked Application Bundle. Select 
the entry and perform the action you want (for example, edit or delete it).

For more information, see “Dependency Bundles” on page 134.

Enable Bundle Ordering
This field allows you to prioritize the way bundles are executed. Bundles with lower order values are 
executed first, followed by those with higher order values. A bundle that has an order value of 1 is 
executed before a bundle with an order value of 2 or 3. If multiple bundles have the same order 
value, the order of execution is based on the alphabetical order of the bundle names or the 
ascending GUID values.

The default value for this field is No. If you select Yes, the value that is set for the bundle order is 0 
and the Wait for previous Bundle execution to complete field is set to No.

Bundle Order
This field determines the order in which bundles are set to run. Multiple bundles can have different 
priorities, based on the order value set. You control the order in which the bundle is started by 
entering a numeric value in the Edit field. A value of 0 to a maximum value of 9999999. The value 0 
has the highest priority.

Content Status
The Content Status field displays the current status of the content on a bundle or policy. The 
following are statuses:

 Available: The content is physically present on a bundle or policy and available for distribution.
 Not Applicable: The content is not uploaded to a bundle or policy.
 In-progress: The content is not yet physically present on a bundle or policy but is currently 

being uploaded.
 Failed: The content set to be hosted on a bundle or policy has failed.
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Wait for Previous Bundle Execution to Complete
Bundles can be executed simultaneously on managed devices based on the priority values. However, 
if the Enable Bundle Ordering field is set to Yes for a bundle with lower priority, the lower-priority 
bundle executes after a higher-priority bundle has finished. The default value for this field is No. The 
bundle priority is based on the order value set in the Bundle Order field.

3.2.2 Message Log 
The Message Log panel displays all unacknowledged messages generated for the object. An 
unacknowledged message is one that you have not yet reviewed and marked as acknowledged.

 Status:  Displays an icon indicating the type of message:  critical,  warning, and  normal. 
 Message: Displays a brief description of the event that occurred.
 Date: Displays the date and time the event occurred.

NOTE: The Message Log panel on the bundle’s sandbox or the older versions page does not display 
any messages. However, the Message Log panel on the bundle’s published version page displays the 
messages of the bundle’s published version, sandbox, and the older versions.

A message remains in the Message Log list until you acknowledge it. You can acknowledge individual 
messages, acknowledge all messages at one time, or view more information about both 
acknowledged and unacknowledged messages. The following table explains how to do these tasks: 

Task Steps Additional Details

Acknowledge a 
message

1. Click the message to display the 
Message Detail Information dialog 
box.

2. Click Acknowledge.

If you decide that you don’t want to 
acknowledge the message, click Finished 
to dismiss the dialog box. This causes the 
message to remain in the Message Log 
list.

Acknowledge all 
messages

1. In the Tasks list located in the left 
navigation pane, click Acknowledge 
All Messages.

View all 
acknowledged or 
unacknowledged 
messages

1. Click the Advanced button to display 
the Edit Message Log page.

In addition to viewing all acknowledged 
and unacknowledged messages, you can 
also view only those messages with a 
specific status or date, view more details 
about messages, and acknowledge 
messages. 

Click the Help button on the Edit Message 
Log page for specific information about 
performing tasks on that page.

Delete a message 1. Click the message to display the 
Message Detail Log dialog box.

2. Click Delete.

Deleting a message completely removes 
the message from your Endpoint 
Management system.
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3.2.3 Upcoming Events
The Upcoming Events panel lists all bundles d to deploy or launch today on all managed devices in 
your Configuration Management Zone. To view the events for another day, click the  icon to select 
a specific day or use the 1, 7, and 31 arrows to view events for the previous or next day, week, or 
month. 

Click a bundle to display or edit its details such as summary, relationship, requirement, actions, or 
settings.

Click a time to view the bundle’s details, including the time the event is d to fire, its type (Date 
Specific, Event, Recurring, etc.), the dates on which the event is d to be performed, and the event’s 
start and end time.

Click  to view the bundle’s assignment details, including the bundle’s folder and its assignments 
(devices or workstations). 
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4 4Managing Bundle Groups

A bundle group lets you group bundles to ease administration and to provide easier assigning and 
scheduling of the bundles in the bundle group.

You can use Endpoint Management Console to create bundle groups. This section explains how to 
perform this task using the Endpoint Management Console.

For information on assigning a bundle group to a device, see Chapter 9, “Managing Bundle 
Assignments,” on page 139.

The following sections contain more information:

 Section 4.1, “Creating Bundle Groups,” on page 39
 Section 4.2, “Renaming or Moving Bundle Groups,” on page 40
 Section 4.3, “Copying the System Requirements of a Bundle Group,” on page 40
 Section 4.4, “Group Members,” on page 41
 Section 4.5, “Deleting a Bundle Group,” on page 42
 Section 4.6, “Adding a Bundle to a Group,” on page 42

4.1 Creating Bundle Groups
1 In Endpoint Management Console, click the Bundles tab.
2 Click New > Bundle Group.
3 Fill in the fields:

Group Name: Provide a name for the bundle group. The name must be different than the name 
of any other item (bundle, group, folder, and so forth) that resides in the same folder. The name 
you provide displays in Endpoint Management Console.
For more information, see “Naming Conventions in Endpoint Management Console” in the 
Endpoint Management Console Reference.
Folder: Type the name or browse to and select the Endpoint Management Console folder 
where you want the bundle to reside. The default is /bundles, but you can create additional 
folders to organize your bundles.
If you want to create the group in another folder, browse to and select the folder. By default, the 
group is created in the current folder.
Description: Provide a short description of the bundle group's contents. This description 
displays in Endpoint Management Console.

4 Click Next to display the Add Group Members page, then specify bundles to be members for the 
group.
You can add any number of bundles to the group. You cannot add other bundle groups to the 
group.
4a Click Add to display the Select Members dialog box.
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Because you are adding bundles to the group, the Select Members dialog box opens with 
the Bundles folder displayed.

4b Browse for and select the bundles you want to add to the group. To do so:

4b1 Click  next to a folder to navigate the folders until you find the bundle you want to 
select. 
If you know the name of the bundle you are looking for, you can also use the Item 
name box to search for the bundle.

4b2 Click the underlined link in the Name column to select the bundle and display its name 
in the Selected list.

4b3 (Optional) Repeat Step 4a and Step 4b to add additional bundles to the Selected list.
4b4 Click OK to add the selected bundles to the group.

5 Click Next to display the Summary page, review the information and, if necessary, use the Back 
button to make changes to the information.

6 (Optional) Select the Define Additional Properties option to display the group’s properties page 
after the group is created. You can then configure additional bundle properties.

7 Click Finish to create the group.

Before the bundle group’s contents are distributed to devices, you must continue with Section 9.2, 
“Assigning a Bundle Group to Devices,” on page 142.

4.2 Renaming or Moving Bundle Groups
Use the Edit drop-down list on the Bundles page to edit an existing object. To access the Edit drop-
down list, you must select an object by clicking the check box next to the object's name in the list.

Depending on the type of object you select, you can rename, copy, or move the selected object. For 
example, if you select a Bundle object, you can rename, copy, and move the bundle. If you select a 
Bundle Group object, you can rename or move the Bundle Group object, but not copy it. If the 
option is dimmed, that option is not available for the selected object type.

Some actions cannot be performed on multiple objects. For example, if more than one check box is 
selected, the Rename option is not available from the Edit menu.

1 In Endpoint Management Console, click the Bundles tab.
2 In the Bundles list, select the box next to the bundle group’s name, click Edit, then click an 

option:
Rename: Click Rename, provide a new name for the folder, then click OK.
Move: Click Move, select a destination folder for the selected objects, then click OK.

4.3 Copying the System Requirements of a Bundle Group
For more information, see Section 4.3, “Copying the System Requirements of a Bundle Group,” on 
page 40.
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4.4 Group Members
This section enables you to manage members in the group.

4.4.1 Adding Members to a Group
To add a member to a group

1 Click Add to display the Select Members dialog box.
2 Browse and select the bundles you want to assign to the group.

You can also use the Item name box to search for the bundle.
3 Click OK to add the selected bundle to the group.

4.4.2 Removing Members from a Group
Select the check box next to the member you want to delete, and Click Remove.

4.4.3 Reordering Members in a Group
To reorder the bundle group member:

1 Select the check box next to the member you want to move.
2 Click Move Up or Move Down to relocate.

4.4.4 Copy Members
Using Copy Member, you can:

Copy a member to an existing group

1. Select Add selected items to an existing Group, and click . 

In the Select Group page, select the required group, and then click OK.
2. In the Copy To Group, click OK.

Copy a member by creating a new group
1. Select Create a new Group to contain the selected items, and specify the following: 

Group Name: Specify the group name.

Folder: Specify the name, or browse to the Endpoint Management folder where you want to 
create the group.

2. Click OK.
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4.4.5 Move Members
Using Move Member, you can:

Move a member to an existing group

1. Select Add selected items to an existing Group, and click  . 

In the Select Group page, select the required group, and then click OK.
2. In the Move To Group, click OK.

Move a member by creating a new group
1. Select Create a new Group to contain the selected items, and specify the following: 

Group Name: Specify the group name.

Folder: Specify the name, or browse to the Endpoint Management folder where you want to 
create the group.

2. Click OK.

4.5 Deleting a Bundle Group
Deleting a bundle group does not delete its bundles. It also does not uninstall the bundles from 
devices where they have already been installed. To uninstall the bundles from devices, you should 
use the Uninstall option for each bundle before deleting the bundle group.

1 In Endpoint Management Console, click the Bundles tab.
2 In the Bundles list, select the check box next to the bundle group (or bundle groups).
3 Click Delete.

4.6 Adding a Bundle to a Group
You can add the bundle to any bundle groups that already exist or you can create a new bundle 
group as part of the assignment process. The bundle inherits the group’s assignments and s, which 
means that you save time by managing one bundle group rather than each individual bundle. Adding 
a bundle to a group is not the same as assigning a bundle to a group (device). For more information 
on assigning bundles to devices, see Assigning Existing Bundles to Devices.

1 In Endpoint Management Console, click the Bundles tab.
2 In the Bundles list, select the check box next to the bundle (or bundles).
3 Click Action > Add to Group.
4 Select Add selected items to an existing group if the group to which you want to add the objects 

already exists.
or
42 Managing Bundle Groups



Select Create a new group to contain the selected items if you need to create a new group for the 
selected objects.

5 (Conditional) If you chose Add selected items to an existing group in Step 4, click Next to display 
the Targets page.
The Targets page lets you select the groups to which you want to add the objects (devices, 
bundles, policies). 
5a Click Add to display the Select Groups dialog box.
5b Browse for and select the groups to which you want to add the objects. To do so:

5b1 Click  next to a folder to navigate the folders until you find the group you want to 
select. 
If you know the name of the group you are looking for, you can also use the Item name 
box to search for the group.

5b2 Click the underlined link in the Name column to select the group and display its name 
in the Selected list.

5b3 Repeat Step 5b1 and Step 5b2 to add additional groups to the Selected list.
5b4 When you are finished selecting groups, click OK.

6 (Conditional) If you chose Create a new group to contain the selected items in Step 4, click Next 
to display the Basic Information page, then fill in the fields:
Name: Provide a name for the group. The group name must be different than the name of any 
other object (group, folder, device,  bundle, policy, and so forth) that resides in the same folder 
and must conform to the Endpoint Management object naming conventions. 
For more information, see “Naming Conventions in Endpoint Management Console” in the 
Endpoint Management Console Reference.
Folder: By default, the group is created in the current folder. If you want to create the group in 
another folder, browse to and select the folder. 
Description: Provide a short description of the group’s purpose or contents.

7 Click Next to display the Summary page, review the information and, if necessary, use the Back 
button to make changes to the information.

8 Click Finish to add the selected objects to the group.
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5 5Managing Folders

A folder is an organizational object. You can use folders to structure your bundles and bundle groups 
into a manageable hierarchy for your Endpoint Management system. For example, you might want a 
folder for each type of bundle or, if applications are department-specific, you might want a folder for 
each department (Accounting Department folder, Payroll Department folder, and so forth).

The following sections contain additional information:

 Section 5.1, “Creating Folders,” on page 45
 Section 5.2, “Renaming or Moving Folders,” on page 45
 Section 5.3, “Deleting a Folder,” on page 46

5.1 Creating Folders
1 In Endpoint Management Console, click the Bundles tab.
2 Click New > Folder.
3 Provide a unique name for your folder. This is a required field.

When you name an object in Endpoint Management Console (folders, bundles, bundle groups, 
catalogs, and so forth), ensure that the name adheres to the naming conventions not all 
characters are supported. For more information on naming conventions, see “Naming 
Conventions in Endpoint Management Console” in the Naming Conventions in Endpoint 
Management Console.

4 Type the name or browse to and select the folder that contains this folder in the Endpoint 
Management Console interface. This is a required field.

5 Provide a short description of the folder's contents.
6 Click OK.

5.2 Renaming or Moving Folders
Use the Edit drop-down list on the Bundles page to edit an existing object. To access the Edit drop-
down list, you must select an object by clicking the check box next to the object's name in the list.

Depending on the type of object you select, you can rename, copy, or move the selected object. For 
example, if you select a Bundle object, you can rename, copy, and move the bundle. If you select a 
Folder object, you can rename or move the Folder object, but not copy it. If the option is dimmed, 
that option is not available for the selected object type.

Some actions cannot be performed on multiple objects. For example, if more than one check box is 
selected, the Rename option is not available from the Edit menu.

1 In Endpoint Management Console, click the Bundles tab.
2 In the Bundles list, select the box next to the folder’s name, then click Edit.
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3 Select an option:
 Rename: Click Rename, provide a new name for the folder, then click OK.
 Move: Click Move, choose a destination folder for the selected objects, then click OK.

5.3 Deleting a Folder
Deleting a folder also deletes all of its contents (bundles, bundle groups, subfolders).

1 In Endpoint Management Console, click the Bundles tab.
2 In the Bundles list, select the check box next to the folder (or folders).
3 Click Delete.
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6 6Actions

The Actions panel displays the action sets available for the bundle. Depending on the bundle type, 
the possible action sets are Distribute, Install, Launch, Repair, Uninstall, Terminate. For example, if 
you select a Windows bundle, six actions sets (Distribute, Install, Launch, Repair, Uninstall, 
Terminate) are available. 

The Actions tab includes all actions that control what a bundle does. As part of the bundle actions, 
the content is distributed first, then the installation is run, and finally the application is started. The 
application can also be verified, uninstalled, and terminated if necessary. Also, certain bundles do 
not need to be distributed, while others do not need to be installed or started. It all depends on 
what they will do as well as the actions they contain.

You can choose to modify the action sets. For more information on modifying the action set options, 
see Section 11.2, “Modifying Action Set Options,” on page 156.

The bundle category that you select during bundle creation is listed as an action in the actions page. 
For example, if you selected the Copy Directory category during the bundle creation, Copy Directory 
action is listed in the Install tab of the actions page. You can also add an action to any of the available 
action sets. When you do so, that action is also performed whenever the action set is applicable. For 
example, when you add an action to the Install action set, that action is performed whenever the 
bundle is installed.

For information on managing the actions, see Section 11.1, “Managing Actions,” on page 153.

To access the action dialog box:

1 In Endpoint Management Console, click the Bundles tab.
2 Click the underlined link of a bundle in the Name column of the Bundles list.
3 Click the Actions tab. 
4 Click one of the action set tabs (Distribute, Install, Launch, Repair, Uninstall, Terminate), click 

the Add drop-down list, then select an available action.

NOTE: It is recommended that you provide an Action Name that clearly explains what the action 
does. For example, if the action copies an installation file, then instead of the default action name 
(Install File(s)), you can name the action as Copy <application name> installer. Also, it is 
recommended that you never use an explicit catalogue name in actions. If an application is to be 
portable, it is better to refer to %INSTALL_PATH% instead of C:\tmp.

The following sections contain information about the actions you can configure for the Distribute, 
Install, Launch, Repair, and Terminate action sets. 

 Section 6.1, “Action - Copy Directory,” on page 48
 Section 6.2, “Action - Copy Files,” on page 51
 Section 6.3, “Action - Create/Delete Directory,” on page 53
 Section 6.4, “Action - Delay,” on page 54
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 Section 6.5, “Action - Display Message,” on page 55
 Section 6.6, “Action - Distribute Files,” on page 56
 Section 6.7, “Action - Edit INI File,” on page 57
 Section 6.8, “Action - Edit Text File,” on page 60
 Section 6.9, “Action - End Process,” on page 62
 Section 6.10, “Action - File Removal,” on page 62
 Section 6.11, “Action - Install Bundle,” on page 63
 Section 6.12, “Action - Install Directory,” on page 64
 Section 6.13, “Action - Install Files,” on page 67
 Section 6.14, “Action - Install MSI,” on page 70
 Section 6.15, “Action - Install MSIX,” on page 73
 Section 6.16, “Action - Install MSP,” on page 75
 Section 6.17, “Action - Install Network MSI,” on page 76
 Section 6.18, “Action - Install Network MSIX,” on page 79
 Section 6.19, “Action - Launch Bundle,” on page 81
 Section 6.20, “Action - Launch Java Application,” on page 81
 Section 6.21, “Action - Launch URL,” on page 85
 Section 6.22, “Action - Launch Executable,” on page 85
 Section 6.23, “Action - Install Executable,” on page 90
 Section 6.24, “Action - Launch Windows Thin Client Application,” on page 95
 Section 6.25, “Action - Prompt User,” on page 96
 Section 6.26, “Action - Reboot/Shutdown,” on page 99
 Section 6.27, “Action - Registry Edit,” on page 101
 Section 6.28, “Action - Run Script,” on page 106
 Section 6.29, “Action - Start/Stop Service,” on page 109
 Section 6.30, “Action - Terminate Application,” on page 109
 Section 6.31, “Action - Terminate Application Prompt,” on page 110
 Section 6.32, “Action - Undo Install Actions,” on page 112
 Section 6.33, “Action - Uninstall Bundle,” on page 112
 Section 6.34, “Action - Repair Bundle,” on page 113
 Section 6.35, “Action - Repair Install Actions,” on page 114
 Section 6.36, “Requirements,” on page 114

6.1 Action - Copy Directory
The Action - Copy Directory dialog box lets you specify the directory to be copied and its destination 
directory. You can also specify the executable security level and the specific requirements that a 
device must meet for the action to be executed on the device.
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NOTE: Copying a file or directory copies the file or directory from one location to another without 
uploading the files into the Endpoint Management content repository. Copying a file or directory is 
described as copying without using content. When copying a file or directory, the managed device 
performs the copy operation and must be able to resolve both the source and destination paths. 
Also, when copying a file or directory, the file or directory is not cached on the managed device. 

Installing a file or directory uploads the file or directory to the Endpoint Management content 
repository before it is distributed to assigned devices. Installing a file or directory is described as 
copying using content. When installing a file or directory, the file or directory is cached on the 
managed device.

Installing an executable file does not launch or execute the file. To launch or execute the file, you 
must add a launch executable action to the bundle.

You can access this information by using the following methods:

 As part of the process of creating a Windows bundle by using the Copy Directory bundle 
category. For more information, see Section 2.2, “Creating Windows Bundles,” on page 19.

 In Endpoint Management Console, click the Bundles tab, click the underlined link of a bundle in 
the Name column of the Bundles list, click the Actions tab, click one of the action set tabs 
(Distribute, Install, Launch, Repair, Uninstall, Terminate), click the Add drop-down list, then 
select an available action.

The following sections contains additional information:

 Section 6.1.1, “General,” on page 49
 Section 6.1.2, “Requirements,” on page 51

6.1.1 General
The General page lets you specify the source directory, destination directory, copy option, and the 
executable security level.

Source Directory
If you have not installed Console Helper on this device, you must do so before you can browse for a 
directory.

Click Browse, and allow browser to launch Console Helper. The Select Folder dialog box is displayed, 
select the directory to copy. 

Destination Directory
Specify the destination path on the device where you want to copy the directory.

Copy Option
Select a copy option from the list:

Copy Always: Copies the content of the directory regardless of whether the files currently exist on 
the workstation.
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Copy If Exists: Copies the content of the directory only if the files currently exist on the workstation.

Copy If Does Not Exist: Copies the content of the directory only if the files does not currently exist 
on the workstation.

Copy If Newer: Copies the content of the directory only if the modified date and time of the file is 
newer than the existing file’s date and time, or if the files do not currently exist on the workstation.

Copy If Newer and Exists: Copies the content of the directory only if it already exists on the 
workstation and the existing file has an older modification date or time.

Copy if Newer Version: Copies the content of the directory only if the internal version of the file is 
newer than the existing file’s version (if version information is present).

Request Confirmation: Prompts the user to confirm that the content of the directory should be 
copied when the directory already exists on the workstation. 

Copy If Different: Copies the content of the directory if the creation date, creation time, or size of 
the file is different than the existing file’s date, time, or size.

Attributes
Select one or more of the following attributes:

Hidden: Select the Hidden check box to specify that the directory is hidden after being copied.

Read-only: Select the Read-only check box to specify that the directory is read-only after being 
copied.

Executable Security Level
 By default, the Run normal option is selected, which causes the application to run in the “user” 
space and inherit the same workstation security level as the logged-in user.

If the logged-in user's security level does not provide sufficient rights and file access to run the 
application, you can configure the application to run in the “system” space or as a dynamic 
administrator, as described below:

Run as logged in user: The action uses the logged-in user’s credentials. For example, the action has 
the same rights to the registry and the file system as the logged-in user.

Run as secure system user (Don't allow system to interact with desktop): The application is run 
under the Local System user and inherits Administrator-level credentials. For example, the 
application has full rights to the registry and the file system. Because the security level is set to 
Secure, the application's interface is not displayed to the user and the application is only visible in 
the Task Manager. This option is useful when running applications that require full access to the 
workstation but require no user intervention. If you use mapped network drives to specify files and 
directories, the action fails because system users do not have access to user mapped drives.

Run as dynamic administrator: A dynamic administrator is an administrator account that is created 
on the fly to perform certain procedures, such as installing applications. Using a dynamic 
administrator is helpful when installing applications (some MSI applications, for example) that 
cannot be installed in the system space. When you select this action, the dynamic administrator is 
created, it performs the required tasks, and then the account is deleted.
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You cannot use mapped network drives to specify files and directories because dynamic 
administrators do not have access to mapped drives.

6.1.2 Requirements
The Requirements page lets you define specific requirements that a device must meet for the action 
to be enforced on it. For information about the requirements, see Requirements.

6.2 Action - Copy Files
The Action - Copy Files dialog box lets you specify files to copy to the device and the specific 
requirements that a device must meet for the action to be executed on the device.

You can access this information by using the following methods:

 As part of the process of creating a Windows bundle by using the Copy Files bundle category. 
For more information, see Section 2.2, “Creating Windows Bundles,” on page 19.

 In Endpoint Management Console, click the Bundles tab, click the underlined link of a bundle in 
the Name column of the Bundles list, click the Actions tab, click one of the action set tabs 
(Distribute, Install, Launch, Repair, Uninstall, Terminate), click the Add drop-down list, then 
select an available action.

The following sections contains additional information:

 Section 6.2.1, “General,” on page 51
 Section 6.2.2, “Requirements,” on page 52

6.2.1 General
The General page lets you specify the files to copy to the device and the executable security level.

File Details
Click Add to display the Select Files dialog box. In the Select Files dialog box, click Add, allow browser 
to launch Console Helper. In the Select File dialog box, browse for the file path and click OK. Click the 
Help button for more information.

Edit File Details
The Edit File Details dialog box page lets you specify a copy option, the complete path of the source 
file to be copied, the path of the destination file, and whether the file is hidden or read-only after 
being copied to the device. Click any of the file names in the File Details dialog box to go to the Edit 
File Details dialog box.

Renaming the source file: To copy the source file to the destination directory with a different name, 
specify the new name along with the destination path in the Destination File Name field in the Edit 
File Details dialog box. 
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For example, to copy run.exe from C:\Program Files\Internet Explorer\ to D:\My 
Applications\Internet Explorer\ie.exe,use ie.exe as the new name you specify in the 
Destination File Name field in the Edit File Details dialog box.

Copy Option: Select a copy option from the list. For details, see Copy Option in the Action - Copy 
Directory section.

Attributes: Select one or more of the following attributes:

 Hidden: Select the Hidden check box to specify that the directory is hidden after being copied.
 Read-only: Select the Read-only check box to specify that the directory is read-only after being 

copied.

Executable Security Level
By default, the Run normal option is selected, which causes the application to run in the “user” space 
and inherit the same workstation security level as the logged-in user.

If the logged-in user's security level does not provide sufficient rights and file access to run the 
application, you can configure the application to run in the “system” space or as a dynamic 
administrator, as described below:

Run as logged in user: The action uses the logged-in user’s credentials. For example, the action has 
the same rights to the registry and the file system as the logged-in user.

Run as secure system user (Don't allow system to interact with desktop): The application is run 
under the Local System user and inherits Administrator-level credentials. For example, the 
application has full rights to the registry and the file system. Because the security level is set to 
Secure, the application's interface is not displayed to the user and the application is only visible in 
the Task Manager. This option is useful when running applications that require full access to the 
workstation but require no user intervention. If you use mapped network drives to specify files and 
directories, the action fails because system users do not have access to user mapped drives. 

Run as dynamic administrator: A dynamic administrator is an administrator account that is created 
on the fly to perform certain procedures, such as installing applications. Using a dynamic 
administrator is helpful when installing applications (some MSI applications, for example) that 
cannot be installed in the system space. When you select this action, the dynamic administrator is 
created, it performs the required tasks, and then the account is deleted.

You cannot use mapped network drives to specify files and directories because dynamic 
administrators do not have access to mapped drives.

6.2.2 Requirements
The Requirements page lets you define specific requirements that a device must meet for the action 
to be enforced on it. For information about the requirements, see Requirements.
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6.3 Action - Create/Delete Directory
The Action - Create/Delete Directory dialog box lets you create or delete a directory on the managed 
device and define the specific requirements that a device must meet for the action to be executed 
on the device.

The Delete Directory action deletes the entire folder along with its inner files and folders; it also 
deletes the folders that are in the hidden mode. 

You can access this information by using the following methods:

 As part of the process of creating a Windows bundle by using the Create/Delete Directory 
bundle category. For more information, see Section 2.2, “Creating Windows Bundles,” on 
page 19.

 In Endpoint Management Console, click the Bundles tab, click the underlined link of a bundle in 
the Name column of the Bundles list, click the Actions tab, click one of the action set tabs 
(Distribute, Install, Launch, Repair, Uninstall, Terminate), click the Add drop-down list, then 
select an available action.

The following sections contains additional information:

 Section 6.3.1, “General,” on page 53
 Section 6.3.2, “Requirements,” on page 54

6.3.1 General
The General page lets you specify the name of the directory to create or delete from the managed 
device and the executable security level.

Create Directory
Creates a directory on the managed device when the action is performed.

Delete Directory
Deletes a directory on the managed device when the action is performed.

Delete readonly directory
Deletes read-only directory on the managed device when the action is performed.

Directory Name
Specify the complete path of the directory you want to create or delete on the managed device. This 
path must be resolved by the device on which the bundle is run.
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Executable Security Level
By default, the Run normal option is selected, which causes the application to run in the “user” space 
and inherit the same workstation security level as the logged-in user.

If the logged-in user's security level does not provide sufficient rights and file access to run the 
application, you can configure the application to run in the “system” space or as a dynamic 
administrator, as described below:

 Run as logged in user: The action uses the logged-in user’s credentials. For example, the action 
has the same rights to the registry and the file system as the logged-in user.

 Run as secure system user (Don't allow system to interact with desktop): The application is 
run under the Local System user and inherits Administrator-level credentials. For example, the 
application has full rights to the registry and the file system. Because the security level is set to 
Secure, the application's interface is not displayed to the user and the application is only visible 
in the Task Manager. This option is useful when running applications that require full access to 
the workstation but require no user intervention. If you use mapped network drives to specify 
files and directories, the action fails because system users do not have access to user mapped 
drives. 

 Run as dynamic administrator: A dynamic administrator is an administrator account that is 
created on the fly to perform certain procedures, such as installing applications. Using a 
dynamic administrator is helpful when installing applications (some MSI applications, for 
example) that cannot be installed in the system space. When you select this action, the dynamic 
administrator is created, it performs the required tasks, and then the account is deleted.
You cannot use mapped network drives to specify files and directories because dynamic 
administrators do not have access to mapped drives.

6.3.2 Requirements
The Requirements page lets you define specific requirements that a device must meet for the action 
to be enforced on it. For information about the requirements, see Requirements.

6.4 Action - Delay
The Action - Delay dialog box lets you specify a system delay between two actions in the action set 
and the specific requirements that a device must meet for the action to be executed on the device.

To access this dialog box in Endpoint Management Console, click the Bundles tab. Click the 
underlined link of a bundle in the Name column of the Bundles list, click the Actions tab, click one of 
the action set tabs (Distribute, Install, Launch, Repair, Uninstall, Terminate), click the Add drop-down 
list, then select an available action.

The following sections contains additional information:

 Section 6.4.1, “General,” on page 55
 Section 6.4.2, “Requirements,” on page 55
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6.4.1 General
The General page lets you specify a system delay between two actions in the action set.

Delay for a Specific Time
Specify the desired time delay, in seconds. After completing the action, the system delays for the 
specified amount of time before performing the next action.

Wait for Processes or Services to Start
Specify the processes or services that must start before the next action in the action set is 
performed. 

To add a process or service to the list:

1 Click Add to display the Add Service/Process dialog box.
2 Select Process, specify the process that must start before performing the next action, then click 

OK. You can specify either the name of the process or its full path. For example, you can specify 
notepad.exe or ${SystemRoot}\system32\notepad.exe.
or
Select Service, specify the service that must start before performing the next action, then click 
OK.

3 Repeat Step 2 as needed.
4 Specify the maximum amount of time to wait for the process or service to start before 

performing the next action in the action set. If the process or service does not start in the 
specified amount of time, the next action is performed.

5 Click OK.

Click Edit to change a process or service, or click Remove to delete a process or service.

6.4.2 Requirements
The Requirements page lets you define specific requirements that a device must meet for the action 
to be enforced on it. For information about the requirements, see Requirements.

6.5 Action - Display Message
The Action - Display Message dialog box lets you specify a message to display on devices when the 
action is performed and the specific requirements that a device must meet for the action to be 
executed on the device.

To access this dialog box in Endpoint Management Console, click the Bundles tab. Click the 
underlined link of a bundle in the Name column of the Bundles list, click the Actions tab, click one of 
the action set tabs (Distribute, Install, Launch, Repair, Uninstall, Terminate), click the Add drop-down 
list, then select an available action.
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The following sections contains additional information:

 Section 6.5.1, “General,” on page 56
 Section 6.5.2, “Requirements,” on page 56

6.5.1 General
The General page lets you specify a message to display on devices when the action is performed.

Define Prompts
Define the prompt that you want to display on the device. Additionally, you can specify different 
locales with different messages.

The Endpoint Agent automatically detects the locale of the operating system and displays the 
prompt defined in the same locale as the operating system locale. However, if the operating system 
locale does not match any of the specified locales, then Endpoint Management displays the prompt 
defined by the first locale in the list.

To create a message:

1 Click Add to display the Select Locale and Prompt dialog box.
2 Select a language from the Locale drop-down list. The message displays only on devices in the 

specified locale. You can create different messages, each with its own locale setting.
3 Specify the text you want to display on the device.
4 Click OK.

Click Edit to change the prompt, or click Remove to delete the prompt.

6.5.2 Requirements
The Requirements page lets you define specific requirements that a device must meet for the action 
to be enforced on it. For information about the requirements, see Requirements.

6.6 Action - Distribute Files
The Distribute Files Action distributes the content of the bundle from the Cloud Server to the 
managed device or user. There are no configuration tasks that you need to perform for this action.
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6.7 Action - Edit INI File
The Action - Edit INI File dialog box lets you specify a configuration file and configure the list of 
changes to be performed on the file. You can also create a file, if one does not exist. You can also 
specify the specific requirements that a device must meet for the action to be executed on the 
device.

To access this dialog box in Endpoint Management Console, click the Bundles tab. Click the 
underlined link of a bundle in the Name column of the Bundles list, click the Actions tab, click one of 
the action set tabs (Distribute, Install, Launch, Repair, Uninstall, Terminate), click the Add drop-down 
list, then select an available action.

The following sections contain additional information:

 Section 6.7.1, “General,” on page 57
 Section 6.7.2, “Advanced,” on page 59
 Section 6.7.3, “Requirements,” on page 59

6.7.1 General
The General page lets you specify a configuration file and configure the list of changes to be 
performed on the file. You can also create a file, if one does not exist.

Filename
Specify the file that you want to change. For example, C:\Program Files\OpenOffice.org 
2.0\program\setup.ini.

Encoding
Specify the encoding that you want to use:

Auto detect:  Use the encoding used in the original file that you specified in the Filename field. This 
is the default option.

ASCII: Use ASCII encoding.

Unicode:  Use Unicode encoding.

UTF-8: Use UTF-8 (8-bit UCS/Unicode Transformation Format) encoding.

Create File, If Does Not Exist
Specify whether you want to create the file specified in the Filename field, if it does not exist. The 
file is created with the same name and the extension as specified in File Path. If the file specified in 
File Path does not have an extension, then the created file also does not have any extension.

If this option is selected and Encoding is set to Auto detect, the file is created in UTF-8 format with 
the same name and the extension as specified in File Path.
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INI Changes
The INI Changes page lets you specify the INI file to change, add sections to the file, add keys to a 
section in the file, and import changes from another INI file. 

To access this dialog box in Endpoint Management Console, click the Bundles tab. Click the 
underlined link of a bundle in the Name column of the Bundles list, click the Actions tab, click one of 
the action set tabs (Distribute, Install, Launch, Repair, Uninstall, Terminate), click the Add drop-down 
list, then select an available action.

The following table lists the tasks you can perform to manage INI changes.

Table 6-1   INI Tasks

Task Steps Additional Details

Specify the INI file to 
change

1. Specify the file that you want to 
change. 

For example, C:\Program 
Files\OpenOffice.org 
2.0\program\setup.ini.

Add a section 1. Click Add, then click New Section 
Change to open the Add a Change 
dialog box.

2. Fill in the fields, then click OK.
Click the Help button for 
additional information.

If you specify an existing section and 
add new keys to the list, then the 
existing section is updated with the 
newly added keys. For example, if a 
section sect1 with k1=v1 already exists 
and if you specify a new section sect1 
with k1=v1,  k2=v2, then the newly 
added key k2=v2 is added to sect1.

Add keys to a 
section

1. Click the section to which you 
want to add the keys.

2. Specify the keys to be added to 
the section in the INI file. Type the 
key, such as key1 or key1=value1, 
then click Add to move the key to 
the list.
You can edit or remove an entry, 
or you can use the Move Up and 
Move Down buttons to order the 
list. The changes to the file are 
made in the order listed.

Edit an INI Change 1. Click the desired item you want to 
edit. The Add a Change dialog box 
is displayed. 

The Section Change Type configured 
for the section is displayed by default in 
the Add Change dialog box.

Remove a section or 
keys

1. Select the check box next to the 
desired item, then click Delete.

Import INI changes 
from another file

1. Click Import to display the Import 
INI Changes from File dialog box.

2. Specify the file from which you 
want to import changes, then click 
OK.
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Run Action As: Specify System (the default) or User from the Run Action As list. Specify System if 
removing files requires access to all areas of the device’s file system. If you use mapped network 
drives to specify files and directories, you must run the action as User.

6.7.2 Advanced 
The Advanced page lets you create the file (if it does not exist), specify the number of backup files to 
retain, and specify key-value separators and comment characters.

Create File, If Does Not Exist: Specify whether you want to create the file specified in the Filename 
field, if it does not exist.

Number of File Backup(s) to Retain: Specify the number of backups of the INI file to retain. The 
default is 5 backup copies, but you can specify any number between 1 and 25. When the number of 
backup copies of the file exceeds the number specified here, the oldest backup file is overwritten.

Key-Value Separator: Specify the character you want to separate key values. You can use an equals 
sign (=) or a colon (:).

Value Separator: Specify the character you want to separate the multiple values. You can use 
characters such as equals sign (=), comma(,), space( ), hash (#), semicolon (;) or a colon (:).

Comment Character: Specify the character you want precede comments in the INI file. You can use a 
semicolon (;) or a pound sign (#).

Append key-value separator to the key when value is not available: Select this option to append 
the key-value separator to the key even if the value is not available. For example, in the setup.ini file 
used by Acrobat Reader*, the CmdLine key does not have a value but requires a key-value separator. 

6.7.3 Requirements
The Requirements page lets you define specific requirements that a device must meet for the action 
to be enforced on it. For information about the requirements, see Requirements.

Change the order of 
items

1. Select the check box next to an 
item, click Edit, then select an 
option (Sort, Move Up, Move 
Down).

Select all the objects 
of a parent folder 

1. Select the check box next to the 
parent folder, then click Edit > 
Select All Children.

Deselect all the 
objects of a parent 
folder 

1. Select the check box next to the 
parent folder, then click Edit > 
Deselect All Children.

Clear Selection 1. Click Edit > Clear Selection.

Task Steps Additional Details
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6.8 Action - Edit Text File
The Action - Edit Text File dialog box lets you specify a file and configure the list of changes to be 
performed on the file. You can also create a file, if one does not exist. You can also specify the 
specific requirements that a device must meet for the action to be executed on the device.

To access this dialog box in Endpoint Management Console, click the Bundles tab. Click the 
underlined link of a bundle in the Name column of the Bundles list, click the Actions tab, click one of 
the action set tabs (Distribute, Install, Launch, Repair, Uninstall, Terminate), click the Add drop-down 
list, then select an available action.

The following sections contains additional information:

 Section 6.8.1, “General,” on page 60
 Section 6.8.2, “Requirements,” on page 61

6.8.1 General
The General page lets you specify a file and configure the list of changes to be performed on the file. 
You can also create a file, if one does not exist.

Filename
Specify the file that you want to change. For example, ${SystemDrive}\Program 
Files\myfile.txt.

File Backup(s) to Retain
Specify the number of backups of the text file to retain. The default is 5 backup copies, but you can 
specify any number between 1 and 25. When the number of backup copies of the file exceeds the 
number specified here, the oldest backup file is overwritten.

Encoding
Specify the encoding that you want to use:

 Auto detect: Use the encoding used in the original file that you specified in the Filename field. 
This is the default option.

 ASCII: Use ASCII encoding.
 Unicode: Use Unicode* encoding.
 UTF-8: Use UTF-8 (8-bit UCS/Unicode Transformation Format) encoding.

File Operation > Specify Contents of the File
Use this option to specify the contents of the text file.

 Import Contents from an Existing File on this Device: Browse to and select the text file from 
which you want to import its contents.
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 Contents of the File: Specify the contents of the newly created file. If an Environment Variable 
is specified, then Endpoint Management will resolve that variable to the associated value. For 
example, if %USERNAME% is provided as the Environment Variable, then the variable will be 
resolved to the value of the logged-in user. 
However, if you do not want the variable to be resolved and want it to be displayed as is, then 
you need to add additional percent signs before and after the variable. For example, if you want 
the output to be displayed as %USERNAME%, specify %%USERNAME%% or if you want the 
output to be displayed as %%USERNAME%%, specify %%%USERNAME%%%.

 Create File, If Does Not Exist: Specify whether you want to create the file specified in the 
Filename field, if it does not exist. If this option is selected and Encoding is set to Auto detect, 
the file is created in UTF-8 format with the same name and the extension as specified in File 
Path.

File Operation > Specify Changes to the File
Use this option to specify the changes to the text file.

 Change List: Specify the changes that you want to make to the text file. Click Add to open the 
Add a Change dialog box, fill in the fields, then click OK. Click the Help button for additional 
information.

You can edit or remove an entry, or you can use the Move Up and Move Down buttons to order 
the list. The changes to the file are made in the order listed.

 Create File, If Does Not Exist: Specify whether you want to create the file specified in the 
Filename field, if it does not exist.

 Contents of the File: If you selected the Create File, If Does Not Exist check box, specify the 
contents of the newly created file that is created if the specified file does not exist. If an 
Environment Variable is specified, then Endpoint Management will resolve that variable to the 
associated value. For example, if %USERNAME% is provided as the Environment Variable, then 
the variable will be resolved to the value of the logged-in user. 
However, if you do not want the variable to be resolved and want it to be displayed as is, then 
you need to add additional percent signs before and after the variable. For example, if you want 
the output to be displayed as %USERNAME%, specify %%USERNAME%% or if you want the 
output to be displayed as %%USERNAME%%, specify %%%USERNAME%%%.

 Apply Changes Configured in the Change List: Specify whether you want to apply the changes 
that you added to the Change List box to the newly created file.

Run Action As
On Windows, specify System (the default) or User from the Run Action As list. Specify System if 
removing files requires access to all areas of the device’s file system. If you use mapped network 
drives to specify files and directories, you must run the action as User.

6.8.2 Requirements
The Requirements page lets you define specific requirements that a device must meet for the action 
to be enforced on it. For information about the requirements, see Requirements.
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6.9 Action - End Process
The Action - End Process dialog box lets you specify the executable name of the process that you 
want to stop (for example, notepad, mspaint, winword, and so forth). If the process is not running 
on the device, the End Process task completes. You can also specify the specific requirements that a 
device must meet for the action to be executed on the device.

To access this information in Endpoint Management Console, click the Bundles tab. Click the 
underlined link of a bundle in the Name column of the Bundles list, click the Actions tab, click one of 
the action set tabs (Distribute, Install, Launch, Repair, Uninstall, Terminate), click the Add drop-down 
list, then select an available action.

The following sections contains additional information:

 Section 6.9.1, “General,” on page 62
 Section 6.9.2, “Requirements,” on page 62

6.9.1 General
The General page lets you specify the executable name of the process that you want to stop (for 
example, notepad, mspaint, winword, and so forth). If the process is not running on the device, 
the End Process task completes.

6.9.2 Requirements
The Requirements page lets you define specific requirements that a device must meet for the action 
to be enforced on it. For information about the requirements, see Requirements.

6.10 Action - File Removal
The Action - File Removal dialog box lets you specify files or directories to remove from the device 
and the specific requirements that a device must meet for the action to be executed on the device.

To access this dialog box in Endpoint Management Console, click the Bundles tab. Click the 
underlined link of a bundle in the Name column of the Bundles list, click the Actions tab, click one of 
the action set tabs (Distribute, Install, Launch, Repair, Uninstall, Terminate), click the Add drop-down 
list, then select an available action.

You can use this action to perform an automated system cleanup. For example, you can specify that 
the c:\windows\Temp\Temporary Internet Files directory and all files matching 
c:\windows\Temp\*.log in are removed from the device.

On a Windows managed device, you cannot remove read-only files. If you specify a directory that 
contains several files (including some read-only files), the directory and the read-only files are not 
removed when the File Removal action runs. The files that are not read-only, however, are removed 
from the Windows device.

The following sections contains additional information:

 Section 6.10.1, “General,” on page 63
 Section 6.10.2, “Requirements,” on page 63
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6.10.1 General
The General page lets you specify files or directories to remove from the device.

Full Path to Source Files/Directories
Specify the full path to the file or directory that you want to remove, then click Add to add the file or 
directory to the list. You can use wildcard characters. If you use a mapped network drive to specify 
the path, you must select User from the Run Action As list.

Include System Files
Select this option to remove system files. If you specify a directory for removal that includes both 
system and non-system files, only non-system files are deleted, unless you specify this option.

Delete Folder Only if Empty
Select this option if you want to remove the specified folders only if they are empty.

When a File is Locked, Retry _ Times, Every _ Seconds
If a file is locked when the action is performed, the file cannot be removed. Select the check box and 
then specify the number of retry attempts and the time interval between attempts. By default, the 
action is retried 3 times with 5 seconds between each attempt.

Run Action As
On Windows, specify System (the default) or User from the Run Action As list. Specify System if 
removing files requires access to all areas of the device’s file system. If you use mapped network 
drives to specify files and directories, you must run the action as User, else the action fails because 
system users do not have access to user mapped drive.

6.10.2 Requirements
The Requirements page lets you define specific requirements that a device must meet for the action 
to be enforced on it. For information about the requirements, see Requirements.

6.11 Action - Install Bundle
The Action - Install Bundle dialog box lets you browse to and select the bundle to install on the 
device. The bundle is installed on the device even if it has not been previously assigned to that 
device. You can also specify the specific requirements that a device must meet for the action to be 
executed on the device.

To access this dialog box in Endpoint Management Console, click the Bundles tab. Click the 
underlined link of a bundle in the Name column of the Bundles list, click the Actions tab, click one of 
the action set tabs (Distribute, Install, Launch, Repair, Uninstall, Terminate), click the Add drop-down 
list, then select an available action.
Actions 63



The following sections contains additional information:

 Section 6.11.1, “General,” on page 64
 Section 6.11.2, “Requirements,” on page 64

6.11.1 General
The General page lets you browse to and select the bundle to install on the device. The bundle is 
installed on the device even if it has not been previously assigned to that device.

Click  to browse to and select the bundle to install on the device. 

The Look in list defaults to /Bundles. If you have created subfolders to hold your bundles, use the 
down arrow to select the appropriate folder. The Items of type list defaults to All Types so that all 
types of bundles are displayed. If you know the name of the bundle you are looking for, you can use 
the Item name box to search for the bundle. 

Creating this action creates a bundle dependency. For more information, see Section 8.5, 
“Dependency Bundles,” on page 134.

6.11.2 Requirements
The Requirements page lets you define specific requirements that a device must meet for the action 
to be enforced on it. For information about the requirements, see Requirements.

6.12 Action - Install Directory
The Action - Install Directory dialog box lets you specify the directory to be installed, specify a 
destination path, specify whether the directory is hidden or read-only after being installed on the 
device (applicable only for Windows), and specify a copy option. You can also specify the 
requirements that a device must meet for the action to be executed on the device

Copying a file or directory copies the file or directory from one location to another without 
uploading the files into the content repository. Copying a file or directory is described as copying 
without using content. When copying a file or directory, the managed device performs the copy 
operation and must be able to resolve both the source and destination paths. Also, when copying a 
file or directory, the file or directory is not cached on the managed device. 

Installing a file or directory uploads the file or directory to the content repository before it is 
distributed to assigned devices. Installing a file or directory is described as copying using content. 
When installing a file or directory, the file or directory is cached on the managed device. If a 
directory does not have any content, it is not uploaded to the content repository. This causes any 
successive action depending on this empty directory to fail.

Installing an executable file does not launch or execute the file. To launch or execute the file, you 
must add a launch executable action (Launch Executable, Launch Java Application, and so forth) to 
the bundle.
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You can access this information by using the following methods:

 As part of the process of creating a Windows bundle by using the Install Directory bundle 
category. For more information, see Section 2.2, “Creating Windows Bundles,” on page 19.

 In Endpoint Management Console, click the Bundles tab, click the underlined link of a bundle in 
the Name column of the Bundles list, click the Actions tab, click one of the action set tabs 
(Distribute, Install, Launch, Repair, Uninstall, Terminate), click the Add drop-down list, then 
select an available action.

The following sections contains additional information:

 Section 6.12.1, “General,” on page 65
 Section 6.12.2, “Requirements,” on page 67

6.12.1 General
The General page lets you specify the directory to be installed, specify a destination path, specify 
whether the directory is hidden or read-only after being installed on the device (applicable for 
Windows only), and specify a copy option. 

Source Directory
Click , allow browser to launch Console Helper. In the Select Directory dialog box, browse and 
select the directory you want to install on the device. 

If you have not installed Console Helper on this device, you must do so before you can browse to and 
upload directories to be installed.

NOTE: You cannot upload an empty directory.

Destination Directory
Specify the destination directory on the device in which you want to install the directory. The 
destination directory should be the folder where the files are installed from the uploaded source 
folder. .

Hidden
Applicable for Windows only. Select the Hidden check box to specify that the directory is hidden 
after installation.

Read-Only
Applicable for Windows only. Select the Read-only check box to specify that the directory is read-
only after installation.
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Copy Option
Select a copy option from the list:

 Copy Always: Copies the contents of the directory regardless of whether the files currently 
exists on the workstation. 

 Copy If Exists: Copies the contents of the directory only if the files currently exists on the 
workstation.

 Copy If Does Not Exist: Copies the contents of the directory only if the files does not currently 
exist on the workstation.

 Copy If Newer: Copies the contents of the directory only if the modified date and time of the 
file is newer than the existing file’s date and time, or if the files does not currently exist on the 
workstation.

 Copy If Newer and Exists: Copies the contents of the directory only if it already exists on the 
workstation and the date and time of the file is newer than the existing file’s date and time.

 Copy if Newer Version: Copies the contents of the directory only if the internal version of the 
file is newer than the existing file’s version (if version information is present).

 Request Confirmation: Prompts the user to confirm that the content of the directory should be 
copied when the directory already exists on the workstation. 

 Copy If Different: Copies the contents of the directory if the creation date, creation time, or size 
is different than the existing file’s date, time, or size.

NOTE: It is recommended that when you copy files to the local disk, you use the Repository to store 
the files. This ensures that the entire package is available wherever the computer is located. This 
makes the application portable, since the user’s computer needs to have neither a UNC/SMB 
connection to a server nor some other means for transferring files to the local hard drive before they 
can be used by the bundle. The computer will not even need to have an Internet connection for the 
installation if the configuration is correct.

Executable Security Level
By default, the Run normal option is selected, which causes the application to run in the “user” space 
and inherit the same workstation security level as the logged-in user.

If the logged-in user's security level does not provide sufficient rights and file access to run the 
application, you can configure the application to run in the “system” space or as a dynamic 
administrator, as described below:

 Run as logged in user: The action uses the logged-in user’s credentials. For example, the action 
has the same rights to the registry and the file system as the logged-in user.

 Run as secure system user (Don't allow system to interact with desktop): The application is 
run under the Local System user and inherits Administrator-level credentials. For example, the 
application has full rights to the registry and the file system. Because the security level is set to 
Secure, the application's interface is not displayed to the user and the application is only visible 
in the Task Manager. This option is useful when running applications that require full access to 
the workstation but require no user intervention. If you use mapped network drives to specify 
files and directories, the action fails because system users do not have access to user mapped 
drives. 
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 Run as dynamic administrator: A dynamic administrator is an administrator account that is 
created on the fly to perform certain procedures, such as installing applications. Using a 
dynamic administrator is helpful when installing applications (some MSI applications, for 
example) that cannot be installed in the system space. When you select this action, the dynamic 
administrator is created, it performs the required tasks, and then the account is deleted.
You cannot use mapped network drives to specify files and directories because dynamic 
administrators do not have access to mapped drives.

6.12.2 Requirements
The Requirements page lets you define specific requirements that a device must meet for the action 
to be enforced on it. For information about the requirements, see Requirements.

6.13 Action - Install Files
The Action - Install Files dialog box lets you specify the file to copy to the content system and from 
content system to the device, the destination directory and filename, and the copy options.You can 
also specify the specific requirements that a device must meet for the action to be executed on the 
device.

You can access this information by using the following methods:

 As part of the process of creating a Windows bundle by using the Install Files bundle category. 
For more information, see Section 2.2, “Creating Windows Bundles,” on page 19.

 In Endpoint Management Console, click the Bundles tab, click the underlined link of a bundle in 
the Name column of the Bundles list, click the Actions tab, click one of the action set tabs 
(Distribute, Install, Launch, Repair, Uninstall, Terminate), click the Add drop-down list, then 
select an available action.

The following sections contains additional information:

 Section 6.13.1, “General,” on page 67
 Section 6.13.2, “Requirements,” on page 69

6.13.1 General
The General page lets you specify the file to copy to the content system and from content system to 
the device, the destination directory and filename, and the copy options. Click Add to display the 
Select Files dialog box.

The Select Files dialog box lets you specify the files to be copied, specify a destination and source 
directory, specify whether the files are hidden or read-only after being copied to the device, and 
specify a copy option.

Copying a file or directory copies the file or directory from one location to another without 
uploading the files into the content repository. Copying a file or directory is described as copying 
without using content. When copying a file or directory, the managed device performs the copy 
operation and must be able to resolve both the source and destination paths. Also, when copying a 
file or directory, the file or directory is not cached on the managed device. 
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Installing a file or directory uploads the file or directory to the content repository before it is 
distributed to assigned devices. Installing a file or directory is described as copying using content. 
When installing a file or directory, the file or directory is cached on the managed device.

Installing an executable file does not launch or execute the file. To launch or execute the file, you 
must add a launch executable action (Launch Executable, Launch Java Application, and so forth) to 
the bundle.

File
Click Add, allow browser to launch Console Helper. The Select Files dialog box is displayed, click Add, 
select the files you want to copy to the device, and then click Upload. Repeat this step as many times 
as necessary to copy the desired files.

If Console Helper is not installed on this device, you must install it before you can browse for file 
paths.

Destination Directory
Specify the destination directory on the device in which you want to install the file.

Copy Option
Select a copy option from the list:

 Copy Always: Copies the file regardless of whether the file currently exists on the workstation.
 Copy If Exists: Copies the file only if the file currently exists on the workstation.
 Copy If Does Not Exist: Copies the file only if the file does not currently exist on the 

workstation.
 Copy If Newer: Copies the file only if its modified date and time is newer than the existing file’s 

date and time, or if the file does not currently exist on the workstation.
 Copy If Newer and Exists: Copies the file only if it already exists on the workstation and the 

date and time of the file is newer than the existing file’s date and time.
 Copy if Newer Version: Copies the file only if its internal version is newer than the existing file’s 

version (if version information is present).
 Request Confirmation: Prompts the user to confirm that the file should be copied when the file 

already exists on the workstation.
 Copy If Different: Copies the file if its creation date, creation time, or size is different than the 

existing file’s date, time, or size.

NOTE: It is recommended that when you copy files to the local disk, you use the Repository to store 
the files. This ensures that the entire package is available wherever the computer is located. This 
makes the application portable, since the user’s computer needs to have neither a UNC/SMB 
connection to a server nor some other means for transferring files to the local hard drive before they 
can be used by the bundle. The computer will not even need to have an Internet connection for the 
installation if the configuration is correct.
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Hidden
Select the Hidden check box to specify that the file is hidden after installation.

Read-Only
Select the Read-only check box to specify that the file is read-only after installation.

Executable Security Level
By default, the Run normal option is selected, which causes the application to run in the “user” space 
and inherit the same workstation security level as the logged-in user.

If the logged-in user's security level does not provide sufficient rights and file access to run the 
application, you can configure the application to run in the “system” space or as a dynamic 
administrator, as described below:

 Run as logged in user: The action uses the logged-in user’s credentials. For example, the action 
has the same rights to the registry and the file system as the logged-in user.

 Run as secure system user (Don't allow system to interact with desktop): The application is 
run under the Local System user and inherits Administrator-level credentials. For example, the 
application has full rights to the registry and the file system. Because the security level is set to 
Secure, the application's interface is not displayed to the user and the application is only visible 
in the Task Manager. This option is useful when running applications that require full access to 
the workstation but require no user intervention. If you use mapped network drives to specify 
files and directories, the action fails because system users do not have access to user mapped 
drives. 

 Run as dynamic administrator: A dynamic administrator is an administrator account that is 
created on the fly to perform certain procedures, such as installing applications. Using a 
dynamic administrator is helpful when installing applications (some MSI applications, for 
example) that cannot be installed in the system space. When you select this action, the dynamic 
administrator is created, it performs the required tasks, and then the account is deleted.
You cannot use mapped network drives to specify files and directories because dynamic 
administrators do not have access to mapped drives.

6.13.2 Requirements
The Requirements page lets you define specific requirements that a device must meet for the action 
to be enforced on it. For information about the requirements, see Requirements.
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6.14 Action - Install MSI
The Action - Install MSI dialog box lets you specify the location of the MSI file; its Install, Uninstall, 
and Repair parameters; the transform file; and the executable security level. You can also specify the 
specific requirements that a device must meet for the action to be executed on the device.

You can access this information by using the following methods:

 As part of the process of creating a Windows bundle by using the MSI Application bundle 
category. For more information, see Section 2.2, “Creating Windows Bundles,” on page 19.

 In Endpoint Management Console, click the Bundles tab, click the underlined link of a bundle in 
the Name column of the Bundles list, click the Actions tab, click one of the action set tabs 
(Distribute, Install, Launch, Repair, Uninstall, Terminate), click the Add drop-down list, then 
select an available action.

The following sections contains additional information:

 Section 6.14.1, “General,” on page 70
 Section 6.14.2, “Advanced,” on page 71
 Section 6.14.3, “Requirements,” on page 72

6.14.1 General
The General page lets you specify the location of the MSI file; its Install, Uninstall, and Repair 
parameters; the transform file; and the executable security level. 

.msi File
Click , allow browser to launch Console Helper. The Select .msi File dialog box is displayed, click 
browse and select the .msi file to install. 

Select the Include all files in and below the directory of this file option to include all the supporting 
files that are within the directory containing the .msi file and the subdirectories within it. 

If you have not installed the Console Helper on this device, you must do so before you can browse to 
and upload files.

Install Parameters
Click  to display the Install Parameters dialog box, then specify the desired parameters. Click the 
Help button for additional information. 

Uninstall Parameters
Click  to display the Uninstall Parameters dialog box, then specify the desired parameters. Click the 
Help button for additional information. 
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Repair Parameters
Click  to display the Repair Parameters dialog box, then specify the desired parameters. Click the 
Help button for additional information. 

MSI Properties
The MSI package contains the property values that were defined during the administrative 
installation of the application. These property values determine the way the Microsoft Windows 
Installer installs the application to the workstation. In some cases, you might want to change one or 
more of the property values. For example, a property value might define the default location for a 
user’s work files. By adding the property to the list and changing the property’s value, you can 
override the default location defined in the MSI package.

If necessary, you can add public properties that were not included in the MSI package. When doing 
so, you should be careful to add only those properties that are valid for the package. The following 
options are available:

 Add: To override a property value, you change the property value and add the property to the 
Properties list so that Application Launcher knows to use that property value rather than the 
one defined in the MSI package. To do so, click Add to display the MSI Properties dialog box. In 
the Name field, select the property whose value you want to override, specify the new value in 
the Value field, then click OK to add the property to the MSI Properties list.

 Edit: To modify a property that is in the MSI Properties list, select the property, click Edit, modify 
the value data, then click OK.

 Remove: To remove a property from the MSI Properties list, select the property, then click 
Remove. Deleting the property causes future installations of the application to use the property 
value defined in the MSI package.

IMPORTANT: The total length of the MSI Properties and the Install Parameters should not exceed 
1024 characters.

6.14.2 Advanced

Transform File

Click Add, in the Select Transform File dialog box click , allow browser to launch Console Helper. In 
the Select Transform File dialog box, click Browse, select the desired transform file, and then click 
Upload. You can upload the transform file or you can specify its location. 

If you have not installed Console Helper on this device, you must do so before you can browse for a 
file. 

Different groups within an organization often use the same application, but they might not require 
the same feature set. One of the benefits of Windows Installer is that if you have 10 groups needing 
10 different feature sets or other alterations for the same application, you can deploy the same MSI 
package to all 10 user groups, but with a different transform file (MST) applied for each group.
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A transform file is a collection of changes applied to an MSI installation. It contains all modification 
information, such as whether features are installed; how they are installed; which files, shortcuts, 
and registry entries are included; and Add/Remove Programs applet information.

Executable Security Level
By default, the Run normal option is selected, which causes the application to run in the “user” space 
and inherit the same workstation security level as the logged-in user.

If the logged-in user's security level does not provide sufficient rights and file access to run the 
application, you can configure the application to run in the “system” space or as a dynamic 
administrator, as described below: 

 Run as logged in user: The MSI application inherits the logged-in user’s credentials. For 
example, the application has the same rights to the registry and the file system as the logged-in 
user.

Select the application’s display mode: Normal, Minimized, Maximized, or Hidden. In Hidden 
mode, the application runs normally without a user interface available. This is useful if you want 
the application to process something, then go away without user intervention.

Select Grant administrator privilege to user during installation to provide administrator privileges 
to the logged-in user. However, providing administrator privileges to a user might pose security 
risks. If this option is selected, the user on the managed device is prompted to enter the 
password when the MSI is installed on the device. To install the MSI, the user must log in to the 
device with a user account that has a password configured.

 Run as secure system user (Don't allow system to interact with desktop): The application is 
run under the Local System user and inherits Administrator-level credentials. For example, the 
application has full rights to the registry and the file system. Because the security level is set to 
Secure, the application's interface is not displayed to the user and the application is only visible 
in the Task Manager. This option is useful when running applications that require full access to 
the workstation but require no user intervention.

 Run as dynamic administrator: A dynamic administrator is an administrator account that is 
created on the fly to perform certain procedures, such as installing applications. Using a 
dynamic administrator is helpful when installing applications (some MSI applications, for 
example) that cannot be installed in the system space. When you select this action, the dynamic 
administrator is created, it performs the required tasks, and then the account is deleted.
You cannot use mapped network drives to specify files and directories because dynamic 
administrators do not have access to mapped drives.

NOTE: Performing this action as dynamic administrator on a Windows domain controller fails 
because Microsoft does not allow the use of local administrator accounts on domain 
controllers.

6.14.3 Requirements
The Requirements page lets you define specific requirements that a device must meet for the action 
to be enforced on it. For information about the requirements, see Requirements.
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6.15 Action - Install MSIX
The Action - Install MSIX dialog box lets you specify the location of the MSIX file, its certificate, 
installation mode, and the executable security level. You can also specify the specific requirements 
that a device must meet for the action to be executed on the device.

You can access this information by using the following methods:

 As part of the process of creating a Windows bundle by using the MSIX Application bundle 
category. For more information, see Section 2.2, “Creating Windows Bundles,” on page 19.

 In Endpoint Management Console, click the Bundles tab, click the underlined link of a bundle in 
the Name column of the Bundles list, click the Actions tab, click one of the action set tabs 
(Distribute, Install, Launch, Repair, Uninstall, Terminate), click the Add drop-down list, then 
select an available action.

The following sections contains additional information:

 Section 6.15.1, “General,” on page 73
 Section 6.15.2, “Advanced,” on page 74
 Section 6.15.3, “Requirements,” on page 74

6.15.1 General
The General page lets you specify the location of the MSIX file, upload a certificate, and choose an 
installation mode.

.msix File

Click , allow browser to launch Console Helper. The Select .msix File dialog box is displayed, click 
browse and select the .msix file to install. 

Select the Include all files in and below the directory of this file option to include all the supporting 
files that are within the directory containing the .msix file and the subdirectories within it. 

If you have not installed the Console Helper on this device, you must do so before you can browse to 
and upload files.

Select Certificate
If the certificate is not signed by a well-known CA, then you can upload a certificate by clicking the 
Select Certificate button. It supports the.pem,.crt,.cer,.der,.p7b, or .p7c file formats.

Install Mode
Select the desired install options:

 For Logged-in User Only: Installs the MSIX application for logged-in user only.
 For All Users of Device: Installs the MSIX application for all the users (Device wide installation).
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NOTE: The Install Network MSIx bundle action with a network path requires network access 
credentials. When creating the Install Network MSIx bundle, ensure that you select For All Users 
of Device as Installation Mode.

6.15.2 Advanced

Executable Security Level
By default, the Run normal option is selected, which causes the application to run in the “user” 
space and inherit the same workstation security level as the logged-in user.

If the logged-in user's security level does not provide sufficient rights and file access to run the 
application, you can configure the application to run in the “system” space or as a dynamic 
administrator, as described below:

 Run as logged in user: The MSIX application inherits the logged-in user’s credentials. For 
example, the application has the same rights to the registry and the file system as the logged-in 
user.

Select the application’s display mode: Normal, Minimized, Maximized, or Hidden. In Hidden 
mode, the application runs normally without a user interface available. This is useful if you want 
the application to process something, then go away without user intervention.

Select Grant administrator privilege to user during installation to provide administrator privileges 
to the logged-in user. However, providing administrator privileges to a user might pose security 
risks. If this option is selected, the user on the managed device is prompted to enter the 
password when the MSIX is installed on the device. To install the MSIX, the user must log in to 
the device with a user account that has a password configured.

 Run as dynamic administrator: A dynamic administrator is an administrator account that is 
created on the fly to perform certain procedures, such as installing applications. Using a 
dynamic administrator is helpful when installing applications (some MSIX applications, for 
example) that cannot be installed in the system space. When you select this action, the dynamic 
administrator is created, it performs the required tasks, and then the account is deleted.
You cannot use mapped network drives to specify files and directories because dynamic 
administrators do not have access to mapped drives.

NOTE: Performing this action as dynamic administrator on a Windows domain controller fails 
because Microsoft does not allow the use of local administrator accounts on domain 
controllers.

6.15.3 Requirements
The Requirements page lets you define specific requirements that a device must meet for the action 
to be enforced on it. For information about the requirements, see Requirements.
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6.16 Action - Install MSP
The Action - Install MSP dialog box lets you specify the location of the MSP file, command line 
parameters, and executable security level. You can also specify the specific requirements that a 
device must meet for the action to be executed on the device.

You can access this information by using the following methods:

 As part of the process of creating a Windows bundle by using the MSP Application bundle 
category. For more information, see Section 2.2, “Creating Windows Bundles,” on page 19.

 In Endpoint Management Console, click the Bundles tab, click the underlined link of a bundle in 
the Name column of the Bundles list, click the Actions tab, click one of the action set tabs 
(Distribute, Install, Launch, Repair, Uninstall, Terminate), click the Add drop-down list, then 
select an available action.

The following sections contains additional information:

 Section 6.16.1, “General,” on page 75
 Section 6.16.2, “Requirements,” on page 76

6.16.1 General
The Action - Install MSP dialog box lets you specify the location of the MSP file, command line 
parameters, and executable security level.

.msp File
Click , allow browser to launch Console Helper. In the Select .msp File dialog box, click browse and 
select the MSP file, and then click Upload. You can also enter the UNC path of the .msp file for a 
network install. 

If you have not installed Console Helper on this device, you must do so before you can browse for a 
file path.

Command Line Parameters
Specify the command line parameters that you want to run when the MSP file is installed. 

Executable Security Level
By default, the Run normal option is selected, which causes the application to run in the “user” space 
and inherit the same workstation security level as the logged-in user.

If the logged-in user's security level does not provide sufficient rights and file access to run the 
application, you can configure the application to run in the “system” space or as a dynamic 
administrator, as described below:

 Run as logged in user: The MSI application inherits the logged-in user’s credentials. For 
example, the application has the same rights to the registry and the file system as the logged-in 
user.
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Select the application’s initial window size: Normal, Minimized, Maximized, or Hidden. In Hidden 
mode, the application runs normally without a user interface available. This is useful if you want 
the application to process something then go away without user intervention.

 Run as secure system user (Don't allow system to interact with desktop): The application is 
run under the Local System user and inherits Administrator-level credentials. For example, the 
application has full rights to the registry and the file system. Because the security level is set to 
Secure, the application's interface is not displayed to the user and the application is only visible 
in the Task Manager. This option is useful when running applications that require full access to 
the workstation but require no user intervention.

 Run as dynamic administrator: A dynamic administrator is an administrator account that is 
created on the fly to perform certain procedures, such as installing applications. Using a 
dynamic administrator is helpful when installing applications (some MSI applications, for 
example) that cannot be installed in the system space. When you select this action, the dynamic 
administrator is created, it performs the required tasks, and then the account is deleted.
You cannot use mapped network drives to specify files and directories because dynamic 
administrators do not have access to mapped drives.

NOTE: Performing this action as dynamic administrator on a Windows domain controller fails 
because Microsoft does not allow the use of local administrator accounts on domain 
controllers.

6.16.2 Requirements
The Requirements page lets you define specific requirements that a device must meet for the action 
to be enforced on it. For information about the requirements, see Requirements.

6.17 Action - Install Network MSI
The Action - Install Network MSI dialog box lets you specify the location of the MSI file; its Install, 
Uninstall, and Repair parameters; transform file; and executable security level. You can also specify 
the specific requirements that a device must meet for the action to be executed on the device.

To access this dialog box in Endpoint Management Console, click the Bundles tab. Click the 
underlined link of a bundle in the Name column of the Bundles list, click the Actions tab, click one of 
the action set tabs (Distribute, Install, Launch, Repair, Uninstall, Terminate), click the Add drop-down 
list, then select an available action.

The following sections contains additional information:

 Section 6.17.1, “General,” on page 76
 Section 6.17.2, “Advanced,” on page 78
 Section 6.17.3, “Requirements,” on page 79

6.17.1 General
The Action - Install Network MSI dialog box lets you specify the location of the MSI file; its Install, 
Uninstall, and Repair parameters; the transform file; and the executable security level.
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.msi File
Click Browse, allow browser to launch Console Helper. In the Select File dialog box, click Browse, 
select the .msi file to install, and then click OK. 

If you have not installed Console Helper on this device, you must do so before you can browse for a 
file.

Install Parameters
Click  to display the Install Parameters dialog box, then specify the desired parameters. Click the 
Help button for additional information. 

Uninstall Parameters
Click  to display the Uninstall Parameters dialog box, then specify the desired parameters. Click the 
Help button for additional information. 

Repair Parameters
Click  to display the Repair Parameters dialog box, then specify the desired parameters. Click the 
Help button for additional information. 

MSI Properties
The MSI package contains the property values that were defined during the administrative 
installation of the application. These property values determine the way the Microsoft Windows 
Installer installs the application to the workstation. In some cases, you might want to change one or 
more of the property values. For example, a property value might define the default location for a 
user’s work files. By adding the property to the list and changing the property’s value, you can 
override the default location defined in the MSI package.

If necessary, you can add public properties that were not included in the MSI package. When doing 
so, you should be careful to add only those properties that are valid for the package. The following 
options are available:

 Add: To override a property value, you change the property value and add the property to the 
Properties list so that Application Launcher knows to use that property value rather than the 
one defined in the MSI package. To do so, click Add to display the MSI Properties dialog box. In 
the Name field, select the property whose value you want to override, specify the new value in 
the Value field, then click OK to add the property to the MSI Properties list.

 Edit: To modify a property that is in the MSI Properties list, select the property, click Edit, modify 
the value data, then click OK.

 Remove: To remove a property from the MSI Properties list, select the property, then click 
Remove. Deleting the property causes future installations of the application to use the property 
value defined in the MSI package.
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6.17.2 Advanced

Transform File

Click Add, in the Select Transform File dialog box click , allow browser to launch Console Helper. In 
the Select Transform File dialog box, click Browse, select the desired transform file, and then click 
Upload. You can upload the transform file or you can specify its location. 

If you have not installed Console Helper on this device, you must do so before you can browse to for 
a file path.

Different groups within an organization often use the same application, but that doesn’t mean they 
require the same feature set. One of the benefits of Windows Installer is that if you have 10 groups 
needing 10 different feature sets or other alterations for the same application, you can deploy the 
same MSI package to all 10 user groups, but with a different transform file (MST) applied for each 
group.

A transform file is a collection of changes applied to an MSI installation. It contains all modification 
information, such as whether features are installed; how they are installed; which files, shortcuts, 
and registry entries are included; and Add/Remove Programs applet information.

Executable Security Level
By default, the Run normal option is selected, which causes the application to run in the “user” space 
and inherit the same workstation security level as the logged-in user.

If the logged-in user's security level does not provide sufficient rights and file access to run the 
application, you can configure the application to run in the “system” space or as a dynamic 
administrator, as described below:

 Run as logged in user: The MSI application inherits the logged-in user’s credentials. For 
example, the application has the same rights to the registry and the file system as the logged-in 
user.

Select the application’s display mode: Normal, Minimized, Maximized, or Hidden. In Hidden 
mode, the application runs normally without a user interface available. This is useful if you want 
the application to process something, then go away without user intervention.

Select Grant administrator privilege to user during installation to provide administrator privileges 
to the logged-in user. However, providing administrator privileges to a user might pose security 
risks. If this option is selected, the user on the managed device is prompted to enter the 
password when the MSI is installed on the device. To install the MSI, the user must log in to the 
device with a user account that has a password configured.

 Run as secure system user (Don't allow system to interact with desktop): The application is 
run under the Local System user and inherits Administrator-level credentials. For example, the 
application has full rights to the registry and the file system. Because the security level is set to 
Secure, the application's interface is not displayed to the user and the application is only visible 
in the Task Manager. This option is useful when running applications that require full access to 
the workstation but require no user intervention.
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 Run as dynamic administrator: A dynamic administrator is an administrator account that is 
locally created on the fly to perform certain procedures, such as installing applications. Using a 
dynamic administrator is helpful when installing applications (some MSI applications, for 
example) that cannot be installed in the system space. Because the dynamic administrator does 
not have access to the network, the network shares on which the MSI is available must be made 
publicly accessible. When you select this action, the dynamic administrator is created, it 
performs the required tasks, and then the account is deleted. 
You cannot use mapped network drives to specify files and directories because dynamic 
administrators do not have access to mapped drives.

6.17.3 Requirements
The Requirements page lets you define specific requirements that a device must meet for the action 
to be enforced on it. For information about the requirements, see Requirements.

6.18 Action - Install Network MSIX
The Action - Install Network MSIX dialog box lets you specify the location of the MSIX file, its 
certificate, installation mode, and the executable security level. You can also specify the specific 
requirements that a device must meet for the action to be executed on the device.

To access this dialog box in Endpoint Management Console, click the Bundles tab. Click the 
underlined link of a bundle in the Name column of the Bundles list, click the Actions tab, click one of 
the action set tabs (Distribute, Install, Launch, Repair, Uninstall, Terminate), click the Add drop-down 
list, then select an available action.

The following sections contains additional information:

 Section 6.18.1, “General,” on page 79
 Section 6.18.2, “Advanced,” on page 80
 Section 6.18.3, “Requirements,” on page 80 

6.18.1 General
The Action - Install Network MSIX dialog box lets you specify the location of the MSIX file, upload a 
certificate, and choose an installation mode.

.msix File
Click Browse, allow browser to launch Console Helper. In the Select File dialog box, click Browse, 
select the .msix file to install, and then click OK.

If you have not installed Console Helper on this device, you must do so before you can browse for a 
file.

Select Certificate
If the certificate is not signed by a well-known CA, then you can upload a certificate by clicking the 
Select Certificate button. It supports the .pem, .crt, .cer, .der, .p7b, or .p7c file formats.
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Installation Mode
Select the desired install options:

 For Logged-in User Only: Installs the MSIX application for logged-in user only.
 For All Users of Device: Installs the MSIX application for all the users (Device wide installation).

6.18.2 Advanced

Executable Security Level
By default, the Run normal option is selected, which causes the application to run in the “user” 
space and inherit the same workstation security level as the logged-in user.

If the logged-in user's security level does not provide sufficient rights and file access to run the 
application, you can configure the application to run in the “system” space or as a dynamic 
administrator, as described below:

 Run as logged in user: The MSIX application inherits the logged-in user’s credentials. For 
example, the application has the same rights to the registry and the file system as the logged-in 
user.

Select the application’s display mode: Normal, Minimized, Maximized, or Hidden. In Hidden 
mode, the application runs normally without a user interface available. This is useful if you want 
the application to process something, then go away without user intervention.

Select Grant administrator privilege to user during installation to provide administrator privileges 
to the logged-in user. However, providing administrator privileges to a user might pose security 
risks. If this option is selected, the user on the managed device is prompted to enter the 
password when the MSIX is installed on the device. To install the MSIX, the user must log in to 
the device with a user account that has a password configured.

 Run as dynamic administrator: A dynamic administrator is an administrator account that is 
created on the fly to perform certain procedures, such as installing applications. Using a 
dynamic administrator is helpful when installing applications (some MSIX applications, for 
example) that cannot be installed in the system space. When you select this action, the dynamic 
administrator is created, it performs the required tasks, and then the account is deleted.
You cannot use mapped network drives to specify files and directories because dynamic 
administrators do not have access to mapped drives.

6.18.3 Requirements
The Requirements page lets you define specific requirements that a device must meet for the action 
to be enforced on it. For information about the requirements, see Requirements.
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6.19 Action - Launch Bundle
The Action - Launch Bundle dialog box lets you specify the bundle to launch on the device. You can 
also specify the specific requirements that a device must meet for the action to be executed on the 
device.

To access this dialog box in Endpoint Management Console, click the Bundles tab. Click the 
underlined link of a bundle in the Name column of the Bundles list, click the Actions tab, click one of 
the action set tabs (Distribute, Install, Launch, Repair, Uninstall, Terminate), click the Add drop-down 
list, then select an available action.

NOTE: When you create a bundle with one or more child bundles, then irrespective of the state of 
the child bundles (enabled or disabled), all the child bundles will be launched/executed if the parent 
bundle is enabled.

The following sections contains additional information:

 Section 6.19.1, “General,” on page 81
 Section 6.19.2, “Requirements,” on page 81

6.19.1 General
The General page lets you specify the bundle to launch on the device. Click  to display the Select 
the Bundle to Launch dialog box. 

The Look in list defaults to /Bundles. If you have created subfolders to hold your bundles, use the 
down- arrow to select the appropriate folder. The Items of type list defaults to All Types so that all 
types of bundles are displayed. Also, if you know the name of the bundle you are looking for, you can 
use the Item name box to search for the bundle.

Creating this action creates a bundle dependency. For more information, see Section 8.5, 
“Dependency Bundles,” on page 134.

6.19.2 Requirements
The Requirements page lets you define specific requirements that a device must meet for the action 
to be enforced on it. For information about the requirements, see Requirements.

6.20 Action - Launch Java Application
The Action - Launch Java Application dialog box lets you configure a Java program to be executed on 
the managed device. You can also specify the specific requirements that a device must meet for the 
action to be executed on the device.

To access this dialog box in Endpoint Management Console, click the Bundles tab. Click the 
underlined link of a bundle in the Name column of the Bundles list, click the Actions tab, click one of 
the action set tabs (Distribute, Install, Launch, Repair, Uninstall, Terminate), click the Add drop-down 
list, then select an available action.
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The following sections contains additional information:

 Section 6.20.1, “General,” on page 82
 Section 6.20.2, “Advanced,” on page 83
 Section 6.20.3, “Requirements,” on page 84

6.20.1 General
The General page lets you configure a Java program to be executed on the managed device.

Java Program Name
Specify the Java program name. For example, com.novell.TestProg.

Program Parameters
Specify the program parameters. 

Path to Java Runtime Executable (JRE)
Specify the path to the Java Runtime Executable (JRE).

JRE Parameters
Specify the JRE parameters. 

Wait Before Proceeding to Next Action
Specify what happens after the Java application launches:

 No wait: The next action in the list is immediately performed.
 When launch action is complete: The next action in the list is performed after the launch action 

completes.
 Wait for _ seconds: Wait the specified number of seconds before proceeding to the next action.

 Terminate action if wait period exceeded: If you select the Wait for _ seconds option, this 
option is enabled. If the specified number of seconds is exceeded and the action is not 
successfully performed, the action is terminated.

Run As
Click More Options to specify the Java application’s Run As settings.

 System: Runs the application as the system account (as a service).
 Administrator: Runs the application as a dynamic administrator user. A dynamic administrator 

is an administrator account that is created on the fly to perform certain procedures, such as 
installing applications or running scripts. Using a dynamic administrator is helpful when 
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installing applications (some MSI applications, for example) that cannot be installed in the 
system space. When you select this action, the dynamic administrator is created, it performs 
the required tasks, and then the account is deleted.

NOTE: Performing this action as dynamic administrator on a Windows domain controller fails 
because Microsoft does not allow the use of local administrator accounts on domain 
controllers.

 User: The application runs using the logged-in user’s credentials. For example, the application 
has the same rights to the registry and the file system as the logged-in user.

6.20.2 Advanced

Working Directory
Click More Options to specify the Java application’s working directory.

Specify the initial working directory for the application.

Success Return Codes
Specify the non-zero success codes that the executable returns. You can specify multiple success 
codes separated by commas.

If an executable returns non-zero success codes, you should specify these non-zero success codes 
while launching the action. For example, explorer.exe in Windows returns a success code of 1. To 
successfully launch the Explorer application, you should add 1 as the success code while launching 
the action.

If you leave this field blank, zero will be considered as the success code. Specify the Success Return 
Code as * to enable any non-zero code returned by a script to be treated as success.

Priority
Click More Options to specify the Java application’s priority.

Specify the priority of the process that runs the application. This option lets you configure how much 
of the CPU usage the application process consumes. Select from the following priorities: Real Time, 
High, Above Normal, Normal, Below Normal, and Low.
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Executable Security Level
By default, the Run normal option is selected, which causes the application to run in the “user” space 
and inherit the same workstation security level as the logged-in user.

If the logged-in user's security level does not provide sufficient rights and file access to run the 
application, you can configure the application to run in the “system” space or as a dynamic 
administrator, as described below:

 Run as logged in user: The MSI application inherits the logged-in user’s credentials. For 
example, the application has the same rights to the registry and the file system as the logged-in 
user.

Select the application’s display mode: Normal, Minimized, Maximized, or Hidden. In Hidden 
mode, the application runs normally without a user interface available. This is useful if you want 
the application to process something, then go away without user intervention.

Select Grant administrator privilege to user during installation to provide administrator privileges 
to the logged-in user. However, providing administrator privileges to a user might pose security 
risks. If this option is selected, the user on the managed device is prompted to enter the 
password when the MSI is installed on the device. To install the MSI, the user must log in to the 
device with a user account that has a password configured.

 Run as secure system user (Don't allow system to interact with desktop): The application is 
run under the Local System user and inherits Administrator-level credentials. For example, the 
application has full rights to the registry and the file system. Because the security level is set to 
Secure, the application's interface is not displayed to the user and the application is only visible 
in the Task Manager. This option is useful when running applications that require full access to 
the workstation but require no user intervention.

 Run as dynamic administrator: A dynamic administrator is an administrator account that is 
locally created on the fly to perform certain procedures, such as installing applications. Using a 
dynamic administrator is helpful when installing applications (some MSI applications, for 
example) that cannot be installed in the system space. Because the dynamic administrator does 
not have access to the network, the network shares on which the MSI is available must be made 
publicly accessible. When you select this action, the dynamic administrator is created, it 
performs the required tasks, and then the account is deleted. 
You cannot use mapped network drives to specify files and directories because dynamic 
administrators do not have access to mapped drives.

6.20.3 Requirements
The Requirements page lets you define specific requirements that a device must meet for the action 
to be enforced on it. For information about the requirements, see Requirements.
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6.21 Action - Launch URL
The Action - Launch URL dialog box lets you specify the URL to launch on the device. You can also 
specify the specific requirements that a device must meet for the action to be executed on the 
device.

To access this dialog box in Endpoint Management Console, click the Bundles tab. Click the 
underlined link of a bundle in the Name column of the Bundles list, click the Actions tab, click one of 
the action set tabs (Distribute, Install, Launch, Repair, Uninstall, Terminate), click the Add drop-down 
list, then select an available action. 

NOTE: When you create a bundle and select the Launch URL action, then assign the bundle to a 
device, each action launches the URL in a new tab in the same window. 

In a whitelisted environment, the Launch URL action might not work as expected. By default, the 
whitelisting feature is disabled for the Launch URL action. To enable the Launch URL action to work in 
a whitelisted environment, you need to add a registry String value named UseShellExecute,to 
HKLM\software\OpenText\EndpointAgent\, and set the value data to false. However, when 
the whitelisting feature is enabled, the action launches the URL in a new browser window instead of 
a new tab.

The following sections contains additional information:

 Section 6.21.1, “General,” on page 85
 Section 6.21.2, “Requirements,” on page 85

6.21.1 General
The General page lets you specify the URL to launch on the device. Click Test URL to open a Web 
browser to verify that the URL is correct.

6.21.2 Requirements
The Requirements page lets you define specific requirements that a device must meet for the action 
to be enforced on it. For information about the requirements, see Requirements.

6.22 Action - Launch Executable
The Add Actions - Launch Executable dialog box lets you specify the Windows executable, command 
line parameters, and additional optional settings. You can also specify the specific requirements that 
a device must meet for the action to be executed on the device. 

To access this dialog box in Endpoint Management Console, click the Bundles tab. Click the 
underlined link of a bundle in the Name column of the Bundles list, click the Actions tab, click one of 
the action set tabs (Distribute, Install, Launch, Repair, Uninstall, Terminate), click the Add drop-down 
list, then select an available action.
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NOTE: It is recommended that you do not place an installation under the Launch Executable tab - 
only the command that starts an installed application. Applications start faster when there are less 
actions under Launch. 

The following sections contains additional information:

 Section 6.22.1, “General,” on page 86
 Section 6.22.2, “Advanced,” on page 87
 Section 6.22.3, “Launch Options,” on page 88
 Section 6.22.4, “Requirements,” on page 90

6.22.1 General
The General page lets you specify the location of the Windows executable, the command line 
parameters to run when the executable launches, the working directory for the executable, and the 
non-zero success codes that the executable returns. 

Field Description

Command Specify the location of the Windows executable, including its filename. 

You can specify a local path or a network drive. If you specify the local path, you must 
include the executable’s full path, unless the executable is included in the 
workstation’s search path. If you specify a network drive, you can use a mapped drive 
or a UNC path, if the workstation can resolve the path.

If you have not installed Console Helper on this device, you must do so before you can 
browse for a file path.

Command Line 
Parameters 

Specify the command line parameters that you want to run when the executable 
launches.

NOTE: As a best practice, you can add a space at the beginning of the field to ensure 
that there is a space between the command and the parameters when the command 
is run by the client.

Working Directory Specify the working directory for the executable.

Success Return Codes Specify the non-zero success codes that the executable returns. You can specify 
multiple success codes separated by commas.

If an executable returns non-zero success codes, you should specify these non-zero 
success codes while launching the action. For example, explorer.exe in Windows 
returns a success code of 1. To successfully launch the Explorer application, you 
should add 1 as the success code while launching the action.

If you leave this field blank, zero will be considered as the success code. Specify the 
Success Return Code as * to enable any non-zero code returned by a script to be 
treated as success.
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6.22.2 Advanced
The Advanced page lets you specify the Window executable’s security level and the wait time after 
launch of windows executable and before proceeding to the next action. 

Environment 
Variables

Lets you add, edit or remove the environment variables as follows:

 Add: Click Add to display the Add Environment Variable dialog box. Specify the 
name and value of the environment variable you want to add. For example, 
Name = JAVA_HOME; Value = C:\java1.4\.

NOTE: Add the ZENPREDEF_REDIRCTSTANDARDOUTPUT predefined 
environment variable and set it to true to redirect the standard output of a 
variable or command to the specified file or location. For example, if the 
command line parameter is /c echo%var% > c:\temp\test.txt, the 
standard output of var will be redirected to c:\temp\test.txt file.

 Remove: Select the environment variables to remove and click Remove.
 Edit: Select the environment variable you want to edit, then click Edit. In the Edit 

Environment Variable dialog box, specify the new value for the variable. For 
example, Name = JAVA_HOME; Value = C:\Program 
Files\Java\jdk1.6.0_06. 

Field Description

Field Description

Wait Before 
Proceeding to Next 
Action

Click More Options to specify how long to wait after launching the Windows 
executable and before proceeding to the next action.

Specify what happens after the executable launches:

No wait: The next action in the list is immediately performed.

When launch action is complete: The next action in the list is performed after the 
launch action completes. For example, enable this option if you are running the 
action as a dynamic administrator and you want the profile cleaned up and deleted 
immediately. If you do not enable this option, the profile is cleaned up and deleted at 
the device’s next reboot.

This option can be used in a scenario in which you want to run an inventory after the 
installation of program and you have to wait until the installation is finished before 
running the zac inv scannow action since the new applications will otherwise 
not be inventoried.

Wait for _ seconds: Wait the specified number of seconds before proceeding to the 
next action.

 Terminate action if wait period exceeded: If you select the Wait for _ seconds 
option, this option is enabled. If the specified number of seconds is exceeded 
and the action is not successfully performed, the action terminates.
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6.22.3 Launch Options
The Launch Options page lets you specify the Window executable’s compatibility mode, display 
settings, and the input settings. 

Executable Security 
Level

The executable can run in either the “user” space or the “system” space. By default, 
the Run normal option is selected, which causes the application to run in the “user” 
space and inherit the same workstation security level as the logged-in user.

If the logged-in user's security level does not provide sufficient rights and file access 
to run the executable, you can configure the executable to run in the “system” space 
or as a dynamic administrator, as described below:

 Run as logged in user: The executable inherits the logged-in user’s credentials. 
For example, the executable has the same rights to the registry and the file 
system as the logged-in user.

Select this option if the user has sufficient rights to execute the action.

Select the executable’s initial window size: Normal, Minimized, Maximized, or 
Hidden. In Hidden mode, the executable runs normally without a user interface 
available. This is useful if you want the executable to process something, then go 
away without user intervention.

 Run as secure system user (Don't allow system to interact with desktop): The 
executable is run under the Local System user and inherits Administrator-level 
credentials. For example, the executable has full rights to the registry and the 
file system. Because the security level is set to Secure, the executable's interface 
is not displayed to the user and the executable is only visible in the Task 
Manager. This option is useful when running executables that require full access 
to the workstation but require no user intervention.
If the installer displays a progress window or tries to interact with the user, the 
action will fail.

 Run as dynamic administrator: A dynamic administrator is an administrator 
account that is created on the fly to perform certain procedures, such as 
installing applications. Using a dynamic administrator is helpful when installing 
applications (some MSI applications, for example) that cannot be installed in the 
system space. When you select this action, the dynamic administrator is created, 
it performs the required tasks, and then the account is deleted.
This option will fail if an installation makes changes in the Registry’s HKCU hive 
(Current user) for the logged in user.
When performing actions as a dynamic administrator, ensure that you select the 
When action is compete option in the Wait before proceeding to next action 
group box. Selecting this option ensures that the action is completed and the 
process has terminated and released its resources before Endpoint Management 
begins cleaning up and deleting the dynamic administrator account.
You cannot use mapped network drives to specify files and directories because 
dynamic administrators do not have access to mapped drives.

Field Description
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Field Description

Compatibility Mode Click More Options to specify the Window executable’s compatibility mode.

Launches the executable in a contained environment. Some executables cannot run 
on workstations with newer versions of Microsoft* Windows because of 
incompatibility issues. The drop-down list is available after you select the 
Compatibility mode option.

Select this option if you successfully ran an executable on a previous Windows version 
but you are unable to run the executable on the device’s current Windows version. 
Select the desired platform from the list.

Display Click More Options to specify the Window executable’s display settings.Select the 
desired display options: Run in 256 colors: Sets the color quality setting to 256 colors 
while this executable is running. The color quality setting reverts back to your default 
setting when you close the executable. Run in 640 × 480 screen resolution: Sets the 
screen resolution setting to 640 × 480 while this executable is running. The color 
quality setting reverts back to your default setting when you close the executable. 
Disable visual themes: Disables visual themes from being applied to the executable. If 
you are experiencing problems with menus or buttons on the title bar of the 
executable, this setting might solve these problems. The theme settings revert back 
to your default setting when you close the executable.

Input Settings Click More Options to specify the Window executable’s input settings.

Temporarily turns off handwriting recognition, speech recognition, and some 
accessibility features. Turning off text services does not affect multiple languages or 
keyboards that you have added.

Use the operating 
system shell to start 
the process

This option is enabled by default and allows the executable specified in the action to 
be launched through the operating system shell.

Deselect this option to prevent the executable specified in the action from being 
launched through the operating system shell. Consequently, the executable can now 
be launched only through the applications configured in the system’s list of allowed 
applications.

To add applications to the system’s list of the allowed applications:

1. In the Endpoint Management Console, create a new Windows Group Policy.
2. In the Windows Group Policy settings page, select Local Group Policy and click 

Configure.
3. In the Group Policy window, navigate to User Configuration > Administrative 

Templates > System.
4. Double-click Run only allowed Windows applications.
5. In the Settings tab, select Enabled and click Show.
6. In the Show Contents window, click Add and enter the name of the application 

as zapp-launcher.exe and click OK.
7. Click Apply, then OK.

You can now launch the executable only if it is available in the NAL window.
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6.22.4 Requirements
The Requirements page lets you define specific requirements that a device must meet for the action 
to be enforced on it. For information about the requirements, see Requirements.

6.23 Action - Install Executable
The Add Actions - Install Executable dialog box lets you upload a Windows executable, specify the 
launching options of the executable, and other additional parameters. You can also specify the 
requirements that a device must meet for the action to be executed on the device. When the Install 
Executable action is executed, the content is downloaded to Endpoint Management cache and the 
executable is run directly from cache, therefore both the install and launch actions are performed by 
this action set.

To access this dialog box in Endpoint Management Console, click the Bundles tab. Click the 
underlined link of a bundle in the Name column of the Bundles list, click the Actions tab, click one of 
the action set tabs (Distribute, Install, Launch, Repair, Uninstall, Terminate), click the Add drop-down 
list, then select an available action.

The following sections contains additional information:

 Section 6.23.1, “General,” on page 90
 Section 6.23.2, “Advanced,” on page 91
 Section 6.23.3, “Launch Options,” on page 93
 Section 6.23.4, “Requirements,” on page 95

6.23.1 General
The General page lets you upload the Windows executable, the command line parameters to run 
when the executable launches, the working directory for the executable, and the non-zero success 
codes that the executable returns. 

Field Description

Executable File Upload the Windows executable. You can also upload all the files in the same 
directory in which the executable is present.

If you have not installed Console Helper on this device, you must do so before you can 
browse for a file path.

Command Line 
Parameters 

Specify the command line parameters that you want to run when the executable 
launches.
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6.23.2 Advanced
The Advanced page lets you specify the Window executable’s security level and the wait time after 
launch of windows executable and before proceeding to the next action. 

Success Return Codes Specify the non-zero success codes that the executable returns. You can specify 
multiple success codes separated by commas.

If an executable returns non-zero success codes, you should specify these non-zero 
success codes while launching the action. For example, explorer.exe in Windows 
returns a success code of 1. To successfully launch the Explorer application, you 
should add 1 as the success code while launching the action.

If you leave this field blank, zero will be considered as the success code. Specify the 
Success Return Code as * to enable any non-zero code returned by a script to be 
treated as success.

Environment 
Variables

Lets you add, edit or remove the environment variables as follows:

 Add: Click Add to display the Add Environment Variable dialog box. Specify the 
name and value of the environment variable you want to add. For example, 
Name = JAVA_HOME; Value = C:\java1.4\.

NOTE: Add the ZENPREDEF_REDIRCTSTANDARDOUTPUT predefined 
environment variable and set it to true to redirect the standard output of a 
variable or command to the specified file or location. For example, if the 
command line parameter is /c echo%var% > c:\temp\test.txt, the 
standard output of var will be redirected to c:\temp\test.txt file.

 Remove: Select the environment variables to remove and click Remove.
 Edit: Select the environment variable you want to edit, then click Edit. In the Edit 

Environment Variable dialog box, specify the new value for the variable. For 
example, Name = JAVA_HOME; Value = C:\Program 
Files\Java\jdk1.6.0_06. 

Field Description
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Field Description

Wait Before 
Proceeding to Next 
Action

Click More Options to specify how long to wait after launching the Windows 
executable and before proceeding to the next action.

Specify what happens after the executable launches:

Do not wait: The next action in the list is immediately performed.

Proceed when an action is complete: The next action in the list is performed after 
the launch action completes. For example, enable this option if you are running the 
action as a dynamic administrator and you want the profile cleaned up and deleted 
immediately. If you do not enable this option, the profile is cleaned up and deleted at 
the device’s next reboot.

Wait for _ seconds: Wait the specified number of seconds before proceeding to the 
next action.

 Terminate an action if it has exceeded the wait duration: If you select the Wait 
for _ seconds option, this option is enabled. If the specified number of seconds 
is exceeded and the action is not successfully performed, the action terminates.
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6.23.3 Launch Options
The Launch Options page lets you specify the Window executable’s compatibility mode, display 
settings, and the input settings. 

Executable Security 
Level

The executable can run in either the “user” space or the “system” space. By default, 
the Run normal option is selected, which causes the application to run in the “user” 
space and inherit the same workstation security level as the logged-in user.

If the logged-in user's security level does not provide sufficient rights and file access 
to run the executable, you can configure the executable to run in the “system” space 
or as a dynamic administrator, as described below:

 Run as logged in user: The executable inherits the logged-in user’s credentials. 
For example, the executable has the same rights to the registry and the file 
system as the logged-in user.

Select the executable’s initial window size: Normal, Minimized, Maximized, or 
Hidden. In Hidden mode, the executable runs normally without a user interface 
available. This is useful if you want the executable to process something, then go 
away without user intervention.

 Run as secure system user (Don't allow system to interact with desktop): The 
executable is run under the Local System user and inherits Administrator-level 
credentials. For example, the executable has full rights to the registry and the 
file system. Because the security level is set to Secure, the executable's interface 
is not displayed to the user and the executable is only visible in the Task 
Manager. This option is useful when running executables that require full access 
to the workstation but require no user intervention.

 Run as dynamic administrator: A dynamic administrator is an administrator 
account that is created on the fly to perform certain procedures, such as 
installing applications. Using a dynamic administrator is helpful when installing 
applications (some MSI applications, for example) that cannot be installed in the 
system space. When you select this action, the dynamic administrator is created, 
it performs the required tasks, and then the account is deleted.
When performing actions as a dynamic administrator, ensure that you select the 
When action is compete option in the Wait before proceeding to next action 
group box. Selecting this option ensures that the action is completed and the 
process has terminated and released its resources before Endpoint Management 
begins cleaning up and deleting the dynamic administrator account.
You cannot use mapped network drives to specify files and directories because 
dynamic administrators do not have access to mapped drives.
Select the network access credentials:  If the file or directory specified in the 
action are a part of the UNC path or network share that can be accessed only 
through credentials, then browse through the credential vault to select a 
credential that has access to the network. 
NOTE: Performing this action as dynamic administrator on a Windows domain 
controller fails because Microsoft does not allow the use of local administrator 
accounts on domain controllers.

Field Description
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Field Description

Compatibility Mode Click More Options to specify the Window executable’s compatibility mode.

Launches the executable in a contained environment. Some executables cannot run 
on workstations with newer versions of Microsoft* Windows because of 
incompatibility issues. The drop-down list is available after you select the 
Compatibility mode option.

Select this option if you successfully ran an executable on a previous Windows version 
but you are unable to run the executable on the device’s current Windows version. 
Select the desired platform from the list.

Display Click More Options to specify the Window executable’s display settings.Select the 
desired display options: Run in 256 colors: Sets the color quality setting to 256 colors 
while this executable is running. The color quality setting reverts back to your default 
setting when you close the executable. Run in 640 × 480 screen resolution: Sets the 
screen resolution setting to 640 × 480 while this executable is running. The color 
quality setting reverts back to your default setting when you close the executable. 
Disable visual themes: Disables visual themes from being applied to the executable. If 
you are experiencing problems with menus or buttons on the title bar of the 
executable, this setting might solve these problems. The theme settings revert back 
to your default setting when you close the executable.

Input Settings Click More Options to specify the Window executable’s input settings.

Temporarily turns off handwriting recognition, speech recognition, and some 
accessibility features. Turning off text services does not affect multiple languages or 
keyboards that you have added.

Use the operating 
system shell to start 
the process

This option is enabled by default and allows the executable specified in the action to 
be launched through the operating system shell.

Deselect this option to prevent the executable specified in the action from being 
launched through the operating system shell. Consequently, the executable can now 
be launched only through the applications configured in the system’s list of allowed 
applications.

To add applications to the system’s list of the allowed applications:

1. In the Endpoint Management Console, create a new Windows Group Policy.
2. In the Windows Group Policy settings page, select Local Group Policy and click 

Configure.
3. In the Group Policy window, navigate to User Configuration > Administrative 

Templates > System.
4. Double-click Run only allowed Windows applications.
5. In the Settings tab, select Enabled and click Show.
6. In the Show Contents window, click Add and enter the name of the application 

as zapp-launcher.exe and click OK.
7. Click Apply, then OK.

You can now launch the executable only if it is available in the NAL window.
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6.23.4 Requirements
The Requirements page lets you define specific requirements that a device must meet for the action 
to be enforced on it. For information about the requirements, see Requirements.

6.24 Action - Launch Windows Thin Client Application
The Action - Launch Windows Thin Client Application dialog box lets you specify to launch an ICA 
(Independent Computing Architecture) or RDP (Remote Desktop Protocol) client session and 
configure the appropriate settings. 

You can also specify the specific requirements that a device must meet for the action to be executed 
on the device. 

You can access this information by using the following methods:

 As part of the process of creating a Windows bundle by using the Thin Client Application bundle 
category. For more information, see Section 2.2, “Creating Windows Bundles,” on page 19.

 In Endpoint Management Console, click the Bundles tab, click the underlined link of a bundle in 
the Name column of the Bundles list, click the Actions tab, click one of the action set tabs 
(Distribute, Install, Launch, Repair, Uninstall, Terminate), click the Add drop-down list, then 
select an available action.

The following sections contain additional information:

 Section 6.24.1, “General,” on page 95
 Section 6.24.2, “Requirements,” on page 96

6.24.1 General
The General page lets you specify to launch an ICA (Independent Computing Architecture) or RDP 
(Remote Desktop Protocol) client session and configure the appropriate settings. 

ICA Session
Select this option if the terminal server requires the application to run in an ICA client session. Citrix 
MetaFrame requires ICA client sessions.

Published Application Name: Type the published application name exactly as it is defined in Citrix.

Servers Hosting the Application: Add the Citrix servers that host the application.

1 Type the server’s IP address or hostname.
2 Click Add.

The order in which the servers are listed is the preferred order for launching. You can use the Move 
Up and Move Down buttons to change the order if necessary.

To set user domain name: 
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When creating a windows bundle, you should create the Edit INI Files action, add 
Domain=[CustomerDomain] as key, and then add the Launch Windows Thin Client Application 
action to set the user domain name.

For more information on Edit INI files, see Section 6.7, “Action - Edit INI File,” on page 57.

If the Selecting the Append key-value separator to the key when value is not available option is 
selected, then the thin client bundle action enables you to pass- through a user domain name.

RDP Session
Select this option if the terminal server requires the application to run in an RDP client session. 
Microsoft Windows Terminal Server requires RDP client sessions.

Terminal Server Address: Specify the terminal server’s IP address or hostname.

Server Port: If the terminal server is not using default port 3389, specify the correct port number.

Server Domain: If the terminal server is part of a Windows NT domain or an Active Directory 
domain, specify the domain name.

Application Path: Specify the path to the application’s executable file from the perspective of the 
terminal server.

Application Working Directory: Specify the path to the directory you want the application to use for 
its working files.

Color Depth: Select the number of colors for the RDP client session. You can select 256 Colors, High 
Color (15 bits), High Color (16 bits), or True Color (24 bits). The default is True Color (24 bits).

Screen Size: If you want the RDP client session to use the entire desktop area, select Operate in full 
screen mode. Otherwise, select Use specified screen size and manually set the width and height (in 
pixels).

Advanced Settings for redirection: Select the settings, such as drivers, printers, serial ports, and 
smart cards, that you want to map to the remote desktop machine.

6.24.2 Requirements
The Requirements page lets you define specific requirements that a device must meet for the action 
to be enforced on it. For information about the requirements, see Requirements.

6.25 Action - Prompt User
The Action - Prompt User dialog box lets you specify that a prompt displays on the device and 
configure its settings. You can also specify the specific requirements that a device must meet for the 
action to be executed on the device.

To access this dialog box in Endpoint Management Console, click the Bundles tab. Click the 
underlined link of a bundle in the Name column of the Bundles list, click the Actions tab, click one of 
the action set tabs (Distribute, Install, Launch, Repair, Uninstall, Terminate), click the Add drop-down 
list, then select an available action.
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The following sections contains additional information:

 Section 6.25.1, “General,” on page 97
 Section 6.25.2, “Requirements,” on page 99

6.25.1 General
The General page lets you specify that a prompt displays on the device and configure its settings.

User Cancels Allowed
Specify the number of times that you can cancel the remaining actions in the action set. 

Set the value of the CancelOnNoResponse registry key to 1 to cancel the remaining actions in the 
action set. 

In addition to the prerequisite above, you need to define the prompts in the Add Action - Prompt 
User page. In the Define Prompt(s) table, click Add to select the locale and the prompt. In the Prompt 
field, in the Select Locale and Prompt dialog box, do the following:

 Include {0} in your text to provide a running counter that counts down the number of seconds 
to 0.

 Include {1} for prompting the number of cancels or postpones allowed.
 Include {2} for prompting the remaining cancels or postpones allowed.

For example, you can specify the following text:

Scheduled Updates: Updates will be applied if there is no response within {0} time. You have {2} 
attempts left out of {1} to postpone this activity.

If the action set installs an application that requires a reboot, and you select this option, you can 
cancel the reboot. This will in turn, cancel the installation. The install action set is performed again 
according to its schedule. For this reason, use this option carefully. There is no Cancel button on the 
dialog box if you use the default setting of 0.

If the value of the User Cancels Allowed field is 5, you can cancel the install up to 5 times. The 
number of cancels remaining is also displayed. 

NOTE: If you configure the Prompt User action, with the User Cancels Allowed value set as 1 or more, 
the Cancel or Postpone button is displayed depending on the ShowCancelInPrompt registry key. If 
the value of this registry key is set to True then the Prompt User action, configured with the User 
Cancels Allowed option will display the Cancel button, else it will display the Postpone button. 
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Seconds to be Displayed
Specify the number of seconds that the prompt is displayed before the action is performed. For 
example, you configure a prompt that appears during an application installation before the device 
performs a required reboot. If you specify that the user can cancel the action set and you enter 10 
seconds as the value of the Seconds to be Displayed field, the prompt displays for 10 seconds and 
then the device reboots.

The reboot control and the prompt control messages display the time in hours, minutes and 
seconds.

For example, if you define the option {0} in the Prompt field and enter 3606 as the value in the 
Seconds to be Displayed field, then the message displays the time as 1:00:06.

How Often to Prompt
Select the desired option:

 Always: Display the prompt every time the action is performed.
 Once per device: Display the prompt once on the device, regardless of how many users log in.
 Once per user: Display the prompt once per user, regardless of how many devices the user logs 

in to.

Define Prompts
Define the prompt that you want to display on the device. Additionally, you can specify different 
locales with different messages.

The Endpoint Agent automatically detects the locale of the operating system and displays the 
prompt defined in the same locale as the operating system locale. However, if the operating system 
locale does not match any of the specified locales, then Endpoint Management displays the prompt 
defined by the first locale in the list.

To create a message:

1 Click Add to display the Select Locale and Prompt dialog box.
2 Select a language from the Locale drop-down list. The message displays only on devices in the 

specified locale. You can create different messages, each with its own locale setting.
3 Type the text you want to display on the device.

You can include {0} in your text to provide a running counter that counts down the number of 
seconds to 0, after which the prompt is auto-accepted. For example, you could specify the 
following text:
The machine will reboot in {0} seconds. Please save your work and close 
any open applications.
The message displays for the number of seconds specified in the Seconds to be Displayed field.

4 Click OK.
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6.25.2 Requirements
The Requirements page lets you define specific requirements that a device must meet for the action 
to be enforced on it. For information about the requirements, see Requirements.

6.26 Action - Reboot/Shutdown
The Action - Reboot/Shutdown dialog box lets you specify the reboot or shutdown action for the 
device. You can also specify the specific requirements that a device must meet for the action to be 
executed on the device.

To access this dialog box in Endpoint Management Console, click the Bundles tab. Click the 
underlined link of a bundle in the Name column of the Bundles list, click the Actions tab, click one of 
the action set tabs (Distribute, Install, Launch, Repair, Uninstall, Terminate), click the Add drop-down 
list, then select an available action.

NOTE: The Reboot action should not normally be used in conjunction with a Recurring launch set to 
When a device is refreshed. Although there are some valid use scenarios for this configuration, 
scheduling a device to reboot upon refresh can cause a continuous loop. 

The following sections contains additional information:

 Section 6.26.1, “General,” on page 99
 Section 6.26.2, “Requirements,” on page 101

6.26.1 General
The General page lets you specify the reboot or shutdown action for the device.

Reboot
Reboot the device when this action is performed.

Shutdown
Shut down the device when this action is performed.

Time to Wait Before Reboot/Shutdown
Specify the number of seconds (between -1 and 1800) before the device reboots or shuts down. 
When the number of seconds specified passes, the device reboots or shuts down, regardless of 
whether the user clicks OK or not. Clicking OK does not cause the device to immediately reboot or 
shut down. 

A value of -1 causes the device to wait an indefinite period of time, essentially preventing the device 
from rebooting or shutting down. You should use a value of -1 in conjunction with the Display a 
warning message before doing Reboot/Shutdown and, optionally, the Allow user to cancel options. If 
you specify -1 and select the Display a warning message before doing Reboot/Shutdown option, a 
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message displays indefinitely until the user clicks OK to perform the reboot or shutdown process. If 
you select both this option and the Allow user to cancel option, a message displays indefinitely until 
the user clicks OK or Cancel.

A value of -1 causes the device to wait an indefinite period of time, essentially preventing the device 
from rebooting or shutting down. You should use a value of -1 in conjunction with the Display a 
warning message before doing Reboot/Shutdown and, optionally, the Allow user to cancel options. If 
you specify -1 and select the Display a warning message before doing Reboot/Shutdown option, a 
message displays indefinitely until the user clicks OK to perform the reboot or shutdown process. If 
you select this option and the Allow user to cancel option, a message displays indefinitely until the 
user clicks OK or Cancel.

Display a Warning Message Before Doing Reboot/Shutdown
Specify that a message displays on the device, warning the user that the device is going to reboot or 
shut down.

For example, you could provide the following prompt:

The machine will reboot in _ seconds. Please save your work and close any 
open applications.
Before performing the action, the message displays on the device only if the user is logged in.

Allow User to Cancel
Specify whether the user can cancel the reboot or shutdown procedure.

Define Prompts
Define the prompt that you want to display on the device. Additionally, you can specify different 
locales with different messages. If you do not specify another locale, a default English message 
displays.

To create a message:

1 Click Add to display the Select Locale and Prompt dialog box.
2 Select a language from the Locale drop-down list. The message displays only on devices in the 

specified locale. You can create different messages, each with its own locale setting.
3 Type the text you want to display on the device.

You can include {0} in your text to provide a running counter that counts down the number of 
seconds to 0, after which the prompt is auto-accepted. For example, you could specify the 
following text:
The machine will reboot in {0} seconds. Please save your work and close 
any open applications.
The message displays for the number of seconds specified in the Seconds to be Displayed field.

4 Click OK.
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6.26.2 Requirements
The Requirements page lets you define specific requirements that a device must meet for the action 
to be enforced on it. For information about the requirements, see Requirements.

6.27 Action - Registry Edit
The Action - Registry Edit dialog box lets you configure the registry file to apply. We recommend that 
you back up the registry before applying the specified registry file, and ensure that the file is 
properly formatted and well tested. You can also specify the specific requirements that a device 
must meet for the action to be executed on the device.

To access this dialog box in Endpoint Management Console, click the Bundles tab. Click the 
underlined link of a bundle in the Name column of the Bundles list, click the Actions tab, click one of 
the action set tabs (Distribute, Install, Launch, Repair, Uninstall, Terminate), click the Add drop-down 
list, then select an available action.

The following sections contain additional information:

 Section 6.27.1, “General,” on page 101
 Section 6.27.2, “Advanced,” on page 104
 Section 6.27.3, “Requirements,” on page 105

6.27.1 General
The General page lets you configure the registry file to apply. You can select hives in the tree to 
which you want to add values and keys, rename or remove sections, or import a registry file. We 
recommend that you back up the registry before applying the specified registry file, and ensure that 
the file is properly formatted and well tested.

NOTE: It is recommended that you do not create a registry key with Default as value. If you create 
a registry key with Default as value and try to perform a registry update, then the registry edit 
action will update the Windows Default registry value and not the user created Default registry 
value.

The following table lists the tasks you can perform to manage registry tree changes:
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Task Steps

Add a registry key 1. Select a registry hive, click New, then click Key.
2. Specify the key’s name. For example, Software.

You can also specify multiple levels of keys by separating them with a backslash 
(\).
Do not use the forward slash (/) as a separator.

3. Select one of the following registry operations:
 Create Always: Creates the key regardless of whether the key currently 

exists in the workstation’s registry.
 Create If Does Not Exist: Creates the key only if the key does not currently 

exist in the workstation’s registry.
 Rename: Renames the key if it currently exists in the workstation’s registry.
 Delete: Deletes the key if it currently exists in the workstation’s registry.
 Delete and Recreate: Deletes the key if it currently exists in the 

workstation’s registry and then recreates the key.
 Delete if Empty: Deletes the key if it currently exists in the workstation’s 

registry and the key is empty.
 None: Does not perform any registry operation.
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Add a Value 1. Select the check box next to the desired item, then click Value to display the Add 
Value To dialog box.

2. Select one of the following options from the Value Type list:
 Default: Adds a default string value to the selected key.
 String: Adds a string value to the selected key.
 Binary: Adds a binary value to the selected key. Most hardware component 

information is stored as binary data and is displayed in hexadecimal format. 
 Dword: Adds a DWORD value to the selected key. DWORD values are 

represented by a number that is 4 bytes long. Many parameters for device 
drivers and services are this type and are displayed in binary, hexadecimal, 
or decimal format.

 Expandable String: Adds an expand string value to the selected key. An 
expandable string is a variable-length data string. This data type includes 
variables that are resolved when a program or service uses the data.

 Multiple String: Adds a multi-value string to the selected key. Multiple 
string values contain lists or multiple values in a form that people can read. 
Entries are separated by spaces, commas, or other marks.

 Qword: Adds a Qword string to the selected key. A Qword value is data 
represented by a number that is a 64-bit integer. This data is displayed in 
Registry Editor as a Binary Value.

 Link: Adds a link string value to the selected key. A link string value is a 
Unicode string naming a symbolic link.

 None: Does not perform any registry operation.
 Full Resource Descriptor: Adds a full resource descriptor value to the 

selected key. A full resource descriptor is a series of nested arrays designed 
to store a resource list for a hardware component or driver.

 Resource List: Adds a resource list to the selected key. A resource list is a 
series of nested arrays that is designed to store a resource list that is used 
by a hardware device driver or one of the physical devices it controls.

 Resource Requirement List: Adds a resource requirements list to the 
selected key. A resource requirements list is a series of nested arrays 
designed to store a device driver's list of possible hardware resources the 
driver or one of the physical devices it controls can use.

3. Specify the data. Depending on which value type you selected in the previous 
step, the type of data varies.

4. Select one of the following registry operations:
 Create Always: The setting is always created in the registry, even if it 

already exists. If it exists, the setting's current values are overwritten. For 
example, if PATH=C:\ already exists, PATH=C:\TEMP replaces it.

 Create If Exists: The setting is created only if it already exists. The setting's 
current values are overwritten. For example, if PATH=C:\ already exists, 
PATH=C:\TEMP replaces it.

 Create If Does Not Exist: The setting is created only if it does not already 
exist.

Task Steps
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6.27.2 Advanced 
The Advanced page lets you specify how you want the action to run (as system or user) and to back 
up the registry file before applying the modified registry file

 Delete: The setting is deleted. If the registry setting has subordinate settings, 
the subordinate settings are also deleted.

 Append If Exists, Otherwise Create: Appends the Value if the value currently 
exists in the workstation’s registry. If the Value does not exist, it is created.

 Prepend If Exists, Otherwise Create: Prepends the Value if the value currently 
exists in the workstation’s registry. If the Value does not exist, it is created.

Rename an entry 1. Select the check box next to the desired item, then click Edit > Rename.
2. Specify the new name.

Select all the objects 
of a parent folder 

1. Select the check box next to the parent folder, then click Edit > Select All 
Children.

Deselect all the 
objects of a parent 
folder

1. Select the check box next to the parent folder, then click Edit > Deselect All 
Children.

Clear Selection 1. Click Edit > Clear Selection.

Remove an entry 1. Select the check box next to the desired item, then click Delete.

Import the contents 
of a registry file

1. Click Import, then specify the registry file whose contents you want to import.

NOTE: A .reg file does not allow you to store the Data Type information of the value 
being deleted. For more information, see Deleting Registry Keys and Values at 
Microsoft Support Site (http://support.microsoft.com/kb/310516). 

Consequently, when you import a registry file that has a value marked for deletion in 
the file, the value defaults to a String Data Type. However, this behavior does not 
affect the deletion of values from the Windows Registry of the managed device.

Export the contents 
to a registry file

1. Click Export to export the contents to a registry file named by default as 
bundle_name.reg. For example, if the name of the bundle is win, then the 
contents are exported to a win.reg file.

You can choose to rename the file.

Search for a Value 
name, registry key, or 
both.

1. Specify the name of the value or key that you want to search for.
2. Select Registry Key/Value, Registry Value Data, or Both.
3. Select the Search within the selected nodes only check box to limit the search 

to the node you selected in the Registry Tree list.
4. Click Search.

Task Steps
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Backup Registry Before Applying the Changes
Select the check box, then specify the path to the backup file, for example, c:\BackupFile.reg.

If you select this option, the entire registry is backed up before importing the configured registry file. 
The backup process is performed every time this action executes. This can be a time-consuming 
operation and the backup file can be large.

Before you edit the registry, export the keys in the registry that you plan to edit, or back up the 
entire registry by selecting this option. If a problem occurs, you can then restore the registry to its 
previous state.

NOTE: On a non-XP Windows device, if you apply a bundle for which Backup registry before applying 
changes is selected and Run Action As is set to User, then the following occurs:

 The registry backup action fails.
 The bundle execution fails.

Run Action As
Specify how you want the action to run:

 System: The action is run under the Local System user and inherits Administrator-level 
credentials. For example, the action has full rights to the HKEY_LOCAL_MACHINE hive.
 Select the Apply HKEY_CURRENT_USER changes to the logged in user's hive instead of 

.DEFAULT option to enable the changes to be made in the user’s hive instead of the 
DEFAULT hive of HKEY_USERS.

 Select the Resolve the environment variables specified in registry edit value in the user 
context option to resolve the environment variables that you have specified in the registry 
edit value, in the user context. If there are no logged in users available, then the 
environment variables will be resolved in the system context.

 User: The registry file is applied using the logged-in user’s credentials. For example, the action 
has the same rights to the registry and the file system as the logged-in user. If you are changing 
keys in the HKEY_CURRENT_USER hive, you must run the action as User. Depending on the 
rights assigned to the user, the action might or might not have rights to the 
HKEY_LOCAL_MACHINE hive. If you select User, the user must be logged in to the device or the 
action fails.

6.27.3 Requirements
The Requirements page lets you define specific requirements that a device must meet for the action 
to be enforced on it. For information about the requirements, see Requirements.
Actions 105



6.28 Action - Run Script
The Action - Run Script dialog box lets you configure a script to be executed on the managed device. 
For the Run Script action to successfully complete, ensure that the script is silent (requires no user 
intervention). You can also specify the specific requirements that a device must meet for the action 
to be executed on the device.

To access this dialog box in Endpoint Management Console, click the Bundles tab. Click the 
underlined link of a bundle in the Name column of the Bundles list, click the Actions tab, click one of 
the action set tabs (Distribute, Install, Launch, Repair, Uninstall, Terminate), click the Add drop-down 
list, then select an available action.

The following sections contains additional information:

 Section 6.28.1, “General,” on page 106
 Section 6.28.2, “Requirements,” on page 108

6.28.1 General
The General page lets you configure a script to be executed on the managed device. For the Run 
Script action to successfully complete, ensure that the script is silent (requires no user intervention). 

The settings vary, depending on the type of script you select from the Script to run list. The following 
options are available:

 “Specify a File on a Managed Device” on page 106
 “Define Your Own Script” on page 107
 “Select From This Device” on page 108

Specify a File on a Managed Device
Select this option to run a script that exists on the managed device.

Script Filename: Specify the path to the script file on the target device, for example, 
C:\scripts\xyz.pl.

Script Parameters: Specify any additional parameters you want to place on the command line after 
the script filename is specified. This results in parameters being passed to your executable script.

Path to Script Engine: Specify the interpreter that launches to run your script. For example, 
C:\Program Files\Perl\bin\Perl.exe.

For Windows scripts other than batch scripts (for example, VBScript), the Path to Script Engine field 
should specify the path to the Windows Based Script Host, such as 
(C:\Windows\System32\wscript.exe)

Script Engine Parameters: Specify any parameters you want included on the command line when 
the script engine launches.

Wait Before Proceeding to Next Action: Specify what happens after the script is run:

 Do not wait: The next action in the list is immediately performed.
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 Proceed when an action is complete: The next action in the list is performed after the launch 
action completes.

 Wait for _ seconds: Wait the specified number of seconds before proceeding to the next action.
 Terminate action if it has exceeded its wait duration: If you select the Wait for _ seconds 

option, this option is enabled. If the specified number of seconds is exceeded and the 
action is not successfully performed, the action is terminated.

Define Your Own Script
Select this option to type a script in Endpoint Management Console.

Script Content: Click Edit to display a text box where you type your script. This script is delivered to 
the assigned devices and is executed in the standard device shell environment.

For example, you can automate drive mapping using the script capabilities of bundles. Your bundle’s 
script could read:

net use m: \\server\sys 
net use w: \\server\vol1
If the user is logged in as an eDirectory user with rights, then the mapping works. They can map a 
drive to a Windows share using a domain account by putting the username / password on the script 
line. If they are a logged in as an Active Directory user and have rights, the username / password is 
not required. If an Environment Variable is specified, then Endpoint Management will resolve that 
variable with the associated value. For example, if %USERNAME% is provided as the Environment 
Variable, then the variable will be resolved to the value of the logged-in user.

However, if you do not want the variable to be resolved and want it to be displayed as is, then you 
need to add additional percent signs before and after the variable. For example, if you want the 
output to be displayed as %USERNAME%, specify %%USERNAME%% or if you want the output to be 
displayed as %%USERNAME%%, specify %%%USERNAME%%%.

Script File Extension: Specify the extension that you want appended to the script when it is saved. 
For example, .bat.

Path to Script Engine: Specify the interpreter that will run your script. 

Script Engine Parameters: Specify any parameters you want included on the command line when 
the script engine launches. .

Wait Before Proceeding to Next Action: Specify what happens after the script is run:

 Do not wait: The next action in the list is immediately performed.
 Proceed when an action is complete: The next action in the list is performed after the launch 

action completes.
 Wait for _ seconds: Wait the specified number of seconds before proceeding to the next action.

 Terminate action if it exceeds its wait duration: If you select the Wait for _ seconds option, 
this option is enabled. If the specified number of seconds is exceeded and the action is not 
successfully performed, the action is terminated.
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Select From This Device
Select this option to specify a script file that is already on the device on which you are running 
Endpoint Management Console.

Select From This Device: Browse to and select the script file.

Script Parameters: Specify any additional parameters you want to place on the command line after 
the script filename is specified. This results in parameters being passed to your executable script.

Path to Script Engine: Specify the interpreter that launches to run your script.

Script Engine Parameters: Specify any parameters you want included on the command line when 
the script engine launches.

Wait Before Proceeding to Next Action: Specify what happens after the script is run:

 Do not wait: The next action in the list is immediately performed.
 Proceed when an action is complete: The next action in the list is performed after the launch 

action completes.
 Wait for _ seconds: Wait the specified number of seconds before proceeding to the next action.

 Terminate action if it has exceeded its wait duration: If you select the Wait for _ seconds 
option, this option is enabled. If the specified number of seconds is exceeded and the 
action is not successfully performed, the action is terminated.

Working Directory: Click More Options to specify the script’s working directory. Specify the initial 
working directory for the script.

Priority: Click More Options to specify the script’s priority. Specify the priority of the process that 
runs the script. This option lets you configure how much of the CPU usage the script process 
consumes. Select from the following priorities: Real Time, High, Above Normal, Normal, Below 
Normal, and Low.

Run As: Click More Options to specify the script’s run as setting. Specify an option:

 System: Runs the script as the system account (as a service).
 Administrator: Runs the script as a dynamic administrator user. A dynamic administrator is an 

administrator account that is created on the fly to perform certain procedures, such as installing 
applications or running scripts. Using a dynamic administrator is helpful when installing 
applications (some MSI applications, for example) that cannot be installed in the system space. 
When you select this action, the dynamic administrator is created, it performs the required 
tasks, and then the account is deleted.

 User: The script runs, using the logged-in user’s credentials. For example, the script has the 
same rights to the registry and the file system as the logged-in user.

6.28.2 Requirements
The Requirements page lets you define specific requirements that a device must meet for the action 
to be enforced on it. For information about the requirements, see Requirements.
108 Actions



6.29 Action - Start/Stop Service
The Action - Start/Stop Service dialog box lets you specify the service that you want to start or stop. 
You can also specify the specific requirements that a device must meet for the action to be executed 
on the device.

To access this dialog box in Endpoint Management Console, click the Bundles tab. Click the 
underlined link of a bundle in the Name column of the Bundles list, click the Actions tab, click one of 
the action set tabs (Distribute, Install, Launch, Repair, Uninstall, Terminate), click the Add drop-down 
list, then select an available action.

The following sections contains additional information:

 Section 6.29.1, “General,” on page 109
 Section 6.29.2, “Requirements,” on page 109

6.29.1 General
The General page lets you specify the service that you want to start or stop.

Service Name: Specify a service and indicate whether you want to start or stop that service.

Select Action: Select one of the following actions:

 Start Service: Starts the specified service. If the service is already running on the device, the 
Start Service task completes.

 Stop Service: Stops the specified service. If the service is not running on the device, the Stop 
Service task completes.

6.29.2 Requirements
The Requirements page lets you define specific requirements that a device must meet for the action 
to be enforced on it. For information about the requirements, see Requirements.

6.30 Action - Terminate Application
The Action - Terminate Application dialog box is displayed when you add a Terminate Application 
Prompt action. This dialog box lets you undo all operations that are performed in the launch action 
set. You can also configure a prompt to notify users of the termination.You can also specify the 
specific requirements that a device must meet for the action to be executed on the device. However, 
you are allowed to add the Terminate Application action only if it is not already added.

To access this dialog box, click the Bundles tab in Endpoint Management Console. Click the 
underlined link of a bundle in the Name column of the Bundles list, click the Actions > Terminate. 
Click Add > Terminate Application.

The following sections contains additional information:

 Section 6.30.1, “General,” on page 110
 Section 6.30.2, “Requirements,” on page 110
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6.30.1 General
The General page lets you undo all operations that are performed in the launch action set. You can 
also configure a prompt to notify users of the termination.

The name and type of each process that is reversed displays in the list.

Notify the User of Termination
Define the prompt that you want to display on the device. You can also specify different locales with 
different messages.

The Endpoint Agent automatically detects the locale of the operating system and displays the 
prompt defined in the same locale as the operating system locale. However, if the operating system 
locale does not match any of the specified locales, then Endpoint Management displays the prompt 
defined by the first locale in the list.

To create a message:

1 Click Add to display the Select Locale and Prompt dialog box.
2 Select a language from the Locale drop-down list. The message displays only on devices in the 

specified locale. You can create different messages, each with its own locale setting.
3 Specify the text you want to display on the device.

You can include {0} in your text to provide a running counter that counts down the number of 
seconds to 0, after which the prompt is auto-accepted. For example, you could specify the 
following text:
The application will terminate in {0} seconds. Please save your work.
The message displays for the number of seconds specified in the Seconds to be Displayed field.

4 Click OK.

To remove a prompt, select the check box, then click Remove.

6.30.2 Requirements
The Requirements page lets you define specific requirements that a device must meet for the action 
to be enforced on it. For information about the requirements, see Requirements.

6.31 Action - Terminate Application Prompt
The Action - Terminate Application Prompt dialog box is displayed when you add a Terminate 
Application Prompt action. This dialog box lets you configure a prompt to notify users before the 
application terminates, including the number of seconds to notify the user, the number of times the 
prompt retries, and different messages for different locales. You can also specify the specific 
requirements that a device must meet for the action to be executed on the device. However, you are 
allowed to add the Terminate Application Prompt action only if it is not already added.

To access this dialog box, click the Bundles tab in Endpoint Management Console. Click the 
underlined link of a bundle in the Name column of the Bundles list, click the Actions > Terminate. 
Click Add > Terminate Application Prompt.
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The following sections contains additional information:

 Section 6.31.1, “General,” on page 111
 Section 6.31.2, “Requirements,” on page 112

6.31.1 General
The Action - Terminate Application Prompt dialog box lets you configure a prompt to notify users 
before the application terminates, including the number of seconds to notify the user, the number of 
times the prompt retries, and different messages for different locales.

Seconds to be Displayed
Specify the number of seconds that the prompt is displayed before the action is performed. For 
example, suppose you configure a prompt to notify the user that an application is in the process of 
terminating. If you specify that the prompt display for 10 seconds, the prompt displays for 10 
seconds, then the application terminates.

Number of Retries Allowed
Specify the number of times the prompt displays before performing the next action.

Prompt the User to Save Any Unsaved Data
Define the prompt that you want to display on the device. You can also specify different locales with 
different messages.

The Endpoint Agent automatically detects the locale of the operating system and displays the 
prompt defined in the same locale as the operating system locale. However, if the operating system 
locale does not match any of the specified locales, then Endpoint Management displays the prompt 
defined by the first locale in the list.

To create a message:

1 Click Add to display the Select Locale and Prompt dialog box.
2 Select a language from the Locale drop-down list. The message displays only on devices in the 

specified locale. You can create different messages, each with its own locale setting.
3 Type the text you want to display on the device.

You can include {0} in your text to provide a running counter that counts down the number of 
seconds to 0, after which the prompt is auto-accepted. For example, you could specify the 
following text:
The application will terminate in {0} seconds. Please save your work.
The message displays for the number of seconds specified in the Seconds to be Displayed field.

4 Click OK.
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6.31.2 Requirements
The Requirements page lets you define specific requirements that a device must meet for the action 
to be enforced on it. For information about the requirements, see Requirements.

6.32 Action - Undo Install Actions
The Action - Undo Install Actions dialog box lets you undo all operations that are performed in the 
install action set. The list displays the name and type of each operation that is reversed. There are no 
configuration tasks that you need to perform for this action.

To access this dialog box in Endpoint Management Console, click the Bundles tab. Click the 
underlined link of a bundle in the Name column of the Bundles list, click the Actions tab, click one of 
the action set tabs (Distribute, Install, Launch, Repair, Uninstall, Terminate), click the Add drop-down 
list, then select an available action.

6.33 Action - Uninstall Bundle
The Action - Uninstall Bundle dialog box lets you select a bundle to remove from the device. You can 
also specify the specific requirements that a device must meet for the action to be executed on the 
device.

To access this dialog box in Endpoint Management Console, click the Bundles tab. Click the 
underlined link of a bundle in the Name column of the Bundles list, click the Actions tab, click one of 
the action set tabs (Distribute, Install, Launch, Repair, Uninstall, Terminate), click the Add drop-down 
list, then select an available action.

The following sections contains additional information:

 Section 6.33.1, “General,” on page 112
 Section 6.33.2, “Requirements,” on page 112

6.33.1 General
The General page lets you select a bundle to remove from the device. Click  to browse to and 
select the bundle to uninstall from the device. 

The Look in list defaults to /Bundles. If you have created subfolders to hold your bundles, use the 
down-arrow to select the appropriate folder. The Items of type list defaults to All Types so that all 
types of bundles are displayed. If you know the name of the bundle you are looking for, you can use 
the Item name box to search for the bundle.

Creating this action creates a bundle dependency. For more information, see Section 8.5, 
“Dependency Bundles,” on page 134.

6.33.2 Requirements
The Requirements page lets you define specific requirements that a device must meet for the action 
to be enforced on it. For information about the requirements, see Requirements.
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6.34 Action - Repair Bundle
The Action - Repair Bundle dialog box lets you repair a bundle on the device. You can also specify the 
specific requirements that a device must meet for the action to be executed on the device.

Repairing a bundle ensures that the specified bundle or bundle group has been properly installed on 
the device.

For example, for an MSI bundle, repairing the bundle results in the task running an MSI /repair 
process against the bundle.

It is a best practice to ensure that the actions under Repair perform a basic re-installation of the 
program, and that they are Enabled. Repair is usually displayed as Repair install actions, which 
means that the actions under Install are run again when users select Repair from the action menu of 
the icon on their computer. This raises the service level considerably for the end user – the program 
can be reinstalled without help from the IT service.

To access this dialog box in Endpoint Management Console, click the Bundles tab. Click the 
underlined link of a bundle in the Name column of the Bundles list, click the Actions tab, click one of 
the action set tabs (Distribute, Install, Launch, Repair, Uninstall, Terminate), click the Add drop-down 
list, then select an available action.

The following sections contains additional information:

 Section 6.34.1, “General,” on page 113
 Section 6.34.2, “Requirements,” on page 113

6.34.1 General
The General page lets you repair a bundle on the device. Click  to browse to and select the bundle 
to repair on the device. 

The Look in list defaults to /Bundles. If you have created subfolders to hold your bundles, use the 
down-arrow to select the appropriate folder. The Items of type list defaults to All Types so that all 
types of bundles are displayed. If you know the name of the bundle you are looking for, you can use 
the Item name box to search for the bundle.

Creating this action creates a bundle dependency. For more information, see Section 8.5, 
“Dependency Bundles,” on page 134.

6.34.2 Requirements
The Requirements page lets you define specific requirements that a device must meet for the action 
to be enforced on it. For information about the requirements, see Requirements.
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6.35 Action - Repair Install Actions
The Repair Install Actions action repairs all operations that are performed in the Install action set. 
This action does not require any configuration.

To access this dialog box in Endpoint Management Console, click the Bundles tab. Click the 
underlined link of a bundle in the Name column of the Bundles list, click the Actions tab, click one of 
the action set tabs (Distribute, Install, Launch, Repair, Uninstall, Terminate), click the Add drop-down 
list, then select an available action.

6.36 Requirements
The Requirements panel lets you define specific requirements that a device must meet for the action 
to be enforced on it.

You define requirements through the use of filters. A filter is a condition that must be met by a 
device in order for the bundle to be applied. For example, you can add a filter to specify that the 
device must have exactly 512 MB of RAM in order for the bundle to be applied, and you can add 
another filter to specify that the hard drive be at least 20 GB in size.

Some of the best practices that you can follow while using the Requirements tab are as follows: 

 Create general filters under Requirements if you do not want the device to utilize CPU time 
evaluating conditions for individual actions under Actions. For example, you can set an 
Architecture filter at this level if an application runs on only 32-bit or 64-bit operating systems. 
It is especially important to set a filter for the architecture when you associate bundles with 
users because the application will otherwise follow the user to all operating systems that they 
use, regardless of whether or not it can be installed and run.

 You can filter out certain environments by means of variables and conditions. For example, if 
you want an application to be visible only if a computer is connected to your network, you can 
configure a filter for that. 

As you construct filters, you need to know the conditions you can use and how to organize the filters 
to achieve the desired results. Refer to the following sections for details.

 Section 6.36.1, “Filter Conditions,” on page 114
 Section 6.36.2, “Filter Logic,” on page 119
 Section 6.36.3, “Fail the action if these requirements fail,” on page 119

6.36.1 Filter Conditions
You can choose from any of the following conditions when creating a filter. Place your mouse pointer 
over fields that require input to display a tooltip containing example usage.

Architecture:  Determines the architecture of Windows running on the device. The condition you 
use to set the requirement includes a property, an operator, and a property value. The possible 
operators are equals (=) and does not equal (<>). For example, if you set the condition to 
architecture = 32, the device’s Windows operating system must be 32-bit to meet the 
requirement. 
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Associated On: Determines the number of users or devices to which the bundle is assigned. The 
possible operators are equals (=) and does not equal (<>). The possible values are Users and Devices. 
For example, if you set the condition to =100 users, the total number of users must be 100 to 
meet the requirement.

Bundle Installed: Determines if a specific bundle is installed. After specifying the bundle, the two 
conditions you can use to set the requirement are Yes and No. If you select Yes, the specified bundle 
must already be installed to meet the requirement. If you select No, the bundle must not be 
installed.

Connected: Determines if the device is connected to the network. The two conditions you can use to 
set the requirement are Yes and No. If you select Yes, the device must be connected to the network 
to meet the requirement. If you select No, it must not be connected. 

Connection Speed: Determines the speed of the device’s connection to the network. The condition 
you use to set the requirement includes an operator and a value. The possible operators are equals 
(=), does not equal (<>), is greater than (>), is greater than or equal to (>=), is less than (<), and is less 
than or equal to (<=). The possible values are bits per second (bps), kilobits per second (Kbps), 
megabits per second (Mbps), and gigabits per second (Gbps). For example, if you set the condition to 
>= 100 Mbps, the connection speed must be greater than or equal to 100 megabits per second to 
meet the requirement.

Disk Space Free: Determines the amount of free disk space on the device. The condition you use to 
set the requirement includes a disk designation, an operator, and a value. The disk designation can 
be a local drive map (for example, c: or d:). The possible operators are equals (=), does not equal 
(<>), is greater than (>), is greater than or equal to (>=), is less than (<), and is less than or equal to 
(<=). The possible values are bytes (Bytes), kilobytes (KB), megabytes (MB), and gigabytes (GB). For 
example, if you set the condition to c: >= 80 MB, the free disk space must be greater than or equal 
to 80 megabytes to meet the requirement.

Disk Space Total: Determines the amount of total disk space on the device. The condition you use to 
set the requirement includes a disk designation, an operator, and a value. The disk designation can 
be a local drive map (for example, c: or d:). The possible operators are equals (=), does not equal 
(<>), is greater than (>), is greater than or equal to (>=), is less than (<), and is less than or equal to 
(<=). The possible values are bytes (Bytes), kilobytes (KB), megabytes (MB), and gigabytes (GB). For 
example, if you set the condition to c: >= 40 GB, the total disk space must be greater than or 
equal to 40 gigabytes to meet the requirement.

Disk Space Used: Determines the amount of used disk space on the device. The condition you use to 
set the requirement includes a disk designation, an operator, and a value. The disk designation can 
be a local drive map (for example, c: or d:). The possible operators are equals (=), does not equal 
(<>), is greater than (>), is greater than or equal to (>=), is less than (<), and is less than or equal to 
(<=). The possible values are bytes (Bytes), kilobytes (KB), megabytes (MB), and gigabytes (GB). For 
example, if you set the condition to c: <= 10 GB, the used disk space must be less than or equal to 
10 gigabytes to meet the requirement.

Environment Variable Exists: Determines if a specific environment variable exists on the device. 
After specifying the environment variable, the two conditions you can use to set the requirement 
are Yes and No. If you select Yes, the environment variable must exist on the device to meet the 
requirement. If you select No, it must not exist.

Environment Variable Value: Determines if an environment variable value exists on the device. The 
condition you use to set the requirement includes the environment variable, an operator, and a 
variable value. The environment variable can be any operating system supported environment 
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variable. The possible operators are equal to, not equal to, contains, and does not contain. The 
possible variable values are determined by the environment variable. For example, if you set the 
condition to Path contains c:\windows\system32, the Path environment variable must 
contain the c:\windows\system32 path to meet the requirement.

File Date: Determines the date of a file. The condition you use to set the requirement includes the 
filename, an operator, and a date. The filename can be any filename supported by the operating 
system. The possible operators are on, after, on or after, before, and on or before. The possible dates 
are any valid dates. For example, if you set the condition to app1.msi on or after 6/15/07, 
the app1.msi file must be dated 6/15/2007 or later to meet the requirement.

File Exists: Determines if a file exists. After specifying the filename, the two conditions you can use 
to set the requirement are Yes and No. If you select Yes, the specified file must exist to meet the 
requirement. If you select No, the file must not exist. 

File Size:  Determines the size of a file. The condition you use to set the requirement includes the 
filename, an operator, and a size. The filename can be any file name supported by the operating 
system. The possible operators are equals (=), does not equal (<>), is greater than (>), is greater than 
or equal to (>=), is less than (<), and is less than or equal to (<=). The possible sizes are designated in 
bytes (Bytes), kilobytes (KB), megabytes (MB), and gigabytes (GB). For example, if you set the 
condition to doc1.pdf <= 3 MB, the doc1.pdf file must be less than or equal to 3 megabytes to 
meet the requirement.

File Version:  Determines the version of a file. The condition you use to set the requirement includes 
the filename, an operator, and a version. The filename can be any file name supported by the 
operating system. The possible operators are equals (=), does not equal (<>), is greater than (>), is 
greater than or equal to (>=), is less than (<), and is less than or equal to (<=).

Be aware that file version numbers contain four components: Major, Minor, Revision, and Build. For 
example, the file version for calc.exe might be 5.1.2600.0. Each component is treated 
independently. For this reason, the system requirements that you set might not provide your 
expected results. If you do not specify all four components, wildcards are assumed.

For example, if you set the condition to calc.exe <= 5, you are specifying only the first 
component of the version number (Major). As a result, versions 5.0.5, 5.1, and 5.1.1.1 also meet the 
condition.

However, because each component is independent, if you set the condition to calc.exe <= 5.1, 
the calc.exe file must be less than or equal to version 5.1 to meet the requirement.

IP Segment: Determines the device’s IP address. After specifying the IP segment name, the two 
conditions you can use to set the requirement are Yes and No. If you select Yes, the device’s IP 
address must match the IP segment. If you select No, the IP address must not match the IP segment.

Logged on to Primary Workstation: Determines whether the user is logged on to his or her primary 
workstation. The two conditions you can use to set the requirement are Yes and No. If you select Yes, 
the user must be logged on to his or her primary workstation to meet the requirement. If you select 
No, if no user is logged on to the workstation, the requirement is not met. However, if a user other 
than the primary user is logged on to the workstation, the requirement is met.

Memory: Determines the amount of memory on the device. The condition you use to set the 
requirement includes an operator and a memory amount. The possible operators are equals (=), 
does not equal (<>), is greater than (>), is greater than or equal to (>=), is less than (<), and is less 
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than or equal to (<=). The memory amounts are designated in megabytes (MB) and gigabytes (GB). 
For example, if you set the condition to >= 2 GB, the device must have at least 2 gigabytes of 
memory to meet the requirement.

Operating System - Windows: Determines the service pack level, server type, and version of 
Windows running on the device. The condition you use to set the requirement includes a property, 
an operator, and a property value. The possible properties are service pack, server type, and version. 
The possible operators are equals (=), does not equal (<>), is greater than (>), is greater than or equal 
to (>=), is less than (<), and is less than or equal to (<=). The property values vary depending on the 
property. For example, if you set the condition to version = Windows XP Versions, the 
device’s Windows version must be XP to meet the requirement. 

NOTE: Be aware that operating system version numbers contain four components: Major, Minor, 
Revision, and Build. For example, the Windows 2000 SP4 release’s number might be 
5.0.2159.262144. Each component is treated independently. For this reason, the system 
requirements that you set might not provide your expected results. 

For example, if you specify Operating System - Windows in the first field, Version in the second field, 
> in the third field, and 5.0 -Windows 2000 Versions in the last field, you are specifying only the first 
two components of the version number: Major (Windows) and Minor (5.0). As a result, for the 
requirement evaluated to true, the OS will have to be at least 5.1 (Windows XP). Windows 2003 is 
version 5.2, so specifying > 5.2 will also evaluate to true.

However, because each component is independent, if you specify the version > 5.0, Windows 2000 
SP4 evaluates to false because the actual version number might be 5.0.2159.262144. You can type 
5.0.0 to make the requirement evaluate as true because the actual revision component is greater 
than 0.

When you select the OS version from the drop-down, the Major and Minor components are 
populated. The Revision and Build components must be typed in manually.

Primary User Is Logged In: Determines if the device’s primary user is logged in. The two conditions 
you can use to set the requirement are Yes and No. If you select Yes, the primary user must be logged 
in to meet the requirement. If you select No, the user must not be logged in.

Process Running: Determines if a process is running. After specifying the process name, the two 
conditions you can use to set the requirement are Yes and No. If you select Yes, the specified process 
must be running to meet the requirement. If you select No, the process must not be running.

Processor Family: Determines the device’s processor type. The condition you use to set the 
requirement includes an operator and a processor family. The possible operators are equals (=) and 
does not equal (<>). The possible processor families are Pentium, Pentium Pro, Pentium II, Pentium 
III, Pentium 4, Pentium M, WinChip, Duron, BrandID, Celeron, and Celeron M. For example, if you set 
the condition to <> Celeron, the device’s processor can be any processor family other than 
Celeron to meet the requirement. 

Processor Speed: Determines the device’s processor speed. The condition you use to set the 
requirement includes an operator and a processor speed. The possible operators are equals (=), does 
not equal (<>), is greater than (>), is greater than or equal to (>=), is less than (<), and is less than or 
equal to (<=). The possible processor speeds are hertz (Hz), kilohertz (KHz), megahertz (MHz), and 
gigahertz (GHz). For example, if you set the condition to >= 2 GHz, the device’s speed must be at 
least 2 gigahertz meet the requirement.
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Registry Key Exists: Determines if a registry key exists. After specifying the key name, the two 
conditions you can use to set the requirement are Yes and No. If you select Yes, the specified key 
must exist to meet the requirement. If you select No, the key must not exist. 

Registry Key Value: Determines if a registry key value meets a defined condition. The condition you 
use to set the requirement includes the key name, the value name, an operator, a value type, and a 
value data. The key and value names must identify the key value you want to check. The possible 
operators are equals (=), does not equal (<>), is greater than (>), is greater than or equal to (>=), is 
less than (<), is less than or equal to (<=) and contains (()). The possible value types are Integer Type 
(specify a decimal value) String Type, IP address, and Version. The possible value data is determined 
by the key, value name, and value type. 

If the value type is String Type, OpenText Configuration Management compares only those values in 
the registry if the actual type in the registry is REG_STRING or REG_EXPANDED_STRING. 

If the value type is Integer, OpenText Configuration Management compares only those values in the 
registry if the actual type in the registry is REG_DWORD.

Leave the key value field blank to use the default value. The default value of a registry key has no 
name and is displayed in regedit as (Default).

If the value type is IP Address, OpenText Configuration Management compares only those values in 
the registry if the actual type in the registry is REG_STRING. 

For more details, see Registry Key Value information in the Adding System Requirements for a 
Bundle section of this guide.

Registry Key and Value Exists: Determines if a registry key and value exist. After specifying the key 
name and value, the two conditions you can use to set the requirement are Yes and No. If you select 
Yes, the specified key and value must exist to meet the requirement. If you select No, the key and 
value must not exist. 

Service Exists: Determines if a service exists. After specifying the service name, the two conditions 
you can use to set the requirement are Yes and No. If you select Yes, the service must exist to meet 
the requirement. If you select No, the service must not exist. 

Service Running:  Determines if a service is running. After specifying the service name, the two 
conditions you can use to set the requirement are Yes and No. If you select Yes, the specified service 
must be running to meet the requirement. If you select No, the service must not be running.

Specified Devices: Determines if the device is one of the specified devices. After specifying the 
devices, the two conditions you can use to set the requirement are Yes and No. If you select Yes, the 
device must be included in the specified devices list to meet the requirement (an inclusion list). If 
you select No, the device must not be included in the list (an exclusion list).

Version of RPM: Determines the version of the RPM name provided if installed. For example, if you 
add a system requirement, Version of RPM cups > 1.0, then the requirement evaluates to 
true, if cups rpm is installed and the version of the installed cups rpm is greater than 1.0. If cups rpm 
is not installed, the requirement is evaluated to be false. The possible operators are equals (=), does 
not equal (<>), is greater than (>), is greater than or equal to (>=), is less than (<), and is less than or 
equal to (<=).
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6.36.2 Filter Logic
You can use one or more filters to determine whether the bundle should be distributed to a device. 
A device must match the entire filter list (as determined by the logical operators that are explained 
below) for the bundle to be applied to the device.

There is no technical limit to the number of filters you can use, but there are practical limits, such as:

 Designing a filter structure that is easy to understand 
 Organizing the filters so that you do not create conflicting filters 

Filters, Filter Sets, and Logical Operators
You can add filters individually or in sets. Logical operators, either AND or OR, are used to combine 
each filter and filter set. By default, filters are combined using OR (as determined by the Combine 
Filters Using field) and filter sets are combined using AND. You can change the default and use AND 
to combined filters, in which case filter sets are automatically combined using OR. In other words, 
the logical operator that is to combine individual filters (within in a set) must be the opposite of the 
operator that is used between filter sets.

You can easily view how these logical operators work. Click both the Add Filter and Add Filter Set 
options a few times each to create a few filter sets, then switch between AND and OR in the Combine 
Filters Using field and observe how the operators change.

As you construct filters and filter sets, you can think in terms of algebraic notation parentheticals, 
where filters are contained within parentheses, and sets are separated into a series of parenthetical 
groups. Logical operators (AND and OR) separate the filters within the parentheses, and the 
operators are used to separate the parentheticals.

For example, “(u AND v AND w) OR (x AND y AND z)” means “match either uvw or xyz.” In the filter 
list, this looks like:

u AND
v AND
w
OR
x AND
y AND
z

Nested Filters and Filter Sets
Filters and filter sets cannot be nested. You can only enter them in series, and the first filter or filter 
set to match the device is used. Therefore, the order in which they are listed does not matter. You 
are simply looking for a match to cause the bundle to be applied to the device.

6.36.3 Fail the action if these requirements fail
If you check this box, the selected action will be marked as failed if the system requirements fail. As a 
result you cannot bypass the action that fails and move to the next action for completing the bundle 
execution. 
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NOTE: However you can bypass the action that fails and move to the next action, only if you have 
selected the check box in the Continue on Failure column.
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7 7Understanding Bundle Change 
Management

OpenText™ Endpoint Management provides a change management capability for bundles allowing 
you to make changes to them with minimum disruption to IT services. 

A sandbox contains changes made to a bundle and is available only to devices that have been 
flagged as test. This allows you to test the changes made to the bundle in a testing environment 
before rolling out the changes into the production environment. If the test results are satisfactory 
then you can publish the sandbox, else discard the changes by reverting the sandbox. 

The published version is available to all the assigned devices that have been flagged as a non-test. 
This ensures that all the devices in the network always receive the same version of a bundle.

You can now create a bundle as a sandbox-only bundle or published version of the bundle. If you 
select the Create as Sandbox option on the Summary page of the bundle creation wizard, the bundle 
is created as a sandbox-only bundle, else a published version of the bundle is created. For more 
information on creating a bundle, see Chapter 2, “Creating Bundles,” on page 19.

Also, any change made to the published version of the bundle creates a sandbox. For more 
information on managing the bundles versions, see Section 8.4.2, “Managing Bundle Versions,” on 
page 130.

You can choose to publish a sandbox either as a new version or a new bundle. For more information 
on publishing a sandbox, see Section 8.4.4, “Publishing Sandbox,” on page 132
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8 8Managing Bundles

The OpenText Configuration Management features let you effectively manage software and content 
in your Endpoint Management system. 

The following sections contain information to help you manage existing bundles:

 Section 8.1, “Bundle Quick Tasks,” on page 123
 Section 8.2, “Bundle Tasks,” on page 125
 Section 8.3, “Editing Bundles,” on page 128
 Section 8.4, “Bundle Change Management,” on page 129
 Section 8.5, “Dependency Bundles,” on page 134
 Section 8.6, “Retaining Older Bundle Version,” on page 137

8.1 Bundle Quick Tasks
Review the following sections for the bundle related tasks that you can quickly perform on one or 
more devices

 Section 8.1.1, “Installing a Bundle,” on page 123
 Section 8.1.2, “Launching a Bundle,” on page 124
 Section 8.1.3, “Uninstalling a Bundle,” on page 124

8.1.1 Installing a Bundle
The Install Bundle option in the Bundle Tasks list in the left navigation pane of Endpoint 
Management Console lets you immediately install a bundle to one or more devices.

1 In Endpoint Management Console, click the Bundles tab.
2 In the Bundles list, select the check box next to the bundle (or bundles).
3 In the Bundle Tasks list in the left navigation pane, select Install Bundle.
4 In the Devices section, click Add to select the devices where you want to install the bundle.
5 In the Select Objects dialog box, browse to and select the objects on which you want to install 

the bundle.
The Select Objects dialog box opens with the Devices folder as the root folder. By default, the 
Servers and Workstations folders are displayed along with any custom folders that you 
have created in the Devices folder.
Browse for and select the devices, groups, and folders to which you want to assign the bundle. 
To do so:

5a Click  next to a folder (for example, the Workstations folder or Servers folder) to 
navigate through the folders until you find the device, group, or folder you want to select. 
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If you are looking for a specific item, such as a Workstation or a Workstation Group, you 
can use the Items of type list to limit the types of items that are displayed. If you know the 
name of the item you are looking for, you can also use the Name filter box to search for the 
item.

5b Click the underlined link in the Name column to select the device, group, or folder and 
display its name in the Selected list box.

5c Click OK to add the selected devices, folders, and groups to the Devices list.
6 Click OK.

If the bundle has not already been assigned to a device, then the bundle’s icon is placed in the 
application window of the device. 

8.1.2 Launching a Bundle
The Launch Bundle option lets you immediately launch a bundle to one or more devices. If the 
bundle is not already installed, it is installed and then launched.

1 In Endpoint Management Console, click the Bundles tab.
2 In the Bundles list, select the check box next to the bundle (or bundles).
3 Click Quick Tasks > Launch Bundle.
4 In the Devices section, click Add to select the devices where you want to launch the bundle.
5 In the Select Objects dialog box, browse to and select the objects on which you want to launch 

the bundle.
The Select Objects dialog box opens with the Devices folder as the root folder. By default, the 
Servers and Workstations folders are displayed along with any custom folders that you 
have created in the Devices folder.
Browse for and select the devices, groups, and folders to which you want to assign the bundle. 
To do so:

5a Click  next to a folder (for example, the Workstations folder or Servers folder) to 
navigate through the folders until you find the device, group, or folder you want to select. 
If you are looking for a specific item, such as a Workstation or a Workstation Group, you 
can use the Items of type list to limit the types of items that are displayed. If you know the 
name of the item you are looking for, you can also use the Name filter box to search for the 
item.

5b Click the underlined link in the Name column to select the device, group, or folder and 
display its name in the Selected list box.

5c Click OK to add the selected devices, folders, and groups to the Devices list.
6 Click OK.

If the bundle has not earlier been assigned to a device, then the bundle’s icon is placed in the 
application window of the device. 

8.1.3 Uninstalling a Bundle
The Uninstall Bundle quick task lets you uninstall a bundle from one or more devices. Uninstalling a 
bundle does not, however, remove its assignments nor prevent the bundle from being reinstalled.
124 Managing Bundles



NOTE: To use the Uninstall Bundle quick task, you must enable the bundle’s uninstall options that is 
disabled by default. For more information, see Section 11.2.3, “Uninstall Action Set Options,” on 
page 157.

To uninstall a bundle:

1 In Endpoint Management Console, click the Bundles tab.
2 In the Bundles list, select the check box next to the bundle (or bundles).
3 Click Quick Tasks > Uninstall Bundle.

4 In the Bundles section, click  to browse to and select the desired bundle (if necessary). 
5 In the Devices section, click Add to select the devices where you want to uninstall the bundle.
6 In the Select Objects dialog box, browse to and select the objects on which you want to 

uninstall the bundle.
The Select Objects dialog box opens with the Devices folder as the root folder. By default, the 
Servers and Workstations folders are displayed along with any custom folders that you 
have created in the Devices folder.
Browse for and select the devices, groups, and folders to which you want to assign the bundle. 
To do so:

6a Click  next to a folder (for example, the Workstations folder or Servers folder) to 
navigate through the folders until you find the device, group, or folder you want to select. 
If you are looking for a specific item, such as a Workstation or a Workstation Group, you 
can use the Items of type list to limit the types of items that are displayed. If you know the 
name of the item you are looking for, you can also use the Name filter box to search for the 
item.

6b Click the underlined link in the Name column to select the device, group, or folder and 
display its name in the Selected list box.

6c Click OK to add the selected devices, folders, and groups to the Devices list.
7 Click OK, then click Apply.

If Endpoint Management Console shows that the uninstall fails, examine the device’s log file for 
more information.

8.2 Bundle Tasks
Review the following sections for the tasks that you can perform on one or more bundles.

 Section 8.2.1, “Renaming, Copying, or Moving Bundles,” on page 126
 Section 8.2.2, “Deleting a Bundle,” on page 126
 Section 8.2.3, “Preventing a Bundle from Being Deployed,” on page 126
 Section 8.2.4, “Enabling a Bundle to Be Deployed,” on page 127
 Section 8.2.5, “Enabling Bundle Ordering,” on page 127
 Section 8.2.6, “Blocking a Bundle that is Assigned to a Device,” on page 128
 Section 8.2.7, “Uninstalling a Blocked Bundle,” on page 128
 Section 8.2.8, “Unblocking a Bundle That has been Blocked for a Device,” on page 128
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8.2.1 Renaming, Copying, or Moving Bundles
Use the Edit drop-down list on the Bundles page to edit an existing object. To access the Edit drop-
down list, you must select an object by clicking the check box next to the object's name in the list.

Depending on the type of object you select, you can rename, copy, or move the selected object. For 
example, if you select a Bundle object, you can rename, copy, and move the bundle. If you select a 
Bundle Group object, you can rename or move the Bundle Group object, but not copy it. If the 
option is dimmed, that option is not available for the selected object type.

Some actions cannot be performed on multiple objects. For example, if more than one check box is 
selected, the Rename option is not available from the Edit menu.

1 In Endpoint Management Console, click the Bundles tab.
2 In the Bundles list, select the box next to the bundle's name, click Edit, then click an option:

Rename: Click Rename, provide a new name for the bundle, then click OK.

IMPORTANT: Do not rename Windows MSP bundles.

Copy: Click Copy, provide a new name for the copy, then click OK.
The copy option is useful to create a new bundle that is similar to an existing bundle. You can 
copy a bundle and then edit the new bundle's settings.
Move: Click Move, select a destination folder for the selected objects, then click OK.
If you rename or move a bundle, its assignments are still in place and OpenText Configuration 
Management does not redistribute the bundle to devices or users because of the name or 
location change. However, the changes are effective when the subsequent versions of the 
bundle are distributed to the devices or users.

8.2.2 Deleting a Bundle
Deleting a bundle removes the bundle content from the Endpoint Management content servers but 
does not uninstall it from devices where it has already been installed. To uninstall it from devices, 
you should use the Uninstall options before deleting the bundle.

1 In Endpoint Management Console, click the Bundles tab.
2 In the Bundles list, select the check box next to the bundle (or bundles).
3 Click Delete.

8.2.3 Preventing a Bundle from Being Deployed
A disabled bundle is not deployed to new managed devices or replicated to content servers. It 
remains on the device and content server to which it has already been deployed until the next 
device refresh.

1 In Endpoint Management Console, click the Bundles tab.
2 In the Bundles list, select the check box next to the bundle (or bundles).
3 Click Action > Disable.
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8.2.4 Enabling a Bundle to Be Deployed
1 In Endpoint Management Console, click the Bundles tab.
2 In the Bundles list, select the check box next to the bundle (or bundles).
3 Click Action > Enable.

8.2.5 Enabling Bundle Ordering
 “Enabling Ordering” on page 127
 “Configuring Time Slice on the Agent” on page 127

Enabling Ordering
You can use Bundle Ordering to prioritize the way bundles are executed. When you assign an order 
value to a bundle, the bundles are executed based on the value assigned. Multiple bundles can be 
executed simultaneously, or the order of execution can be prioritized.

1 In Endpoint Management Console, click the Bundles tab.
2 Select an existing bundle or create a new Windowsbundle.

For more information, see Chapter 2, “Creating Bundles,” on page 19.
3 In the General tab of the Summary page, click Yes next to the Enable Bundle Ordering field. This 

activates the Bundle Order field.
4 Click Edit next to the Bundle Order field. 
5 In the Bundle Order dialog box that appears, specify a value and then click OK. 

Values can range from 0 to 9999999. The default value 0, has the highest priority. Bundles are 
executed in the ascending order of the values assigned.

6 (Optional) Click Yes next to Wait for previous Bundle execution to complete, if you want bundles 
with lower priorities to wait for bundles with higher priority to complete execution. 

7 Click Publish.

Configuring Time Slice on the Agent
Time slice configuration sets the amount of time that the agent waits before reordering the assigned 
bundles. The time slice duration is configurable on the agent; the default is 5 seconds. This value can 
be changed. It should be an integer value and is calculated in seconds.

To change the default time slice value of the Endpoint Agent on a Windows managed device:

1 Open the Registry Editor.
2 Go to  HKLM\software\OpenText\EndpointAgent.
3 Add the BundleOrderingTimeSlice parameter as any value greater than 0, in seconds.
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8.2.6 Blocking a Bundle that is Assigned to a Device
In scenarios where the behavior of a bundle is not as per expectation, you can choose to block the 
bundle from being executed on a device. This eliminates the need of altering the bundle assignment.

1 In Endpoint Management Console, click the Devices tab.
2 Navigate to the device for which you want to block the bundle.
3 Click Assignments.
4 In the Assigned Bundles panel, select the bundles you want to block on the device.
5 Click Block.

8.2.7 Uninstalling a Blocked Bundle
1 In Endpoint Management Console, click the blocked bundle that you want to uninstall.
2 Click Actions > Uninstall.
3 Click Options to display the Uninstall Options dialog box.
4 Click Enable Uninstall.
5 In the Blocked Assignment Options section, select Uninstall application and click OK.
6 Click Apply.
7 Click Publish to publish the bundle to next version.

The bundle uninstalls by running the actions listed within the Uninstall action set.

8.2.8 Unblocking a Bundle That has been Blocked for a Device

1 In Endpoint Management Console, click the blocked bundle that you want to unblock.
2 In the Bundle Status panel, click Refresh.
3 Click the underlined link in the Blocked column for the device.
4 In the Bundle Status (Device assignments-Blocked) page, select the devices for which you want 

to unblock the bundle and click Unblock.

8.3 Editing Bundles
After you have assigned a bundle to a device or user, you can choose to edit the bundle :

1 In Endpoint Management Console, click the Bundles tab.
2 Click the desired bundle for which you want to edit.
3 Click the Relationships tab.
4 Click the Assignment Details link of the assignment.
5 In the View Assignment Details dialog box, click the link next to the type you want to edit.
6 In the dialog box that displays, edit the bundle as desired.
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8.4 Bundle Change Management
OpenText™ Endpoint Management provides a change management capability for bundles allowing 
you to make changes to them with minimum disruption to IT services.

To understand bundle change management, see Chapter 7, “Understanding Bundle Change 
Management,” on page 121.

Review the following sections:

 Section 8.4.1, “Understanding Bundle Versions,” on page 129
 Section 8.4.2, “Managing Bundle Versions,” on page 130
 Section 8.4.3, “Older Bundle Versions Retain Settings,” on page 131
 Section 8.4.4, “Publishing Sandbox,” on page 132

8.4.1 Understanding Bundle Versions
Bundle Change Management allows you to create either a sandbox-only bundle or a published 
version of the bundle. If you edit a published version of the bundle, a sandbox is created. You can 
choose to publish the sandbox either as a new version of the bundle or a new bundle. 

For more information on the bundle versions, see Section 8.4.2, “Managing Bundle Versions,” on 
page 130.

For more information on publishing the sandbox, see Section 8.4.4, “Publishing Sandbox,” on 
page 132.

The Displayed Version option on the bundle’s page lists all the existing versions of the bundle, and 
the latest version of the bundle is selected by default. However, if a sandbox exists, the sandbox is 
selected by default.

Scenario: 
1 Consider a bundle named sos1 that is created as a sandbox. The Displayed Version option on the 

bundle page lists Sandbox and it is selected by default.
2 Click Publish to publish the sandbox to a new version. The Displayed Version option on the 

bundle page now lists 0(Published) and it is selected by default.
3 Edit the bundle’s description to create a sandbox. The Displayed Version option on the bundle 

page now lists 0(Published) and Sandbox. Sandbox is selected by default.
4 Click Publish to publish the sandbox to a new version. The Displayed Version option on the 

bundle page now lists 0(Published), and 1(Published). The bundle’s latest version, 1(Published), 
is selected by default.
0 is the older version of the bundle.

5 Edit the bundle’s description again to create a sandbox. The Displayed Version option on the 
bundle page now lists 0(Published), 1(Published), and Sandbox. Sandbox is selected by default.
0 is the older version of the bundle and 1(Published) is the latest version of the bundle.
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6 Click Publish to publish the sandbox to a new version. The Displayed Version option on the 
bundle page now lists 0(Published), 1(Published), 2(Published). The bundle’s latest version, 
2(Published), is selected by default.
0 and 1 are the older versions of the bundle; and 2(Published) is the latest version of the bundle.

8.4.2 Managing Bundle Versions 
The Displayed Version option on the bundle’s page lists all existing versions of the bundle, and the 
latest version of the bundle is selected by default. However, if a sandbox exists, the sandbox is 
selected by default.

For more information on the bundle versions, see Section 8.4.1, “Understanding Bundle Versions,” 
on page 129.

Select the version of the bundle whose details you want to view or edit. 

Task Steps Additional Details

Create a sandbox from the 
published version of the bundle

1. Select the published version 
of the bundle.

2. Edit the bundle. 

A single modification made to the 
bundle creates a sandbox. The 
created sandbox is a copy of the 
bundle and also includes the 
additional edit. However, the 
change is not made to the 
published version of the bundle.

The sandbox flows to the test 
devices to whom the bundle is 
assigned.

Changes can now be made to the 
sandbox.

You can revert a sandbox to the 
original version of the bundle or 
publish a sandbox to create a new 
version or a new bundle. 

Create a sandbox from an older 
version of the bundle

1. Select an older version of the 
bundle.

2. Click Create Sandbox. 

The created sandbox is an exact 
copy of the bundle version. 

Changes can now be made to the 
sandbox.

Publish a sandbox 1. Select Sandbox.
2. Click Publish to display the 

Publish Option page.

The sandbox must be published for 
the changes to be effective on the 
non-test devices to whom the 
bundle is assigned.

Revert a sandbox 1. Select Sandbox.
2. Click Revert to delete the 

sandbox.

All the changes made are 
discarded. The sandbox no longer 
exists. 

The published version of the 
bundle is displayed in the 
Displayed Version option.
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8.4.3 Older Bundle Versions Retain Settings
Using the Bundle Version Retain settings, you can configure the number of older bundle versions 
that should be retained. This setting can be configured at the zone, folder and bundle levels. The 
order of precedence is bundle, folder and then zone.

To configure the bundle version retain settings, perform the following steps:

In Endpoint Management Console, go to Configuration > Management Zone Settings > Bundle, Policy 
and Content > Older Bundle Version Retain Setting.

Following are the available options to retain the version:

 Retain all versions: Select this option to retain all versions of the bundle. This includes the 
published and sandbox versions.

 Retain the specified number of older versions:  Select this option to specify the number of 
older versions of the bundle to be retained. 
The number that you specify should be a positive integer and it should not include the 
Published and Sandbox versions as they are retained by default. For example: If a bundle has 5 
versions and if you specify 2, then only the 2 versions prior to the currently published version 
will be retained along with Published and Sandbox versions. The remaining versions will be 
deleted. 

 Do not retain any older versions:  Select this option if you do not want to retain any older 
versions of bundles in Endpoint Management. This option retains only the Published and 
Sandbox versions.

8.4.4 Publishing Sandbox 
The sandbox must be published for the changes to be effective on the devices and users to whom 
the bundle is assigned. You can choose to publish the sandbox either as a new version or as a new 
bundle. 

Review the following sections:

 “Publishing a Sandbox as a New Version” on page 132
 “Publishing a Sandbox as a New Bundle” on page 133
 “Publishing Multiple Sandbox as New Versions” on page 134

Delete an older version of the 
bundle

1. Select an older version of the 
bundle.

2. Click Delete Selected Version. 

To delete all older versions of a 
bundle or delete all versions older 
than a particular version, click 
Delete Older Versions under the 
Bundle Tasks list located in the 
Endpoint Management Console 
left navigation pane.

Task Steps Additional Details
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Publishing a Sandbox as a New Version
Publishing a sandbox as a new version lets you create a new version of the bundle that has a version 
number incremented by one from the latest available version of the bundle. 

Perform the following steps in the Endpoint Management Console:

1 On the page of the bundle that you want to publish, select Sandbox in the Displayed Version 
option.

2 Click Publish to display the Publish Option page.
3 Click Publish as New Version.
4 (Conditional) If the bundle has any dependencies, the Publish Dependent Bundles Page is 

displayed. 
This page lists all the bundles that the sandbox you want to publish depends on. These can 
include sandbox-only bundles (bundles that were directly created as a sandbox), or sandbox 
bundles (bundles that were edited to create a sandbox). To publish the sandbox, you must 
publish all the dependent sandbox-only bundles. However, you can choose to publish all the 
dependent sandbox bundles.
4a You must select the Publish sandbox only bundle(s) that this bundle depends on option to 

publish all the dependent child bundles that have a sandbox-only version. 
4b Select the Publish sandbox for all bundle(s) that this bundle depends on option to publish all 

the dependent child bundles that have a sandbox.
4c On the Summary Page, review the information and, if necessary, use the Back button to 

make changes to the information
5 Click Finish to create a new published version.

For example, if the Displayed Version option on the bundle page lists 0(Published), 1(Published), 
and Sandbox, publishing the sandbox as a new version creates a version 2. The Displayed 
Version option on the bundle page now lists 0(Published), 1(Published), and 2(Published). 

Publishing a Sandbox as a New Bundle
Publishing a sandbox as a new bundle creates a new bundle. Perform the following steps in the 
Endpoint Management Console:

1 On the page of the bundle that you want to publish, select Sandbox in the Displayed Version 
option.

2 Click Publish to display the Publish Option page.
3 Click Publish as New Bundle.
4 Specify a name for the bundle.

The bundle name must be different from the name of any other item (bundle, group, folder, 
and so forth) that resides in the same folder. The name you provide displays in Endpoint 
Management Console and the Endpoint Agent (on managed devices).
For more information, see “Naming Conventions in Endpoint Management Console” in the 
Endpoint Management Console Reference.
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5 Specify the folder name or browse to the Endpoint Management Console folder where you 
want the bundle to reside. The default is /bundles, but you can create additional folders to 
organize your bundles. 

6 Select the Create as Sandbox option to create a sandbox-only version of the bundle and deploy 
the bundle as a sandbox. The sandbox version of a bundle enables you to test it on your device 
before actually deploying it.

7 Select the bundle groups that the new bundle should be a member of.
8 Click Next to display the Select Assignments page.
9 Select the device that you want to apply to the new bundle.

10 Click Next.
11 (Conditional) If the bundle has any dependencies, the Publish Dependent Bundles Page is 

displayed. 
This page lists all the bundles that the sandbox you want to publish depends on. These can 
include sandbox-only bundles (bundles that were directly created as a sandbox), or sandbox 
bundles (bundles that were edited to create a sandbox). To publish the sandbox, you must 
publish all the dependent sandbox-only bundles. However, you can choose to publish all the 
dependent sandbox bundles.
11a You must select the Publish sandbox only bundle(s) that this bundle depends on option to 

publish all the dependent child bundles that have a sandbox-only version. 
11b Select the Publish sandbox for all bundle(s) that this bundle depends on option to publish all 

the dependent child bundles that have a sandbox.
11c By default, the dependent bundles are published to the next version. You can choose to 

select the Publish the dependent bundles as new bundles option to publish the dependent 
bundles as new bundles. 
Specify the name or browse to the folder where you want the new bundles to reside. If a 
bundle that has the same name as the new bundle already exists in the specified folder, 
then the new bundle is saved with a random GUID appended to its name. 

12 On the Summary Page, review the information and, if necessary, use the Back button to make 
changes to the information.

13 Click Finish to create the bundle. 

Publishing Multiple Sandbox as New Versions
Perform the following steps in the Endpoint Management Console:

1 Select a few bundle folders, bundle groups and bundles.
2 Click Action > Publish Bundle(s) to display the Publish Options page.
3 (Conditional) Select the Include bundles from subfolders also option to publish all the bundles 

within the selected folders as new versions of the bundles.This option is displayed only if you 
have selected a bundle folder in Step 1.

4 Click Next. On the Select Bundles page, select the bundles you want to publish to next version, 
then click Next.

5 (Conditional) If the bundle has any dependencies, the Publish Dependent Bundles Page is 
displayed. 
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This page lists all the bundles that the sandbox you want to publish depends on. These can 
include sandbox-only bundles (bundles that were directly created as a sandbox), or sandbox 
bundles (bundles that were edited to create a sandbox). To publish the sandbox, you must 
publish all the dependent sandbox-only bundles. However, you can choose to publish all the 
dependent sandbox bundles.
5a You must select the Publish sandbox only bundle(s) that this bundle depends on option to 

publish all the dependent child bundles that have a sandbox-only version. 
5b Select the Publish sandbox for all bundle(s) that this bundle depends on option to publish all 

the dependent child bundles that have a sandbox.
5c On the Summary Page, review the information and, if necessary, use the Back button to 

make changes to the information
6 Click Finish to create a new published version.

For example, if the Displayed Version option on the bundle page lists 0(Published), 1(Published), 
and Sandbox, publishing the sandbox as a new version creates a version 2. The Displayed 
Version option on the bundle page now lists 0(Published), 1(Published), and 2(Published). 

8.5 Dependency Bundles
When you create the following actions for a bundle, you create bundle dependencies:

 Action - Install Bundle
 Action - Launch Bundle
 Action - Uninstall Bundle
 Action - Repair Bundle

A bundle’s Dependency Bundles tree shows the chaining information of that bundle and the action 
sets that each dependency is in. To view the Dependency Bundles tree in Endpoint Management 
Console, click the Bundles tab, click a bundle that has dependent bundles, then on the Summary tab, 
click the Display Bundle Dependencies link in the Dependency Bundles row. If the selected bundle 
does not have dependent bundles, the link displays None instead of Display Bundle Dependencies.

The following sections contain additional information:

 Section 8.5.1, “Primary Applications vs. Dependent Applications,” on page 135
 Section 8.5.2, “Bundle Chains,” on page 135
 Section 8.5.3, “Distributing, Installing, and Launching a Bundle That Has Dependencies,” on 

page 136

8.5.1 Primary Applications vs. Dependent Applications
When working with bundle dependencies, the primary bundle is the bundle for which you are 
establishing dependencies. The bundles that are defined as dependencies are called the dependent 
bundles. The following illustration shows this relationship. Application A as the primary bundle with 
Applications B, C, and D as dependent bundles.
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Figure 8-1   Dependency Bundle Tree

A primary bundle can have one dependent application or, as shown in the above example, it can 
have multiple dependent applications.

In addition, a bundle can be both a primary bundle and a dependent bundle, as shown in the 
following illustration. Application A as the primary bundle, with Applications B, B1, B2, C, and D as 
dependent bundles.

Figure 8-2   Dependency Bundle Tree

In the above example, Application B is one of Application A's dependent bundles. At the same time, 
Application B has dependencies on two bundles, Application B1 and Application B2.

8.5.2 Bundle Chains
A bundle chain is two or more bundles linked together by dependencies. In its simplest form, a 
application chain consists of two levels, as shown in the following illustration.

Figure 8-3   Dependency Bundle Tree

However, when bundle dependencies are nested, a bundle chain can grow to include many levels. In 
the following example, Application A has a dependency on Application B. Application B, in turn, has 
dependencies on Application B1 and Application B2. As a result, all three bundles (B, B1, B2), in 
addition to applications C and D, must be present in order for Application A to run.
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Figure 8-4   Dependency Bundle Tree

In some cases, a bundle might belong to more than one bundle chain, as in the following example 
where Application D is a dependent application for both Application A and Application E.

8.5.3 Distributing, Installing, and Launching a Bundle That Has 
Dependencies
When setting up bundle dependencies, you should be aware of the following:

Bundle Assignment: A dependent bundle does not need to be assigned to devices or users. The 
primary bundle, however, must be assigned to one or more devices or users for it to function 
properly.

Distribution and Installation: If dependent bundles have not already been distributed to or installed 
on the user's workstation, when a user launches or installs a bundle, Endpoint Agent distributes and 
installs them. If Endpoint Agent is unable to distribute or install a dependent bundle (for example, 
the user’s workstation does not meet the dependent bundle’s system requirements), the primary 
bundle is not launched or installed.

Distribution Through an Add-On Image: If you distribute a bundle through an image add-on, its 
dependent bundles must be included as another image add-on. Otherwise, the distribution of the 
primary bundle fails.

Distribution to Disconnected Workstations: For disconnected workstations, the bundles must be 
force cached to the workstation before it becomes disconnected. If changes are made to dependent 
bundles after the bundles have been cached to workstations, the version number of the primary 
bundle must be updated in order to force a re-cache of the bundles.

Launch: Each time a bundle is launched, Endpoint Agent performs any launch operations, such as 
other actions, defined for its dependent bundles.

Reboot/Shutdown: Ensure that the dependent bundle does not include a Reboot / Shutdown 
action.

Redeploying a Bundle to Refresh Its Dependencies:  Endpoint Agent distributes a dependent 
bundle only once, unless the dependent bundle’s version is updated or the distribution or 
installation is unsuccessful. If you include a dependent bundle in a primary bundle through the 
Install action set, and if there are changes in the dependent bundle, you need to change the primary 
bundle to reflect the dependent bundle changes. If you include a dependent bundle in a primary 
bundle through the launch action set, and if there are changes in the dependent bundle, you need to 
launch the primary bundle again to reflect the dependent bundle changes.
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8.6 Retaining Older Bundle Version
You can configure the number of older bundle versions that you want to retain in Endpoint 
Management at the zone, folder and individual bundle levels. The order of precedence is bundle, 
folder and then zone. To navigate to the setting:

 Management Zone Level: Click Configuration> Management Zone > Bundle, Policy and Content > 
Older Bundle Versions Retain Setting

 Bundle Folder level: Click Details displayed on the bundle folder. Click Settings > Older Bundle 
Version Retain Setting.

 Bundle: Click a bundle. Click Settings > Older Bundle Version Retain Setting.

The available options include:

 Retain all versions: Select this option to retain all versions of the bundle. This includes the 
Published and Sandbox versions.

 Retain the specified number of older versions: Select this option to specify the number of 
older versions of the bundle to be retained. The number that you specify should be a positive 
integer and it should not include the Published and Sandbox versions as they are retained by 
default. 

For example: If a bundle has 5 versions and if you specify 2, then only the 2 versions prior to the 
currently published version will be retained along with Published and Sandbox versions. The 
remaining versions will be deleted.

 Do not retain any older versions: Select this option if you do not want to retain any older 
versions. This option retains only the Published and Sandbox versions.
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9 9Managing Bundle Assignments

OpenText™ Endpoint Management lets you assign bundles to devices. Device-assigned bundles are 
available whenever the device is running. 

You can manage a bundle assignment from the bundle’s Relationships page (Click the bundle and 
then the Relationship tab). The Relationships page is not affected by the bundle change 
management capability. 

NOTE: If you have different schedules configured for a bundle that is assigned to multiple objects 
such as devices, or their groups and folder assignments: 

  All the assigned schedules are applicable.
 The Shortcut Location assignments, which are configured to specify the locations on the 

managed device where Endpoint Agent displays the bundle’s icon, are merged and the shortcut 
is displayed in all configured locations.

Review the following sections:

 Section 9.1, “Assigning Existing Bundles to Devices,” on page 139
 Section 9.2, “Assigning a Bundle Group to Devices,” on page 142
 Section 9.3, “Execution of Scheduled Bundles,” on page 144

9.1 Assigning Existing Bundles to Devices
When you create bundles, the object is created without assigning devices to it, or specifying 
distribution, launch, or availability schedules. Before the bundle can be used on assigned devices, 
you must complete the steps in the following procedure. You can assign bundles to devices, device 
groups, or device folders.

The following procedure explains how to assign a bundle using Endpoint Management Console.

1 In Endpoint Management Console, click the Bundles tab.
2 Select the desired bundle in the Bundles list by clicking the box next to its name, click Action, 

then click Assign to Device.
A bundle must be assigned to devices before it can be distributed to them.
You can assign the bundle to individual devices, folders, or groups. Assigning a bundle to a 
folder or group is the preferred method of assigning bundles. This allows for easier 
management of the bundle assignments and can decrease the possibility of high server 
utilization caused by assigning the bundle to a large number of items (for example, more than 
250).

3 In the Select Objects dialog box, browse to and select the objects to which you want to assign 
the bundle.
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The Select Objects dialog box opens with the Devices folder as the root folder. By default, the 
Servers and Workstations folders are displayed along with any custom folders that you 
have created in the Devices folder.
Browse for and select the devices, groups, and folders to which you want to assign the bundle. 
To do so:
3a Click  next to a folder (for example, the Workstations folder or Servers folder) to 

navigate through the folders until you find the device, group, or folder you want to select. 
If you are looking for a specific item, such as a Workstation or a Workstation Group, you 
can use the Items of type list to limit the types of items that are displayed. If you know the 
name of the item you are looking for, you can also use the Item name box to search for the 
item.

3b Click the underlined link in the Name column to select the device, group, or folder and 
display its name in the Selected list box.

3c Click OK to add the selected devices, folders, and groups to the Devices list.
4 Specify the bundle’s shortcut location.

You can use the Shortcut Location assignments to specify the locations on the managed device 
where Endpoint Agent displays the bundle’s icon. 
The possible locations include the following:
Application Window: Places the icon in the Application window. This location is selected by 
default.
Quick Launch:  Places the icon on the Quick Launch area of the Windows taskbar.
Desktop: Places the icon on the device’s desktop.
System Tray: Places the icon in the system tray (notification area) of the Windows taskbar.
Start Menu: Places the icon on the Start menu on all Windows devices.
Taskbar: Places the icon on the taskbar.
Start Menu Tiles: Places the icon on the Start menu tiles. This is applicable only for Windows 10 
and later versions.

5 Click Next to display the Schedules page.
In the Schedules page select the schedules you want to define:
Distribution Schedule: Defines the dates and times when the content of the bundle is 
distributed from the Cloud Server to the managed device. If you do not establish a schedule, the 
bundle’s content is distributed to the device when it is first launched. However, the schedule 
does not define the date and time when the action in the bundle runs.
Installation Schedule: Defines the date and time when the bundle is installed from the Cloud 
Server to the managed device. If you do not configure a schedule, the bundle is installed to the 
device when it is first launched.
Launch Schedule: Defines the dates and times when the Endpoint Agent automatically launches 
the bundle. If you do not establish a schedule, the bundle is launched only when the user 
launches it. Before launching the bundle, the Endpoint Agent checks if the bundle is distributed 
and installed. If the bundle is not yet distributed, the agent first distributes the bundle, 
performs the bundle’s install actions to install the bundle, then performs the bundle’s launch 
actions to launch it.
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IMPORTANT: If Install Immediately after Distribution and Launch Immediately after Installation 
options are set for the distribution schedule of a bundle, the content of the bundle is 
distributed as per the schedule and, then the bundle is installed and launched. 
The Bundle that is distributed once will not be distributed again on the next schedule. Hence, 
the Install Immediately after Distribution and Launch Immediately after Installation options 
which are specified in the distribution schedule are not considered on subsequent schedules. 
To launch the same bundle repeatedly on subsequent schedules, you need to configure the 
launch schedule.

Availability Schedule: Defines the dates and times when the bundle is available to the device. 
The Endpoint Agent displays the bundle icon only during the times defined by the schedule. If 
you do not establish a schedule, the bundle is available at all times.

NOTE: If a bundle with an assignment schedule fails to execute on a device, an attempt to 
execute the bundle on the device is made five times, by default. 
To change the default value:

1. Open the Registry Editor.
2. Go to HKLM\software\OpenText\EndpointAgent.
3. Create a STRING called ScheduleRetries, and set its value as desired.

For example, if you do not want the failed bundle to be executed again on the device, set the 
value of the ScheduleRetries to 0.

6 (Conditional) If you selected Distribution Schedule in Step 5, click Next to display the Bundle 
Distribution Schedule page.
The distribution schedule defines the dates and times when the bundle is distributed from the 
Cloud Server to the managed device. The default schedule (no schedule) causes the bundle to 
be distributed to the device when it is first launched.

7 In the Schedule Type field, select one of the following schedules, then fill in the fields. For 
detailed information, click the Help button on the wizard page.
For the 'Now' schedule to be effective during bundle assignment, ensure that the number of 
devices to which you want to assign a bundle does not exceed 30. The Now schedule sets a 
refresh device schedule and triggers a bundle quick task. To assign bundles randomly to more 
than 30 devices, use the Quick Tasks option in Endpoint Management Console.
For more information on the quick tasks, see “Using Quick Tasks” in the Endpoint Management 
Console Reference.

8 Select the following options as desired:
Install Immediately After Distribution: Performs any installation actions immediately after the 
bundle is distributed to the device.
Launch Immediately After Installation: Performs any launch actions immediately after the 
bundle is installed. This option is available only if the Install Immediately After Distribution 
option is enabled. 

9 (Conditional) If you selected Launch Schedule in Step 5, click Next to display the Bundle Launch 
Schedule page.
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The launch schedule determines the dates and times when Endpoint Agent automatically 
launches the bundle. The default schedule (no schedule) results in the bundle only being 
launched if the user launches it.

10 In the Schedule Type field, select one of the following schedules, then fill in the fields. For 
detailed information, click the Help button on the wizard page.

11 (Conditional) If you selected Availability Schedule in Step 5, click Next to display the Bundle 
Availability Schedule page.
The availability schedule defines the dates and times when the bundle is available on the 
managed device. Endpoint Agent displays the bundle icon only during the times defined by the 
schedule. The default schedule (no schedule) makes the bundle available at all times.
The schedule applies regardless of whether or not the bundle is installed. For example, if a user 
has not yet installed the bundle, it is only available for installation at the times specified by the 
schedule. If a user has already installed the bundle, it is only available for running during the 
scheduled times.

12 In the Schedule Type field, select one of the following schedules, then fill in the fields. For 
detailed information, click the Help button.

13 Click Next to display the Finish page, review the information and, if necessary, use the Back 
button to make changes to the information.

14 Click Finish.

9.2 Assigning a Bundle Group to Devices
You can assign bundle group to devices, device groups, or device folders.

1 In Endpoint Management Console, click the Bundles tab.
2 In the Bundles list, select the check box next to the bundle group (or bundle groups).
3 Click Action > Assign to Device.
4 Browse for and select the devices, device groups, and device folders to which you want to 

assign the group. To do so:

4a Click  next to a folder (for example, the Workstations folder or Servers folder) to 
navigate through the folders until you find the device, group, or folder you want to select. 
If you are looking for a specific item, such as a Workstation or a Workstation Group, you 
can use the Items of type list to limit the types of items that are displayed. If you know the 
name of the item you are looking for, you can use the Item name box to search for the item.

4b Click the underlined link in the Name column to select the device, group, or folder and 
display its name in the Selected list box.

4c Click OK to add the selected devices, folders, and groups to the Devices list.
5 Specify the locations on the managed device where Endpoint Agent displays the bundle group’s 

icons. The possible locations are:
Application Window: Places the icons in the Application window.
Desktop: Places the icons on the device’s desktop.
Quick Launch: Places the icons on the Quick Launch area of the Windows taskbar.
142 Managing Bundle Assignments



Start Menu: Places the icons on the Start menu on all Windows devices except for Windows 
Vista and later. It places the icon in Start > All Programs on Windows Vista and later.
System Tray: Places the icons in the system tray (notification area) of the Windows taskbar.

6 Click Next to display the Schedules Page, then select the schedules you want to define. For 
information on schedules, see Step 5 in Assigning Existing Bundles to Devices (page 139).

7 (Conditional) If you selected Distribution Schedule in Step 6, click Next to display the Bundle 
Distribution Schedule page.
The distribution schedule defines the dates and times when the bundle is distributed from the 
Cloud Server to the managed device. The default schedule (no schedule) causes the bundle to 
be distributed to the device when it is first launched.

8 In the Schedule Type field, select one of the following schedules, then fill in the fields. For 
information, see Step 7 in Assigning Existing Bundles to Devices. 

9 Select the following options as desired:
Install Immediately After Distribution: Performs any installation actions immediately after the 
bundle is distributed to the device.
Launch Immediately After Installation: Performs any launch actions immediately after the 
bundle is installed. This option is available only if the Install Immediately After Distribution 
option is enabled.

10 (Conditional) If you selected Launch Schedule in Step 6, click Next to display the Bundle Launch 
Schedule page.
The launch schedule determines the dates and times when Endpoint Agent automatically 
launches the bundle. The default schedule (no schedule) results in the bundle only being 
launched if the user launches it.

11 In the Schedule Type field, select one of the following schedules, then fill in the fields. For 
information, see Step 10 in Assigning Existing Bundles to Devices. 

12 (Conditional) If you selected Availability Schedule in Step 6, click Next to display the Bundle 
Availability Schedule page.
The availability schedule defines the dates and times when the bundle is available on the 
managed device. Endpoint Agent displays the bundle icon only during the times defined by the 
schedule. The default schedule (no schedule) makes the bundle available at all times.
The schedule applies regardless of whether or not the bundle is installed. For example, if a user 
has not yet installed the bundle, it is only available for installation at the times specified by the 
schedule. If a user has already installed the bundle, it is only available for running during the 
scheduled times.

13 In the Schedule Type field, select one of the following schedules, then fill in the fields. For more 
information, see Step 12 in Assigning Existing Bundles to Devices. 

14 Click Next to display the Finish page, review the information and, if necessary, use the Back 
button to make changes to the information.

15 Click Finish.
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9.3 Execution of Scheduled Bundles
Scheduled bundles run in a serial manner. All scheduled bundle actions are added to a run queue on 
the agent side. The bundle actions are added to the queue according to the bundle schedule. 
However, the bundle actions are then executed in the order in which they were added to the queue. 
This design can result in bundles seeming to run off the schedule, if prior scheduled bundles have 
not finished their action sets by the time the next bundle schedule is reached.

Consider the following scenario:

 Bundle A is scheduled to launch at 10:00 AM and Bundle B is scheduled to launch at 10:30 AM. 
 The launch action set for Bundle A takes 1 hour to complete.
 Bundle B launches at 10:30 AM according to the schedule.
 However, the launch actions for Bundle B will start only at 11:00 AM after Bundle A’s launch 

actions have been completed. 

Now consider that Bundle B performs a reboot that should only have been performed at the 
scheduled time. In this case, to prevent the reboot from running at unwanted times, you would have 
to set action level system requirements. For example, an action level system requirement could be 
either to perform the reboot if a user is not logged into the workstation or to show a prompt 
allowing the user to cancel the reboot.

NOTE: The option Process immediately if device unable to execute on schedule does not apply in the 
above scenario. This option is only meant for scenarios where the workstation is not running when 
the scheduled time occurs.
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10 10Managing System Requirements

The System Requirements panel lets you define specific requirements that a device must meet for 
the bundle to be distributed to it.

You define requirements through the use of filters. A filter is a condition that must be met by a 
device in order for the bundle to be applied. For example, you can add a filter to specify that the 
device must have exactly 512 MB of RAM in order for the bundle to be applied, and you can add 
another filter to specify that the hard drive be at least 20 GB in size.

Review the following sections:

 Section 10.1, “Adding System Requirements for a Bundle,” on page 145
 Section 10.2, “Copying a Bundle’s System Requirements,” on page 150
 Section 10.3, “Copying a Bundle Group’s System Requirements,” on page 151

10.1 Adding System Requirements for a Bundle
1 In Endpoint Management Console, click the Bundles tab.
2 Click the underlined link for the desired bundle to display the bundle’s Summary page.
3 Click the Requirements tab.
4 Click Add Filter, select a filter condition from the drop-down list, then fill in the fields.

As you construct filters, you need to know the conditions you can use and how to organize the 
filters to achieve the desired results. For more information, see Section 10.1.1, “Filter 
Conditions,” on page 145 and Section 10.1.2, “Filter Logic,” on page 150.

5 (Conditional) Add additional filters and filter sets.
6 Click Apply to save the settings.

NOTE: After defining a bundle’s system requirements, you can copy its requirements and apply it to 
other bundles or policies. To do so, click the Bundles tab, select the check box in front of the bundle, 
click Edit, click Copy System Requirements, select Bundles or Policies, then click Add to select the 
bundles or policies to which you want to copy the selected bundle’s system requirements.

10.1.1 Filter Conditions
You can choose from any of the following conditions when creating a filter. Place your mouse pointer 
over fields that require input to display a tooltip containing example usage.

Bundle Installed: Determines if a specific bundle is installed. After specifying the bundle, the two 
conditions you can use to set the requirement are Yes and No. If you select Yes, the specified bundle 
must already be installed to meet the requirement. If you select No, the bundle must not be 
installed.
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Connected: Determines if the device is connected to the network. The two conditions you can use to 
set the requirement are Yes and No. If you select Yes, the device must be connected to the network 
to meet the requirement. If you select No, it must not be connected. 

Connection Speed: Determines the speed of the device’s connection to the network. The condition 
you use to set the requirement includes an operator and a value. The possible operators are equals 
(=), does not equal (<>), is greater than (>), is greater than or equal to (>=), is less than (<), and is less 
than or equal to (<=). The possible values are bits per second (bps), kilobits per second (Kbps), 
megabits per second (Mbps), and gigabits per second (Gbps). For example, if you set the condition to 
>= 100 Mbps, the connection speed must be greater than or equal to 100 megabits per second to 
meet the requirement.

Disk Space Free: Determines the amount of free disk space on the device. The condition you use to 
set the requirement includes a disk designation, an operator, and a value. The disk designation can 
be a local drive map (for example, c: or d:). The possible operators are equals (=), does not equal 
(<>), is greater than (>), is greater than or equal to (>=), is less than (<), and is less than or equal to 
(<=). The possible values are bytes (Bytes), kilobytes (KB), megabytes (MB), and gigabytes (GB). For 
example, if you set the condition to c: >= 80 MB, the free disk space must be greater than or equal 
to 80 megabytes to meet the requirement.

Disk Space Total: Determines the amount of total disk space on the device. The condition you use to 
set the requirement includes a disk designation, an operator, and a value. The disk designation can 
be a local drive map (for example, c: or d:). The possible operators are equals (=), does not equal 
(<>), is greater than (>), is greater than or equal to (>=), is less than (<), and is less than or equal to 
(<=). The possible values are bytes (Bytes), kilobytes (KB), megabytes (MB), and gigabytes (GB). For 
example, if you set the condition to c: >= 40 GB, the total disk space must be greater than or 
equal to 40 gigabytes to meet the requirement.

Disk Space Used: Determines the amount of used disk space on the device. The condition you use to 
set the requirement includes a disk designation, an operator, and a value. The disk designation can 
be a local drive map (for example, c: or d:). The possible operators are equals (=), does not equal 
(<>), is greater than (>), is greater than or equal to (>=), is less than (<), and is less than or equal to 
(<=). The possible values are bytes (Bytes), kilobytes (KB), megabytes (MB), and gigabytes (GB). For 
example, if you set the condition to c: <= 10 GB, the used disk space must be less than or equal to 
10 gigabytes to meet the requirement.

Environment Variable Exists: Determines if a specific environment variable exists on the device. 
After specifying the environment variable, the two conditions you can use to set the requirement 
are Yes and No. If you select Yes, the environment variable must exist on the device to meet the 
requirement. If you select No, it must not exist.

Environment Variable Value: Determines if an environment variable value exists on the device. The 
condition you use to set the requirement includes the environment variable, an operator, and a 
variable value. The environment variable can be any operating system supported environment 
variable. The possible operators are equal to, not equal to, contains, and does not contain. The 
possible variable values are determined by the environment variable. For example, if you set the 
condition to Path contains c:\windows\system32, the Path environment variable must 
contain the c:\windows\system32 path to meet the requirement.

File Date: Determines the date of a file. The condition you use to set the requirement includes the 
filename, an operator, and a date. The filename can be any filename supported by the operating 
system. The possible operators are on, after, on or after, before, and on or before. The possible dates 
are any valid dates. For example, if you set the condition to app1.msi on or after 6/15/24, 
the app1.msi file must be dated 6/15/2024 or later to meet the requirement.
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File Exists: Determines if a file exists. After specifying the filename, the two conditions you can use 
to set the requirement are Yes and No. If you select Yes, the specified file must exist to meet the 
requirement. If you select No, the file must not exist. 

File Size:  Determines the size of a file. The condition you use to set the requirement includes the 
filename, an operator, and a size. The filename can be any file name supported by the operating 
system. The possible operators are equals (=), does not equal (<>), is greater than (>), is greater than 
or equal to (>=), is less than (<), and is less than or equal to (<=). The possible sizes are designated in 
bytes (Bytes), kilobytes (KB), megabytes (MB), and gigabytes (GB). For example, if you set the 
condition to doc1.pdf <= 3 MB, the doc1.pdf file must be less than or equal to 3 megabytes to 
meet the requirement.

File Version:  Determines the version of a file. The condition you use to set the requirement includes 
the filename, an operator, and a version. The filename can be any file name supported by the 
operating system. The possible operators are equals (=), does not equal (<>), is greater than (>), is 
greater than or equal to (>=), is less than (<), and is less than or equal to (<=).

Be aware that file version numbers contain four components: Major, Minor, Revision, and Build. For 
example, the file version for calc.exe might be 5.1.2600.0. Each component is treated 
independently. For this reason, the system requirements that you set might not provide your 
expected results. If you do not specify all four components, wildcards are assumed.

For example, if you set the condition to calc.exe <= 5, you are specifying only the first 
component of the version number (Major). As a result, versions 5.0.5, 5.1, and 5.1.1.1 also meet the 
condition.

However, because each component is independent, if you set the condition to calc.exe <= 5.1, 
the calc.exe file must be less than or equal to version 5.1 to meet the requirement.

NOTE: If the file is missing and the ‘less than’ (<) operator is used, the system requirement will still 
be evaluated as true.

IP Segment: Determines the device’s IP address. After specifying the IP segment name using CIDR 
(Classless Inter-Domain Routing) format, the two conditions you can use to set the requirement are 
Yes and No. If you select Yes, the device’s IP address must match the IP segment. If you select No, the 
IP address must not match the IP segment.

You must specify the IP address using CIDR format. The number following the slash (/n) is the prefix 
length, which is the number of shared initial bits, counting from the left side of the address. The /n 
number can range from 0 to 32, with 8, 16, 24, and 32 being commonly used numbers. 

Examples:

123.45.67.12/16: Matches all IP addresses that start with 123.45.

123.45.67.12/24: Matches all IP addresses that start with 123.45.67.

The IPv6 block 2001:db8::/48 represents range of IPv6 addresses from 2001:db8:0:0:0:0:0:0 
to 2001:db8:0:ffff:ffff:ffff:ffff:ffff.

Memory: Determines the amount of memory on the device. The condition you use to set the 
requirement includes an operator and a memory amount. The possible operators are equals (=), 
does not equal (<>), is greater than (>), is greater than or equal to (>=), is less than (<), and is less 
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than or equal to (<=). The memory amounts are designated in megabytes (MB) and gigabytes (GB). 
For example, if you set the condition to >= 2 GB, the device must have at least 2 gigabytes of 
memory to meet the requirement.

Operating System - Windows: Determines the service pack level, server type, and version of 
Windows* running on the device. The condition you use to set the requirement includes a property, 
an operator, and a property value. The possible properties are service pack, server type, and version. 
The possible operators are equals (=), does not equal (<>), is greater than (>), is greater than or equal 
to (>=), is less than (<), and is less than or equal to (<=). The property values vary depending on the 
property. 

NOTE: Be aware that operating system version numbers contain four components: Major, Minor, 
Revision, and Build. For example, the Windows 2000 SP4 release’s number might be 
5.0.2159.262144. Each component is treated independently. For this reason, the system 
requirements that you set might not provide your expected results. 

For example, if you specify Operating System - Windows in the first field, Version in the second field, 
> in the third field, and 5.0 -Windows 2000 Versions in the last field, you are specifying only the first 
two components of the version number: Major (Windows) and Minor (5.0). As a result, for the 
requirement evaluated to true, the OS will have to be at least 5.1 (Windows XP). Windows 2003 is 
version 5.2, so specifying > 5.2 will also evaluate to true.

However, because each component is independent, if you specify the version > 5.0, Windows 2000 
SP4 evaluates to false because the actual version number might be 5.0.2159.262144. You can type 
5.0.0 to make the requirement evaluate as true because the actual revision component is greater 
than 0.

When you select the OS version from the drop-down, the Major and Minor components are 
populated. The Revision and Build components must be typed in manually.

Process Running: Determines if a process is running. After specifying the process name, the two 
conditions you can use to set the requirement are Yes and No. If you select Yes, the specified process 
must be running to meet the requirement. If you select No, the process must not be running.

Processor Family: Determines the device’s processor type. The condition you use to set the 
requirement includes an operator and a processor family. The possible operators are equals (=) and 
does not equal (<>). The possible processor families are Pentium, Pentium Pro, Pentium II, Pentium 
III, Pentium 4, Pentium M, WinChip, Duron, BrandID, Celeron, and Celeron M. For example, if you set 
the condition to <> Celeron, the device’s processor can be any processor family other than 
Celeron to meet the requirement. 

Processor Speed: Determines the device’s processor speed. The condition you use to set the 
requirement includes an operator and a processor speed. The possible operators are equals (=), does 
not equal (<>), is greater than (>), is greater than or equal to (>=), is less than (<), and is less than or 
equal to (<=). The possible processor speeds are hertz (Hz), kilohertz (KHz), megahertz (MHz), and 
gigahertz (GHz). For example, if you set the condition to >= 2 GHz, the device’s speed must be at 
least 2 gigahertz meet the requirement.

Registry Key Exists: Determines if a registry key exists. After specifying the key name, the two 
conditions you can use to set the requirement are Yes and No. If you select Yes, the specified key 
must exist to meet the requirement. If you select No, the key must not exist. 
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Registry Key Value: Determines if a registry key value meets a defined condition. The condition you 
use to set the requirement includes the key name, the value name, an operator, a value type, and a 
value data. The key and value names must identify the key value you want to check. The possible 
operators are equals (=), does not equal (<>), is greater than (>), is greater than or equal to (>=), is 
less than (<), is less than or equal to (<=), and contains (()). The possible value types are Integer Type 
(specify a decimal value) String Type, IP Address, and Version. The possible value data is determined 
by the key, value name, and value type. 

The ${EMPTY_VALUE} variable enables you to check for empty strings in the Registry Key Value 
requirements, on Windows devices.

If the value type is String Type, Endpoint Management compares only those values in the registry if 
the actual type in the registry is REG_STRING or REG_EXPANDED_STRING. 

If the value type is Integer, Endpoint Management compares only those values in the registry if the 
actual type in the registry is REG_DWORD.

Leave the key value field blank to use the default value. The default value of a registry key has no 
name and is displayed in regedit as (Default).

If the value type is IP Address, Endpoint Management compares only those values in the registry if 
the actual type in the registry is REG_STRING. 

If you have set the condition to Registry Key Value and selected IP Address as the value type, then the 
two conditions that you can use to set the requirements are Is in Subnet and Is not in Subnet. If you 
select Is in Subnet, then the thin-client IP address of the device must be within a specific subnet. If 
you select Is not in Subnet, then the thin-client IP address of the device must be outside the subnet. 

Specify the following in the text fields:

 Path of the registry key that should be compared
 Name of the registry value, for example: ViewClient_IP_Address
 IP Address of the network and a subnet mask to compare in order to determine if the device is 

within the segment (Example: 10.0.0.0/24)

Registry Key and Value Exists: Determines if a registry key and value exist. After specifying the key 
name and value, the two conditions you can use to set the requirement are Yes and No. If you select 
Yes, the specified key and value must exist to meet the requirement. If you select No, the key and 
value must not exist. 

Service Exists: Determines if a service with the given name exists in the Services list of the system. 
Specify a service name and ensure that the service name is not enclosed in quotes. After specifying 
the service name, the two conditions you can use to set the requirement are Yes and No. If you 
select Yes, the service must exist to meet the requirement. If you select No, the service must not 
exist. 

Service Running:  Determines if a service is running. After specifying the service name, the two 
conditions you can use to set the requirement are Yes and No. If you select Yes, the specified service 
must be running to meet the requirement. If you select No, the service must not be running.

Specified Devices: Determines if the device is one of the specified devices. After specifying the 
devices, the two conditions you can use to set the requirement are Yes and No. If you select Yes, the 
device must be included in the specified devices list to meet the requirement (an inclusion list). If 
you select No, the device must not be included in the list (an exclusion list).
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10.1.2 Filter Logic
You can use one or more filters to determine whether the bundle should be distributed to a device. 
A device must match the entire filter list (as determined by the logical operators that are explained 
below) for the bundle to be applied to the device.

There is no technical limit to the number of filters you can use, but there are practical limits, such as:

 Designing a filter structure that is easy to understand 
 Organizing the filters so that you do not create conflicting filters 

Filters, Filter Sets, and Logical Operators
You can add filters individually or in sets. Logical operators, either AND or OR, are used to combine 
each filter and filter set. By default, filters are combined using OR (as determined by the Combine 
Filters Using field) and filter sets are combined using AND. You can change the default and use AND 
to combined filters, in which case filter sets are automatically combined using OR. In other words, 
the logical operator that is to combine individual filters (within in a set) must be the opposite of the 
operator that is used between filter sets.

You can easily view how these logical operators work. Click both the Add Filter and Add Filter Set 
options a few times each to create a few filter sets, then switch between AND and OR in the Combine 
Filters Using field and observe how the operators change.

As you construct filters and filter sets, you can think in terms of algebraic notation parentheticals, 
where filters are contained within parentheses, and sets are separated into a series of parenthetical 
groups. Logical operators (AND and OR) separate the filters within the parentheses, and the 
operators are used to separate the parentheticals.

For example, “(u AND v AND w) OR (x AND y AND z)” means “match either uvw or xyz.” In the filter 
list, this looks like:

u AND
v AND
w
OR
x AND
y AND
z

Nested Filters and Filter Sets
Filters and filter sets cannot be nested. You can only enter them in series, and the first filter or filter 
set to match the device is used. Therefore, the order in which they are listed does not matter. You 
are simply looking for a match to cause the bundle to be applied to the device.

10.2 Copying a Bundle’s System Requirements
1 In Endpoint Management Console, click the Bundles tab.
2 In the Bundles list, select the check box next to the bundle.
3 Click Edit > Copy System Requirements.
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If more than one check box is selected, the Copy System Requirements option is not available on 
the Edit menu.

4 Select Bundles or Policies, then click Add to select the bundles or policies to which you want to 
copy the selected bundle’s system requirements.

10.3 Copying a Bundle Group’s System Requirements
1 In Endpoint Management Console, click the Bundles tab.
2 In the Bundles list, select the check box next to the bundle group.
3 Click Edit > Copy System Requirements.

If more than one check box is selected, the Copy System Requirements option is not available on 
the Edit menu.

4 Select Bundles or Policies, then click Add to select the bundles or policies to which you want to 
copy the selected bundle group’s system requirements.
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11 11Managing Action and Action Sets

The Actions panel displays the action sets available for the bundle. Depending on the bundle type, 
the possible action sets are Distribute, Install, Launch, Repair, Uninstall, Terminate.

You can add an action to any of the available action sets. When you do so, that action is performed 
whenever the action set is applicable. For example, when you add an action to the Install action set, 
that action is performed whenever the bundle is installed.

 Section 11.1, “Managing Actions,” on page 153
 Section 11.2, “Modifying Action Set Options,” on page 156

11.1 Managing Actions
When you create a bundle, all actions are enabled by default, meaning that after you add them to a 
action set, they run according to the action set’s options. However, not all action sets are enabled by 
default. You can choose to modify the action sets. For more information on modifying the action set 
options, see Section 11.2, “Modifying Action Set Options,” on page 156.

The following table lists the tasks you can perform to manage actions associated with the bundle. 
For more information on the different actions, see “Actions” on page 47.

Task Steps Additional Details

Add an action 1. If you are not already on the 
appropriate action set tab, click 
Distribute, Install, Launch, Repair, 
Uninstall, Terminate.

2. Click Add, then click the action you 
want to add.

3. Fill in the appropriate fields. Click 
the Help button in the Add Action 
dialog box for details.

4. Click Apply.

Remove an action 1. If you are not already on the 
appropriate action set tab, click 
Distribute, Install, Launch, Repair, 
Uninstall, Terminate.

2. Select the check box next to the 
action (or actions).

3. Click Remove.
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Edit an action 1. If you are not already on the 
appropriate action set tab, click 
Distribute, Install, Launch, Repair, 
Uninstall, Terminate.

2. Click the action’s name to display 
the edit page. 

3. Modify the desired settings. Click 
the Help button in the Edit Action 
dialog box for details.

4. After returning to the action set 
page, click Apply.

Reorder the actions 1. If you are not already on the 
appropriate action set tab, click 
Distribute, Install, Launch, Repair, 
Uninstall, Terminate.

2. Select the check box next to the 
action you want to move.

3. Click Move Up and Move Down to 
relocate it.

4. Click Apply.

The actions are performed in the order 
they are listed.

Enable an action to 
be performed

1. If you are not already on the 
appropriate action set tab, click 
Distribute, Install, Launch, Repair, 
Uninstall, Terminate.

2. Select the check box next to the 
action (or actions).

3. Click Enable.
4. Click Apply.

Prevent an action 
from being 
performed

1. If you are not already on the 
appropriate action set tab, click 
Distribute, Install, Launch, Repair, 
Uninstall, Terminate.

2. Select the check box next to the 
action (or actions).

3. Click Disable.
4. Click Apply.

Task Steps Additional Details
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Bypass an action that 
fails 

1. If you are not already on the 
appropriate action set tab, click 
Distribute, Install, Launch, Repair, 
Uninstall, Terminate.

2. Select the check box next to the 
action (or actions) you want to 
bypass on failure

3. Select the check box in the Continue 
on Failure column.

4. Click Apply.

Configure an action 
set’s options

1. If you are not already on the 
appropriate action set tab, click 
Distribute, Install, Launch, Repair, 
Uninstall, Terminate.

2. Click Options.
3. Modify the desired settings, then 

click OK to return to the action set 
page.

4. Click Apply.

Duplicate an action Enables you to create another action with 
similar configuration but with a small 
change.

1. Select the check box next to the 
action.

2. Click Duplicate.

Relocate an action Enables you to relocate a selected action 
to a different action set.

1. Select the check box next to the 
action.

2. Click Relocate.
3. Choose the required action set, then 

click OK.

Requirements The Requirements column displays 
whether you have configured the 
requirements or not. If you have not 
configured the requirements, click the 
icon in the column and then configure the 
requirements.

Task Steps Additional Details
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11.2 Modifying Action Set Options
When you create a bundle, all actions are enabled by default, meaning that after you add them to a 
action set, they run according to the action set’s options. However, not all action sets are enabled by 
default. The Install, Launch, and Terminate action sets are enabled, meaning that after you add an 
action, it runs on assigned devices according to its action set’s options. The Uninstall action set is not 
enabled by default. 

The following sections contain information about modifying action set options and enabling the 
Uninstall action set:

 Section 11.2.1, “Install Action Set Options,” on page 156
 Section 11.2.2, “Launch Action Set Options,” on page 157
 Section 11.2.3, “Uninstall Action Set Options,” on page 157
 Section 11.2.4, “Terminate Action Set Options,” on page 158

11.2.1 Install Action Set Options
The Install Options dialog box lets you specify the how often the bundle’s install actions are 
performed on managed devices and to specify if users can postpone the bundle’s installation. If the 
install action set or its options are modified and the bundle is re-published, then when the bundle is 
installed or launched, the install action set is invoked again, even if it has been set to install only 
once.

Bundle Change Management causes a change in the behavior of the Install action set on a device. 
For more information on the changed behavior, see Appendix C, “How Bundle Versions Affect an 
Install Action Set,” on page 189.

1 In the Endpoint Management Console, click the Bundles tab.
2 In the Bundles list, click a bundle’s underlined link in the Name column to display its Summary 

page.
3 Click the Actions tab, then click the Install tab.
4 Click Options to display the Install Options dialog box.
5 Specify how often you want the bundle’s install actions performed:

Install once per device: Performs the bundle’s install actions once on each managed device.
Install once per user per device: Performs the bundle’s install actions once for each user on 
each managed device.
Install always: Performs the bundle’s install action each time the bundle is run on the managed 
device.

6 Specify whether to allow users to postpone performing the bundle’s install actions and specify 
the number of postpones to allow.
Always allow postpones: Allow the user to postpone the installation an unlimited number of 
times.
Never allow postpones: Do not allow the user to postpone the installation.
Limit postpones to: Specify the number of times that the user can postpone the installation.

7 Click OK, then click Apply.
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11.2.2 Launch Action Set Options
The Launch Options dialog box lets you configure how often the bundle’s launch actions are 
performed on managed devices. By default, the launch actions are performed according to the 
bundle’s or when the user launches the bundle using its shortcut (from the Application Window, 
desktop, and so forth). If the launch action set or its options are modified and the bundle is re-
published, then when the bundle is launched, the launch action set will be invoked again even if it 
has been set to launch once.

As a part of the Launch Action, it is recommended that you only add an action that starts an installed 
application and not an action required to install an application.

1 In the Endpoint Management Console, click the Bundles tab.
2 In the Bundles list, click a bundle’s underlined link in the Name column to display its Summary 

page.
3 Click the Actions tab, then click the Launch tab.
4 Click Options to display the Launch Options dialog box.
5 Fill in the fields:

Select this option to configure the bundle’s launch actions, then select one of the following 
options. If you do not select this option (the default), the launch actions are performed each 
time a user launches the application contained in the bundle.
 For each device: Launches the bundle’s actions once on each managed device.
 For the first user that logs in: Launches the bundle’s actions once on each managed device 

when the first user logs in to that device. If subsequent users log in to the device, the 
action set is not launched. If you select this option, the bundle’s icon is removed from the 
device’s Application Window, desktop, and so forth.

 For every user that logs in: Launches the bundle’s actions for every user that logs in to the 
device.

6 Click OK, then click Apply.

11.2.3 Uninstall Action Set Options
The Uninstall Options dialog box lets you enable the application to be uninstalled, allow the user to 
perform the uninstall, and specify that the application is uninstalled if it is not used with in a 
specified number of days.

When you create a bundle, the Undo Install action is enabled by default; however, the Uninstall 
Action Set is not enabled. Therefore, in order for any actions in the action set to run (including the 
Undo Install action), you must enable the action set.

1 In the Endpoint Management Console, click the Bundles tab.
2 In the Bundles list, click the bundle’s underlined link in the Name column to display its Summary 

page.
3 Click the Actions tab, then click the Uninstall tab.
4 Click Options to display the Uninstall Options dialog box.
5 Select the Enable Uninstall option. The following uninstall options are available only if Enable 

Uninstall option is selected:
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User Options: 
Specify whether the user should be allowed to uninstall or cancel the uninstallation of an 
application from a device.
Allow User to perform uninstall: Select this option to enable users to remove the application 
from their devices. 
Display message to the user before uninstalling the application: Select this option to specify 
that a message warning the user that the application is going to be uninstalled from the device 
is displayed.
Allow user to cancel the uninstallation of the application: Select this option to specify 
whether the user can cancel the uninstallation of the application. You can enable this option 
only if the Display message to the user before uninstalling the application option is enabled.
Blocked Assignment Option: 
Uninstall application: Select this option to uninstall the blocked application from the device.
Other Options: 
Specify additional options to enable the uninstallation of the application from the device:
Uninstall application if not used within _ days: Select this option to automatically remove the 
application if the user has not run it within the specified number of days (the default is 30).
Ignore Chained Dependencies: Select this option to enable the uninstallation of a dependent 
application that is referenced by two or more applications. For example, consider three 
applications (A, B, and C), where C is the dependent application. Assume application A installs 
application C, and application B uninstalls application C. Application C is uninstalled only if 
Ignore Chained Dependencies is selected.
Do not uninstall application on unassignment: Select this option to prevent the application 
from being uninstalled after it is unassigned from the device or user.

6 Click OK, then click Apply.

11.2.4 Terminate Action Set Options
The Terminate Options dialog box lets you specify that the bundle’s actions can be terminated. This 
setting is used if a bundle has an availability. For example, if a bundle can be installed only between 
1 p.m. and 5 p.m. and the bundle is in the process of being installed at 5 p.m., the installation 
process terminates.

1 In the Endpoint Management Console, click the Bundles tab.
2 In the Bundles list, click the bundle’s underlined link in the Name column to display its Summary 

page.
3 Click the Actions tab, then click the Terminate tab.
4 Click Options to display the Terminate Options dialog box.
5 Select or deselect the Enable Terminate check box.
6 Click OK, then click Apply.
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12 12Accessing the Bundle Dashboard

The bundle dashboard consists of 5 default dashlets that display a summary of the assignment status 
and deployment status (distribute status, install status, and launch status) of an individual bundle. 
The dashlets can be grouped into following categories:

 Device Assignment Status:  Displays the assignment status of a bundle to devices.
 Deployment Status: A set of dashlets that displays the distribution, install and launch status of 

a bundle across device assignments. 

These dashlets also enable you to perform certain quick tasks such as uninstalling a bundle and 
blocking a bundle. For more information on pinning, unpinning and other dashboard actions, see 
Endpoint Management Dashboard Reference.

To navigate to the bundle dashlets, you need to click Bundles in the left pane in Endpoint 
Management Console, select a bundle and then click the Dashboard tab. You can pin these individual 
dashlets to the Bundle Home page, which is the Dashboard tab displayed when you click the Bundles 
menu in Endpoint Management Console. You can also pin the dashlet to the main Home Dashboard 
page. 

This chapter includes the following information:

 Section 12.1, “Device Assignment Status,” on page 159
 Section 12.2, “Bundle Deployment Status,” on page 163

12.1 Device Assignment Status
This dashlet displays the device assignment status for an individual bundle. Data in the device 
assignment status dashlet is displayed based on the effective assignment calculation that is 
periodically computed by the cloud server. The dashlet data is also displayed based on the 
information reported back by the device on whether the assignment is effective on the device or 
not.

When you access this dashlet immediately after assigning a bundle to a device, then no data will be 
displayed, as the effective assignment calculation is not yet computed by the cloud server. To trigger 
effective assignments immediately, click the Refresh dashlet icon, after which you can view the 
assignment status in the dashlet.

The assignment status information is categorized as:

 Effective: Indicates that the device meets the system requirements set for the bundle and the 
assignment is effective for the device.

 Not Effective: Indicates that the device does not meet the system requirements set for the 
bundle and the assignment is not effective for the device.

 Blocked: Indicates that the bundle has been blocked from executing on the device. 
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 Pending: Indicates that the assignment status of the bundle is yet to be determined due to 
reasons such as, the bundle is just assigned to the device, the device has not yet reported the 
status of the assignment. 

 Unknown: Indicates that the server is unable to determine the status of the bundle.

To determine how best to configure the dashlet for your organization’s needs, you can ask questions 
such as:

 How many devices to which the bundle is assigned, do not the meet the system requirements of 
the bundle? 

 How many duplicate assignments have been made to the device?

Filter the data displayed: To filter the data that the dashlet displays, expand and modify any of the 
sections in the Filter panel. The filters include Device Folders, Device Groups, Operating System, 
Device Type, and the Agent Version. Additionally, the following filters are also available based on 
which the displayed data can be modified:

Filter Description

Device Folders View devices based on the device folder to which the 
devices belong.

Device Groups View devices based on the device group to which the 
devices belong.

Operating System View devices based on the operating system version 
on the device.

Device Type View devices based on whether the device is a server 
or workstation.

Agent Version View devices based on the agent version installed on 
the device.

Bundle Version View devices based on the version of the bundle 
assigned to the device:

 Published
 Sandbox version

Assignment Status View devices based on the assignment status of the 
bundle:

 Unknown
 Effective
 Not Effective
 Pending
 Blocked

Assignment Status Time View devices based on the time at which the 
assignment status of the bundle was last updated or 
modified.
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The Device Assignment Status panel: Displays the devices that meet the criteria defined in the Filter 
panel. You can also filter the list by searching for a device name. The columns listed in this panel are:

Bundle Assignment View devices based on the manner in which the 
bundle was assigned, that is, whether the bundle was 
assigned directly or through a bundle group. On 
selecting the bundle name, only those devices to 
which the bundle was directly assigned, are 
displayed. 

On selecting the bundle group, all devices to which 
the bundle was assigned through a group are 
displayed. 

Device Assignment View devices based on the manner in which the 
device was assigned, that is, whether the device was 
assigned directly or whether the bundle was assigned 
to a device group or folder. On selecting the device 
name, only those devices that were direct 
assignments, are displayed. 

On selecting the device group or device folder, only 
those devices that were part of the device group or 
folder to which the bundle was assigned, are 
displayed. 

Column Name Description

Device The name of the device to which the bundle is 
assigned.

Agent Version The Endpoint agent version installed on the device.

Bundle Version The version of the bundle assigned to the device is 
displayed. By default the latest published version is 
displayed. The bundle version might be displayed as 
unknown, if the bundle is yet to be processed on the 
device.

Assignment Status The status of the assignment based on the selected 
bundle version assigned to the device is displayed. 
The statuses are:

 Unknown
 Effective
 Not Effective
 Pending
 Blocked

Assignment Status Time View devices based on the time at which the 
assignment status of the bundle was last updated or 
modified.

Filter Description
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Execute actions in the Device Assignment Status panel: The actions that you can execute on this 
panel are:

Status Processed Time View devices based on the time at which the status of 
the bundle, such as the assignment status or the 
deployment status, was last updated or modified

Not Effective Reason The reason for the bundle to be not effective on the 
device. Click the link to get more information on the 
status.

Bundle Assignment The manner in which the bundle is assigned. If the 
bundle is directly assigned to the device and a bundle 
group, to which the bundle belongs, is assigned to 
the device, then 2 is displayed. It determines the 
different ways in which the bundle is assigned to the 
device and helps in identifying duplicate assignments 
made for the device. 

Device Assignment The manner in which the device is assigned. If the 
bundle is assigned directly to the device and the 
bundle is assigned to a device group to which the 
device belongs, then 2 is displayed. It determines the 
different ways in which the bundle is assigned to the 
device and helps in identifying duplicate assignments 
made for the device.

Blocked Time The time at which the bundle was blocked from 
executing on the device. The time displayed is based 
on the local time on the server from which the 
bundle was blocked.

Device Folder The device folder to which the device belongs is 
displayed.

Device Type The type of device, that is, Servers or Workstation.

Operating System The operating system version on the device.

Task Description

Block Bundle Blocks the assignment from executing on the device. If the blocked bundle uninstalls 
from the device, the assignment status changes to Pending after the server side 
computation.

Unblock Bundle Unblocks a bundle assignment of a blocked bundle. The bundle assignment is 
reinstated and the bundle is executed on the device.

Refresh Device Refreshes the device so that any pending actions can immediately be initiated on the 
device. This quick task updates all information (bundle, policy, configuration settings, 
registration, and so forth) on the selected devices.

Column Name Description
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12.2 Bundle Deployment Status 
Bundle deployment status is a set of dashlets that provide a summary of the bundle status for the 
distribute, install and launch action sets across device assignments. The Dashboard feature provides 
default views for each of these action sets. However, you can configure and view each of these 
action sets within a single dashlet. The status of the deployment status dashlets is gathered when 
the devices reports the bundle status information to the server. Therefore, when you immediately 
access one of the deployment status dashlets, after assigning a bundle to a device, no data will be 
displayed for that version of the bundle, till the bundle is distributed, installed or launched on the 
device and the device reports this information back to the server. If you want this information to be 
reported back to the server immediately, click the Retrieve Bundle Status quick task.

The bundle status information for the distribute, install and launch action set is categorized as:

 Success: Indicates that the contents of the bundle are successfully distributed, installed or 
launched on the device.

 Failure: Indicates that the contents of the bundle have failed to distribute, install or launch on 
the device.

 Partial Success: Indicates that the distribute, install or launch of the bundle is partially 
successful if the bundle is executed, even though one or more of the bundle actions that was 
set to Continue on Failure have failed.

 Unknown: Indicates that the distribute, install or launch status of the bundle could not be 
determined by the Cloud Server. For example, the status will be unknown if the agent did not 
contact the Cloud Server after the bundle is assigned to the device. For more information on 
the scenarios in which the deployment status will be Unknown, see Unknown Status Scenarios. 

To determine how best to configure the dashlet for your organization’s needs, you can ask questions 
such as:

 How many instances of bundle failures exist and need to be addressed?
 How many instances of the bundle assignment made to the device are currently not active but 

the bundle is still installed on the device?
 How many devices do not have the latest published version of the bundle deployed on them?
 What is the time period for which you want to view the bundles that have failed to deploy?

Group the data displayed: You can group data to be displayed in the chart based on the action set, 
that is, distribute, install, or launch. For example, in the Bundle Distribution Status dashlet, you can 
change the Group Chart Data By value to Install, to view the install status of the bundle in the dashlet 

Retrieve Bundle 
Status

Obtains the latest bundle status from the selected devices and rolls up this 
information to the server. You can select from one of the following options:

 Differential scan: obtains the change in status of the bundles on the device 
since the last complete scan.

 Complete scan: runs a full scan to obtain the current status of all the bundles on 
the device.

Task Description
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chart. However, by changing the Group Chart Data By value, the columns in the Status panel will not 
be updated. You will have to manually select the relevant columns associated with the Group Chart 
Data By value.

The dashlet chart will display the instances of success, failure and other statuses for the selected 
action set. Therefore, for a given bundle-device combination, multiple records might be displayed in 
the chart.

Filter the data displayed: To filter the data that the dashlet displays, expand and modify any of the 
sections in the Filter panel. Along with general filters, this panel also includes tabs that contain filters 
specific to each action set (Distribute, Install, and Launch).

The default dashlets for each action set displays data based on the latest published version of the 
bundle. If you update the Group Chart Data By field to another action set in any of the default 
dashlets, to ensure accuracy of data, select the appropriate bundle version and other values in the 
corresponding filter of the updated action set. For example, in the Bundle Distribution Status 
dashlet, if you change the Group Chart Data By value to Install, select the Installed Version as 
Published (Latest Version) in the Install tab, which will enable you to view the install status of the 
current published version of the bundle.

If you apply filters in each of the action set tabs, the deployments that meet the conditions selected 
in each tab, are displayed. 

For example: 

Scenario 2: Consider you have 2 versions of a bundle of which version 2 is the published version of 
the bundle. In the default distribution status dashlet, you modify the Group Chart Data By to Install. 
In the filters, you select the Distribution Status in the Distribute filter as success, specify the Install 
Version in the Install filter as 1 and Install Status in the Install filter as Success. The Status Details 
panel will display those deployments for which the distribution status was successful for the latest 
published version of the bundle and the install status was successful for version 1of the bundle. The 
dashlet chart will display the status based on the Install action set selected in the Group Chart Data 
By section. 

General
The filters in this tab include Device Folders, Device Groups, Device Type, Platform, Operating 
System and Agent Version. Additionally, this tab also includes the following filters: 

Filter Description

Device Folders View deployments based on the device folder to 
which the devices belong.

Device Groups View deployments based on the device group to 
which the devices belong.

Device Type View deployments based on whether the device is a 
server, workstation.

Operating System View deployments based on the operating system 
version on the device.

Platform View deployments based on the operating system on 
the device.
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Distribute

Agent Version View deployments based on the agent version 
installed on the device.

Status Processed Time View deployments based on the time at which the 
bundle status was last processed by the Cloud Server. 

Assignment Source View deployments based device assignments.

Filter Description

Distributed Version View deployments based on any of the following 
versions of the bundle. 

 All lets you view the distribution status for all 
the versions of the bundle

 Published (Latest Version) lets you view the 
distribution status of the current published 
version of the bundle. This is the default value.

 Published (Older Version) lets you view the 
distribution status of the older versions of the 
bundle.

 Sandbox version lets you view the deployments 
of the sandbox version of the bundle.

 Custom lets you view the deployment status of a 
specified version of the bundle. You can specify 
a comma separated list of versions. The Sandbox 
version can be represented with value -1.

 Unknown lets you view the status for those 
deployments whose bundle version could not 
be determined. If this filter is selected, then the 
Distributed Version with empty values are 
displayed in the Status Details panel.

Distribution Time View deployments based on the date or time at 
which the action to distribute was performed on the 
device.

Distribution Status View deployments based on the following statuses:

 Success
 Partial Success
 Failure
 Unknown

Filter Description
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Install

Filter Description

Installed Version View deployments based on any of the following 
versions of the bundle:

 All lets you view the install status for all the 
versions of the bundle.

 Published (Latest Version) lets you view the 
install status of the current published version of 
the bundle. This is the default value.

 Published (Older Version) lets you view the 
install status of the older versions of the bundle.

 Sandbox version lets you view the deployments 
of the sandbox version of the bundle.

 Custom lets you view the deployment status of a 
specified version of the bundle. You can specify 
a comma separated list of versions. The Sandbox 
version can be represented with value -1.

 Unknown lets you view the status for those 
deployments whose bundle version could not 
be determined by the server. If this filter is 
selected, then the Installed Version with empty 
values are displayed in the Status Details panel.

Install Time View deployments based on the date or time at 
which the action to install the bundle was performed 
on the device.

Install Status View deployments based on the following statuses:

 Success
 Partial Success
 Failure
 Unknown

Installing Parent Bundle View deployments based on the parent bundle that 
last installed the bundle. Click Add or Remove to 
specify the parent bundle.
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Launch

Unknown Status Scenarios
The scenarios in which the deployment status will be displayed as Unknown are:

Scenario 1: When you access one of the Deployment Status dashlets, immediately after assigning a 
bundle to a device, no data will be displayed till the device reports the bundle status information. In 
the meantime, if you click the Refresh Dashlet icon, the status of the record will change to Unknown. 
However, you can view this record only if you change the bundle version filter from the default 
Published (Latest Version) to All or Unknown.

Filter Description

Launched Version View deployments based on any of the following 
versions of the bundle:

 All lets you view the launch status for all the 
versions of the bundle

 Published (Latest Version) lets you view the 
launch status of the current published version of 
the bundle. This is the default value.

 Published (Older Version) lets you view the 
launch status of the older versions of the 
bundle.

 Sandbox version lets you view the deployments 
of the sandbox version of the bundle.

 Custom lets you view the deployment status of a 
specified version of the bundle. You can specify 
a comma separated list of versions. The Sandbox 
version can be represented with value -1.

 Unknown lets you view the status for those 
deployments whose bundle version could not 
be determined by the server. If this filter is 
selected, then the Launch Version with empty 
values are displayed in the Status Details panel.

Launch Time View deployments based on the date or time at 
which the action to launch the bundle was performed 
on the device.

Launch Status View deployments based on the following statuses:

 Success
 Partial Success
 Failure
 Unknown

Launching Parent Bundle View deployments based on the parent bundle that 
last launched the bundle. Click Add or Remove to 
specify the bundles.
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Scenario 2: A bundle is assigned to a Device Group that contains three devices. The bundle is 
scheduled to deploy at a specific time. However, since all three devices are in different time zones, 
the deployment status is rolled back for Device 1. The deployment status dashlet will display only 
one record for the latest published version of the bundle. If you modify the bundle version filter to 
All, then all three records will be displayed and the status for Device 2 and Device 3 will be Unknown 
till the deployment status information is reported back by these devices.

The Status Details panel: The Status Details panel displays the devices that meet the criteria that 
you defined in the Filter panel. You can also use the search option to further filter the displayed 
records, based on the device name, distribution message, install message, and launch message. 
However, as some of these columns, such as distribution message and install message, might be 
hidden based on the selected dashlet type, no records will be displayed if a search is performed on 
the columns that are not visible in the Status Details panel.

The Status Details panel displays only those columns that are relevant to the dashlet and all other 
columns are hidden in the default view. For example, in the default Bundle Distribution Status 
dashlet, the columns relevant to distribution status are displayed. To view the install and launch 
status related columns within this dashlet, you can click the hamburger menu appearing in the right 
corner Status Details panel and select the relevant columns. 

Column Name Description

Device Indicates the name of the device.

Device Folder Path The device folder to which the device belongs, is 
displayed.

Operating System Indicates the operating system version on the device.

Agent Version Indicates the Endpoint agent version installed on the 
device.

Status Processed Time View deployments based on the time at which the 
bundle status was last processed by the Cloud Server.

Distributed Version Indicates the distributed version of the bundle. 

Distribution Status Indicates the distribution status for a specific 
distributed version of the bundle. The statuses can be 
Success, Partial Success, Failure or Unknown.

Distribution Time Indicates the date or time at which the action to 
distribute was performed.

Distribution Message Indicates the reason (if any) for failed or partially 
distributed bundles. This message is also displayed on 
the successful distribution of a mobile bundle.

Distribution Duration Indicates the time taken to distribute the bundle on 
the device.

Installed Version Indicates the installed version of the bundle.

Install Status Indicates the installation status for the specific 
installed version of the bundle. The statuses can be 
Success, Partial Success, Failure or Unknown.
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For information about other actions and options you have in the Status Details panel, see the 
following table:

NOTE: After implementing the quick tasks, it is recommended that you click the Refresh Dashlet icon 
to view the updated data in the dashlet grid. 

Installation Time Indicates the date or time at which the action to 
distribute was performed.

Install Message Indicates the reason (if any) for failed or partially 
installed bundles. This message is also displayed on 
the successful installation of a mobile bundle.

Installing Parent Indicates the parent bundle (if any) to which the 
bundle belongs that last installed the bundle.

Install Duration Indicates the time taken to install the bundle on the 
device.

Launched Version Indicates the launch version of the bundle.

Launch Status Indicates the launch status for the specific launch 
version of the bundle. The statuses can be Success, 
Partial Success, Failure or Unknown.

Launch Time Indicates the date or time at which the action to 
launch was performed.

Launch Message Indicates the reason (if any) for failed or partially 
launched bundles. This message is also displayed on 
the successful launch of a mobile bundle.

Launching Parent Indicates the parent bundle (if any) to which the 
bundle belongs that last launched the bundle.

Launch Duration Indicates the time taken to launch the bundle on the 
device.

Device Type Indicates the type of device, that is, server, 
workstation or mobile devices.

Platform Indicates the operating system on the device.

Assignment Source Indicates whether the assignment is a or device 
assignment.

Effective Assignment Exists Indicates whether the assignment is an active and an 
effective assignment. For example: If a bundle that is 
deployed to the device is disabled, the column will 
display No as the value, as the assignment is currently 
not effective on the device.

Column Name Description
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NOTE: A message displayed in the collapsed and expanded views of the bundle dashlets, indicates 
the time at which the bundle status was last computed by the cloud server. There might be 
discrepancies with the time displayed in the message in scenarios where the device has rolled back 
status information before bundle status computation on the server. 

To resolve these discrepancies and to view the latest bundle status for the selected bundle, click the 
Refresh Dashlet icon on any one of the dashlets of the selected bundle.

Task Description

Install Bundle This quick task installs the bundle immediately on one or more devices. For more 
information, see Bundle Quick Tasks.

Uninstall Bundle Uninstalls the bundle immediately on one or more devices. For more information, 
see Bundle Quick Tasks.

Launch Bundle Launches the bundle immediately on one or more devices. For more information, see 
Bundle Quick Tasks.

Block Assignment Blocks the bundle assignment from executing on the device. For a blocked bundle, 
the Deployment Status dashlet will display the last known status of the bundle and 
the Assignment Exists column will display ‘No’ as the value. If the blocked bundle 
uninstalls from the device, then the Deployment Status will change to Unknown, 
which can be viewed only if the Bundle Version filter is selected as Unknown or All. 

Unblock Assignment Unblocks an already blocked bundle on the device.

Refresh Device Refreshes the device so that any pending actions can immediately be initiated on the 
device. This quick task updates all information (bundle, policy, configuration settings, 
registration, and so forth) on the selected devices.

Retrieve Bundle 
Status

Obtains the latest bundle status from the selected devices and rolls up this 
information to the server. You can select from one of the following options:

 Differential scan: obtains the change in bundle status for all the bundles on the 
selected device since the last complete scan.

 Complete scan: runs a full scan to obtain the current status of all the bundles on 
the selected device.
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13 13Accessing Bundles on a Managed Device

The Endpoint Agent is part of the OpenText Configuration Management software that lets your 
administrator manage devices over the network. 

NOTE: This section contains information from the Agent online Help system and is written from the 
perspective of the end-user.

The Endpoint Agent, commonly referred to as the Agent, provides services that help your 
administrator do the following without visiting devices:

 Deliver software, and other files to your device
 Manage policies that determine the behavior of your device.
 Take inventory of your device’s hardware and software.
 Access your device from a remote location to troubleshoot and fix problems with hardware and 

software.

Software applications and other files are distributed to your device as bundles. A bundle contains all 
of the content (files, etc.) and instructions (registry modifications, shortcut information, etc.) 
required to install the software on the device.

The following information discusses how to manage bundles by using the Endpoint Agent:

 Section 13.1, “Bundles vs. Applications,” on page 171
 Section 13.2, “Device-Assigned Bundles,” on page 172
 Section 13.3, “Accessing Bundles,” on page 172
 Section 13.4, “Understanding Bundle Icons,” on page 176
 Section 13.5, “Launching a Bundle,” on page 177
 Section 13.6, “Postponing a Bundle Download,” on page 177
 Section 13.7, “Repairing a Bundle,” on page 177
 Section 13.8, “Viewing a Bundle’s Properties,” on page 178
 Section 13.9, “Uninstalling a Bundle,” on page 178

13.1 Bundles vs. Applications
Bundles are different than standard applications, such as Windows Notepad, that already reside on 
your device. When you double-click a bundle to launch it, the Endpoint Agent might first complete a 
variety of distribution tasks before the application is launched, including installing the application 
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files, running scripts, and changing the device’s registry, specific INI files, or environment variables. 
These tasks are all configured by your administrator to ensure that the application runs correctly on 
your device.

In some instances, a bundle’s icon appears dimmed or grayed out. This indicates that your device 
does not meet the requirements that the administrator defined for the application, or the bundle is 
not to be available to you at that time. The Agent does not distribute the application to your device 
until the requirements are met or the is appropriate.

13.2 Device-Assigned Bundles
The bundles that you see on your device are assigned to the device. Bundles assigned to your device 
are referred to as device-assigned bundles.

The Agent always displays the device-assigned bundles regardless of whether or not you are logged 
in. Device-assigned bundles can be launched by anyone who uses your device.

13.3 Accessing Bundles
The Endpoint Agent provides three ways for you to access the bundles that are assigned to you:

 Section 13.3.1, “Application Portal,” on page 172
 Section 13.3.2, “Application Explorer,” on page 174
 Section 13.3.3, “Agent Tray Icon,” on page 176

13.3.1 Application Portal
The Application Portal is a standalone window that you can launch from the Start menu or the 
command prompt.

 “Using the Start Menu” on page 172
 “Using the Command Prompt” on page 173
 “Using the Applications Portal as the Windows Shell” on page 174

Using the Start Menu
1 Click Start > Programs > OpenText Endpoint Agent > Application Portal

The Application Portal left pane displays the following:

 [All] folder: Contains all bundles that have been distributed to you, regardless of the folder in 
which they are located.

 Folder: Contains all bundles that have not been assigned to a different folder. The folder is the 
default folder for bundles; however, your administrator can create additional folders in which to 
organize bundles, and can even rename the folder.

 Favorites: Contains all bundles that have been set a favorite. This folder will be displayed only if 
the setting Enable Users to manage Favorites is enabled in the Application Explorer 
Configuration Policy.
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When you select a folder in the left pane, the right pane displays the bundles that are contained 
within the folder. You can:

 Install a bundle or launch an application for an already installed bundle.
 View the properties of a bundle. The properties include a description of the bundle, 

information about people to contact for help with the bundle, the times when the bundle is 
available for use, and the system requirements established for the bundle.

 Repair an installed application.
 Uninstall an application. This is an administrator-controlled feature that might not be enabled.
 Postpone Operation. This feature allows a user to postpone the download of contents until the 

next refresh. The postpone operation appears only when the content being downloaded is fairly 
large in size.

Using the Command Prompt
1 Open the command prompt and execute the following command:
zapp-launcher

The following command line switches can be used when starting the Application Window using 
zapp-launcher. 

Table 13-1   Application Window Command Line Switches

Switch Description

:

EXAMPLE: zapp-launcher:
Hides the initial splash screen.

/?

EXAMPLE: zapp-launcher /?
Displays the help.

/max
EXAMPLE: zapp-launcher /
max

Displays the Application Window maximized when first loaded, 
overriding the window state (size and position) that was saved 
when exiting the previous Application Window session.

/min
EXAMPLE: zapp-launcher /
min

Displays the Application Window minimized when first loaded, 
overriding the window state (size and position) that was saved 
when exiting the previous Application Window session.

/runonce
EXAMPLE: zapp-launcher /
runonce

This command is used for internal purposes and it is located at 
HKLM\SOFTWARE\Microsoft\Windows\CurrentVersion\
Run. Ensure that you do not delete it.
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 Using the Applications Portal as the Windows Shell
If the Applications Portal is used as a Windows shell, only the Applications Portal is visible on the 
device. You do not have access to the device desktop so the Start menu, Quick Launch toolbar, and 
the Agent Tray Icon are also not visible. Also, help is disabled on the device.

Using the Applications Portal as a Windows shell is useful in scenarios where you want to restrict the 
user on the managed device to access only the applications displayed in the Applications Portal. For 
example, if you want the user to access only applications such as Notepad and Calculator, ensure 
that the Applications Portal displays only these applications. To shut down the device, click File > 
Shutdown. 

To use the Applications Portal as a shell: 

1 On the Windows device, run regedit.exe and locate the following setting:

HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows 
NT\CurrentVersion\Winlogon\Shell

2 Change the SHELL value to:

Program Files\OpenText\Endpoint Agent\bin\zapplauncher.exe
3 Close regedit.exe.
4 Restart Windows.

13.3.2 Application Explorer
Application Explorer is an extension to Windows Explorer that enables bundles to be displayed in 
Windows Explorer, on the desktop, on the Start menu, on the Quick Launch toolbar, and in the 
notification area.

/s
EXAMPLE: zapp-launcher /s

Makes the Application Window act like the Windows shell. For 
example, on the File menu, the Exit Application Launcher option 
changes to Shutdown and gives the user the standard Windows 
shutdown options.

The Contents option on the Help menu is disabled. So, you cannot 
view the help.

This is not a true replacement for the Windows shell. If users 
minimize the Application Window, they have access to the normal 
desktop. 

/d
EXAMPLE: zapp-launcher /d

Displays the Application Window with the Contents option on the 
Help menu disabled. So, you cannot view the help. 

/norm
Example: zapp-launcher /
norm

Displays the Applications Portal window in its original state when 
first loaded, and maintains the window state (size and position) 
that was saved when exiting the previous Applications Portal 
window session.

Switch Description
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Figure 13-1   Bundles Displayed in Windows Explorer

Figure 13-2   Bundles Displayed on the Desktop

You can perform the same tasks on the bundles in the Application Explorer as you can in the 
Applications Portal.

NOTE: Windows does not allow certain characters in folder paths ( \ / : * ? “< > | ). If you use any of 
these characters as part of the name of the Application Explorer folder path, each character displays 
as an underscore ( _ ) in the Start menu. The characters display correctly in the Applications Portal.
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13.3.3 Agent Tray Icon
The Agent Tray Icon  is located in the Windows notification area. You can double-click the icon to 
display the Endpoint Agent properties. Located in the left navigation pane, the Bundles link lets you 
view the bundles that are assigned to you and to your device. 

The bundle list includes the following information:

 Name: Displays the name of the bundle. Click the name to display the properties for the 
bundle, including such information as the version, folder and icon locations, and help contacts.

 Version:  Displays the version of the bundle.
 Status: Displays the installation status for the bundle.
 Effective: Displays whether or not the bundle can be used on the device. If the Effective box is 

selected, the bundle meets all system requirements and constraints to be used. You can click 
the bundle icon  to launch the bundle. 
If the box is not selected, it cannot be used; to find out why, click the bundle name to display 
the system requirements and properties.

13.4 Understanding Bundle Icons
A bundle icon changes to reflect the current status of the bundle. The following table shows the 
bundle icons with the default light blue background icon. Your administrator might choose to use a 
different background icon; however, the status icons such as  and , remain the same. 

Icon Status

Available. You can launch the bundle.

Not Installed. 

The bundle failed to install. Right-click the icon, then click Repair to repair the bundle.

Unavailable. You cannot launch the bundle. Either the device does not meet the system 
requirements established for the bundle.

Installing. The bundle is installing to the device.

Downloading. The bundle is downloading from the network location where it is stored.

Uninstalling. The bundle is being removed from the device.

Running. The bundle is currently running.

Downloaded: Downloaded but not installed: The bundle has been downloaded on the device. 
However, it has not been installed as yet.

Blocked. The bundle is blocked on the device. You cannot perform any of the actions on the 
bundle other than viewing its properties.
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13.5 Launching a Bundle
By default, the Endpoint Agent does not distribute (download and install) a bundle to your device 
until the first time you launch it. The distribution process might include installing the bundle’s files, 
running scripts, and changing the device’s registry, specific INI files, or environment variables. Or, the 
process might include nothing more than providing a shortcut to the application's executable file on 
your local device or a network server.

To launch a bundle:

1 Access the bundle in one of the following locations:
Applications Portal:  Press the Windows logo key, and then type Applications Portal..
Application Explorer: Open Windows Explorer and find the  Endpoint Agent entry. 
Depending on how your Endpoint Management administrator configured the bundle, the 
bundle icon might also be displayed on the desktop, Start menu, Quick Launch toolbar, Start 
Menu Tiles, Task Bar, or notification area. 

2 Double-click the bundle icon.

13.6 Postponing a Bundle Download
If, after you launch a bundle, it begins to download and you need to stop the download, you can 
postpone the download to a later time. When you resume the download, it continues from the point 
where it previously stopped.

1 Access the bundle in one of the following locations:
Applications Portal:  Press Windows logo key, and then type Applications Portal .
Application Explorer: Open Windows Explorer and find the  Endpoint Agent entry. 
Depending on how your Endpoint Management administrator configured the bundle, the 
bundle icon might also be displayed on the desktop, Start menu, Quick Launch toolbar, Start 
Menu Tiles, Task Bar, or notification area. 

2 Right-click the bundle icon, then click Postpone.

13.7 Repairing a Bundle
If an installed application is not functioning correctly or you think it might be outdated, you can 
repair that the application’s bundle information is still correct. If it is not, the Endpoint Agent 
reinstalls the bundle to your workstation.

1 Access the bundle in one of the following locations:
Applications Portal:  Press Windows logo key, and then type Applications Portal .

Favorite: The bundle is set as a favorite.

Icon Status
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Application Explorer: Open Windows Explorer and find the  Endpoint Agent entry. 
Depending on how your Endpoint Management administrator configured the bundle, the 
bundle icon might also be displayed on the desktop, Start menu, Quick Launch toolbar, Start 
Menu Tiles, Task Bar, or notification area. 

2 Right-click the bundle icon, then click Repair.

13.8 Viewing a Bundle’s Properties
You can view a bundle’s properties to see its version number, current installation status, and help 
contacts. In addition, if the bundle is unavailable, you can see if it is unavailable because of system 
requirements or restrictions.

To view a bundle’s properties:

1 Access the bundle in one of the following locations:
Applications Portal: Press the Windows logo key, and then type Applications Portal.
Application Explorer: Open Windows Explorer and find the  Endpoint Agent entry. 
Depending on how your Endpoint Management administrator configured the bundle, the 
bundle icon might also be displayed on the desktop, Start menu, Quick Launch toolbar, Start 
Menu Tiles, Task Bar, or notification area. 

2 Right-click the bundle icon, then click Properties.

13.9 Uninstalling a Bundle
Uninstall is an administrator-controlled feature. By default, uninstall is not enabled, which means 
that you can only uninstall bundles if your administrator has enabled the feature. Uninstall is 
enabled on a per-bundle basis. Depending on what your administrator enables, you might be able to 
uninstall some bundles but not others.

When you uninstall a bundle, the Endpoint Agent removes all files from your device and undoes all 
configuration settings made to your device during the bundle installation. Only files that the 
Endpoint Agent installs specifically for the bundle are removed. For example, the Endpoint Agent 
does not remove any shared files (files used by another application) or any user-created files such as 
word processing documents or spreadsheets.

After you uninstall a bundle, the bundle’s icon remains on your device. This enables you to install the 
bundle again whenever necessary.

To uninstall a bundle:

1 Access the bundle in one of the following locations:
Applications Portal: Press the Windows logo key, and then type Applications Portal.
Application Explorer: Open Windows Explorer and find the  Endpoint Agent entry. 
Depending on how your Endpoint Management administrator configured the bundle, the 
bundle icon might also be displayed on the desktop, Start menu, Quick Launch toolbar, Start 
Menu Tiles, Task Bar, or notification area. 

2 Right-click the bundle icon, then click Uninstall.
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A AInstall, Uninstall, and Repair MSI 
Bundle Parameters

While creating Windows MSI bundles, you can select install, uninstall, and repair parameters. The 
following sections contain information to help you select the desired options:

 Section A.1, “Install Parameters,” on page 179
 Section A.2, “Uninstall Parameters,” on page 181
 Section A.3, “Repair Parameters,” on page 182

A.1 Install Parameters
The Install Parameters dialog box lets you specify the desired parameters.

Figure A-1   Install Parameters Dialog Box
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The following sections contain additional information:

 Section A.1.1, “Restart Options,” on page 180
 Section A.1.2, “Display Options,” on page 180
 Section A.1.3, “Install Options,” on page 181
 Section A.1.4, “Command Line Parameters,” on page 181

A.1.1 Restart Options
In some cases, installing an application requires restarting the workstation.

In the Install Parameters dialog box, select the desired Restart option:

None (default): Uses the MSI application’s settings to determine whether or not a restart occurs. 
Endpoint Management does not force a Restart option. 

Do Not Restart (/norestart): Never restarts the workstation during the install process. The 
installation is not completed until the next time the workstation starts.

Prompt For Restart (/promptrestart): Prompts users before restarting the workstation. If users 
answer No, the installation is not completed until the next time they manually restart.

Always Restart (/forcerestart): Forces the workstation to restart without prompting users.

A.1.2 Display Options
In the Install Parameters dialog box, select the desired Display options. You can choose to perform 
the installation with or without a user interface, whether to display a modal dialog box at the end of 
the install process (a modal dialog box demands a response from the user before the installation is 
complete), or to hide the Cancel button so that users cannot cancel the installation.

No UI (/qn): Installs the application with no user interface (silent installation).

NOTE: This is the default installation option. If you want users to be aware that OpenText 
Configuration Management is installing an application to help prevent them from rebooting or 
calling the help desk, change the display options to Basic UI (/qb) with No modal dialog at end (-) and 
Hide Cancel button (!). 

You can select the options in the dialog box or you can type /i /qb-! in the Command Line 
Parameters field.

Full UI (/qf): Installs the application with the full user interface and a modal dialog box displayed at 
the end of the installation. 

Reduced UI (/qr): Installs the application with a reduced user interface and a modal dialog box 
displayed at the end of the installation.

Basic UI (/qb): Installs the application with a basic user interface consisting of a progress bar. The 
following settings are available with this option: 

 No modal dialog at end (-): Displays a basic user interface with no modal dialog box displayed 
at the end of the installation.
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 Modal dialog at end (+): Displays a basic user interface with a modal dialog box displayed at the 
end of the installation.

 Hide Cancel button (!): Displays a basic user interface without a Cancel button, so the user 
cannot cancel the installation process.

A.1.3 Install Options
In the Install Parameters dialog box, select the desired Install options:

Install (/i): Installs the application.

Administrative Install (/a): Creates an administrative installation point for the application. This 
option is useful for a network installation.

For All Users (/im): Advertises the application on the computer and installs the application for all 
users on first use.

For Logged In User Only (/iu): Advertises the application on the computer for the logged-in 
(current) user and installs the application on first use. Do not use this option when performing a 
System installation or when using a dynamic administrator to install the application.

A dynamic administrator is an administrator account that is created on the fly to perform certain 
procedures, such as installing applications. Using a dynamic administrator is helpful when installing 
applications (some MSI applications, for example) that cannot be installed in the system space. 
When you select this action, the dynamic administrator is created, it performs the required tasks, 
and then the account is deleted.

A.1.4 Command Line Parameters
Displays the install command line parameters used during the application’s installation. As you 
select Restart, Display, and Install options, the command line parameters in this field are 
automatically populated.

A.2 Uninstall Parameters
The Uninstall Parameters dialog box lets you specify the desired parameters.

The following sections contain additional information:

 Section A.2.1, “Restart Options,” on page 181
 Section A.2.2, “Display Options,” on page 182
 Section A.2.3, “Command Line Parameters,” on page 182

A.2.1 Restart Options
In some cases, uninstalling an application requires restarting the workstation.

SIn the Uninstall Parameters dialog box, select the desired Restart option:

None (default): Uses the MSI application’s settings to determine whether or not a restart occurs. 
Endpoint Management does not force a Restart option. 
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Do Not Restart (/norestart): Never restarts the workstation during the uninstall process. The 
uninstallation is not completed until the next time the workstation starts.

Prompt For Restart (/promptrestart): Prompts users before restarting the workstation. If users 
answer No, the uninstallation is not completed until the next time they manually restart.

Always Restart (/forcerestart): Forces the workstation to restart without prompting users.

A.2.2 Display Options
In the Uninstall Parameters dialog box, select the desired Display options. You can choose to perform 
the uninstallation with or without a user interface, whether to display a modal dialog box at the end 
of the uninstallation process (a modal dialog box demands a response from the user before the 
uninstallation is complete), or to hide the Cancel button so that users cannot cancel the 
uninstallation.

No UI (/qn): Uninstalls the application with no user interface (silent uninstallation).

Full UI (/qf): Uninstalls the application with the full user interface and a modal dialog box displayed 
at the end of the uninstallation. 

Reduced UI (/qr): Uninstalls the application with a reduced user interface and a modal dialog box 
displayed at the end of the uninstallation.

Basic UI (/qb): Uninstalls the application with a basic user interface consisting of a progress bar. The 
following settings are available with this option: 

 No modal dialog at end (-): Displays a basic user interface with no modal dialog box displayed 
at the end of the uninstallation.

 Modal dialog at end (+): Displays a basic user interface with a modal dialog box displayed at the 
end of the uninstallation.

 Hide Cancel button (!): Displays a basic user interface without a Cancel button, so the user 
cannot cancel the uninstallation process.

A.2.3 Command Line Parameters
Displays the command line parameters used during the application’s uninstallation. As you select 
Restart and Display options, the command line parameters in this field are automatically populated.

A.3 Repair Parameters
The Repair Parameters dialog box lets you specify the desired parameters.
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Figure A-2   Repair Parameters Dialog Box

The following sections contain additional information:

 Section A.3.1, “Restart Options,” on page 183
 Section A.3.2, “Display Options,” on page 184
 Section A.3.3, “Repair Options,” on page 184
 Section A.3.4, “Command Line Parameters,” on page 185

A.3.1 Restart Options
In some cases, repairing an application requires restarting the workstation.

In the Repair Parameters dialog box, select the desired Restart option:

None (default): Uses the MSI application’s settings to determine whether or not a restart occurs. 
Endpoint Management does not force a Restart option.

Do Not Restart (/norestart): Never restarts the workstation during the repair process. The repair 
process is not completed until the next time the workstation starts.

Prompt For Restart (/promptrestart): Prompts users before restarting the workstation. If users 
answer No, the repair process is not completed until the next time they manually restart.

Always Restart (/forcerestart): Forces the workstation to restart without prompting users.
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A.3.2 Display Options
In the Repair Parameters dialog box, select the desired Display options. You can choose to perform 
the repair process with or without a user interface, whether to display a modal dialog box at the end 
of the repair process (a modal dialog box demands a response from the user before the repair 
process is complete), or to hide the Cancel button so that users cannot cancel the repair process.

No UI (/qn): Repairs the application with no user interface (silent repair process).

Full UI (/qf): Repairs the application with the full user interface and a modal dialog box displayed at 
the end of the repair process. 

Reduced UI (/qr): Repairs the application with a reduced user interface and a modal dialog box 
displayed at the end of the repair process.

Basic UI (/qb): Repairs the application with a basic user interface consisting of a progress bar. The 
following settings are available with this option: 

 No modal dialog at end (-): Displays a basic user interface with no modal dialog box displayed 
at the end of the repair process.

 Modal dialog at end (+): Displays a basic user interface with a modal dialog box displayed at the 
end of the repair process.

 Hide Cancel button (!): Displays a basic user interface without a Cancel button, so the user 
cannot cancel the repair process.

A.3.3 Repair Options
In the Repair Parameters dialog box, select the desired Repair options:

Missing File (p): Instructs Windows Installer to repair a file only if it is missing.

Older File (o): Instructs Windows Installer to repair a file if it is missing or if the installed file’s 
version is older than the file in the MSI package.

Equal or Older File (e): Instructs Windows Installer to repair a file if it is missing or if the installed 
file’s version is the same as or older than the file in the MSI package.

Different File Version (d): Instructs Windows Installer to repair a file if it is missing or if the installed 
file’s version is not exactly the same as the file in the MSI package.

Force All (a): Instructs Windows Installer to repair all files.

User Registration Keys (u): Instructs Windows Installer to repair all per-user entries from the MSI 
package to the Windows system registry. Per-user entries are those entries contained in the 
HKEY_CURRENT_USER and HKEY_USERS registry hives.

Computer Registry Keys (m): Instructs Windows Installer to repair all per-machine entries from the 
MSI package to the Windows system registry. Per-machine entries are those entries contained in the 
HKEY_LOCAL_MACHINE and HKEY_CLASSES_ROOT registry hives.

Failed Checksum (c): Instructs Windows Installer to perform a checksum on all executable files and 
to repair a file if it is missing or if the checksum verifies that the file is corrupt. Only files that have 
msidbFileAttributesChecksum in the Attributes column of the MSI package’s File Table are 
repaired.
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Install and Re-Cache (v): Instructs Windows Installer to repair files from the re-cache (local) source 
rather than the source package.

Shortcut(s): Instructs Windows Installer to repair the MSI application’s shortcuts, overwriting any 
existing shortcuts and icons.

A.3.4 Command Line Parameters
Displays the command line parameters used during the application’s repair process. As you select 
the Restart, Display, and Repair options, the command line parameters in this field are automatically 
populated.
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B BAuthentication Hook

An authentication hook enables you to control the installation or launching of the bundle. 

Create an executable file containing your authentication logic and begin its name with authhook. 
For example, authhookinstall.exe. During the installation or launching of the bundle, the 
bundle manager searches for a file matching authhook*.* in the bin directory of Endpoint 
Management. If the file is found, the bundle manager passes four arguments: zone name, bundle ID, 
and bundle name of the current bundle to the file. On execution, the file returns a code. The bundle 
manager installs or launches the bundle only if the returned error code matches 264.
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C CHow Bundle Versions Affect an Install 
Action Set

Bundle Change Management results in a change in the behavior of the Install action set on a device 
if the install frequency option of the action set is configured either to install once per device.

 Section C.1, “Triggers that Cause an Install Action Set to Run,” on page 189
 Section C.2, “Sample Scenario,” on page 189
 Section C.3, “Additional Scenarios,” on page 190

C.1 Triggers that Cause an Install Action Set to Run
If you assign a bundle to a device, the Install action set runs on the device only in the following 
circumstances:

 If the Install action set has never run on the device. 
 If the version of the Install action set is different from the version of the Install action set that 

has previously run on the device
The Install action set of a bundle is internally associated with a global version identifier and the 
Install action set of every bundle version is internally associated with a local version identifier.
If you make any modifications to a bundle other than modifying its Install action set, the Install 
action set of the sandbox that is created has the same local version identifier as the bundle 
version you modified. However, if you modify the Install action set of a bundle, the global 
version identifier of the bundle’s Install action set is incremented by one and the modified 
Install action set’s local version identifier is set to the new value of the global version identifier. 

If the install action set or its options are modified and the bundle is re-published, then when the 
bundle is installed or launched, the install action set is invoked again, even if it has been set to install 
only once. 

C.2 Sample Scenario
For example, consider the following scenario:

1. In Endpoint Management Console, create a bundle (not as a sandbox).

The bundle version, the global version identifier of the bundle’s Install action set, and the local 
version identifier of the created bundle version are all set to 0 (zero).

2. In the Install action set of the bundle, add one or more actions and then click Apply.
The global version identifier for the Install action set is incremented to 1.

3. Click Publish to publish the sandbox as version, 1.
The local version identifier of this published version also changes to 1.
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4. Assign the bundle to Device A. 
The bundle runs on Device A and the actions in the Install action set of the latest published 
version of the bundle, which has the local version identifier set to 1, are executed on the device.

5. Modify the Install action set of the bundle and click Apply.
The global version identifier is incremented to 2.

6. Repeat Step 5 twice more.
The global version identifier is incremented to 4.

7. Click Publish to publish the sandbox as version, 2
The local version identifier of this published version also changes to 4.

8. Assign the bundle to Device B. 
The bundle runs on Device B and the actions in the Install action set of the latest published 
version of the bundle, which has the local version identifier set to 4, are executed on the device.

C.3 Additional Scenarios
Perform the tasks listed in the following table to understand the subsequent behavior of the Install 
action set on Device A and Device B. When you begin, Device A has an Install action set with version 
1 (see Step 4) and Device B has an Install action set with version 4 (see Step 6) in Section C.2, 
“Sample Scenario,” on page 189.

Task Device A Device B 

Modify the Install action set of the 
latest published version to create a 
sandbox and then publish the 
sandbox.

Starting value of the local version 
identifier: 4

New value of the local version 
identifier: 5

The actions in the Install action set 
of the latest published version of 
the bundle, which has the local 
version identifier set to 5, are 
executed on the device.

The actions in the Install action set 
of the latest published version of 
the bundle, which has the local 
version identifier set to 5, are 
executed on the device.

Modify a property of bundle other 
than the Install action set of the 
latest published version to create a 
sandbox and then publish the 
sandbox.

Starting value of the local version 
identifier: 4

New value of the local version 
identifier: 4

The actions in the Install action set 
of the latest published version of 
the bundle, which has the local 
version identifier set to 4, are 
executed on the device.

Because the version of the 
previously run Install action set on 
the device is the same as the value 
of the local version identifier, the 
Install action set does not run on 
the device.
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If a sandbox version of a bundle is assigned to a test device, the execution of the Install action set 
depends on whether the action set is modified or not. Even though there is no change in the bundle 
version, the action set runs on the device if it has been modified.

NOTE: When you have a bundle that references a file on a share and if the file in the share location 
has changed, you need to modify the action set in which you are referring the file, if you want the 
bundle to be reinstalled with the new file.

Create a sandbox from an older 
version of the bundle, modify the 
Install action set to create a 
sandbox, and then publish the 
sandbox.

Starting value of the local version 
identifier: 4

New value of the local version 
identifier: 5

The actions in the Install action set 
of the latest published version of 
the bundle, which has local version 
identifier set to 5, are executed on 
the device.

The actions in the Install action set 
of the latest published version of 
the bundle, which has local version 
identifier set as 5, are executed on 
the device.

Create a sandbox from an older 
version of the bundle, modify a 
property of the bundle other than 
the Install action set to create a 
sandbox, and then publish the 
sandbox.

Starting value of the local version 
identifier: 4

New value of the local version 
identifier: 4

Because the version of the 
previously run Install action set on 
the device is the same as the value 
of the local version identifier, the 
Install action set does not run on 
the device.

The actions in the Install action set 
of the latest published version of 
the bundle, which has the local 
version identifier set to 1, are 
executed on the device.

Task Device A Device B 
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D DBest Practices

The following sections contain information on the best practices to follow while using the Bundles 
component of Endpoint Management:

 Section D.1, “Assigning Bundles to a Device,” on page 193
 Section D.2, “Application Explorer Folder Naming Convention,” on page 193
 Section D.3, “Creating Bundles with Large Content,” on page 193

D.1 Assigning Bundles to a Device
Do not assign more than two bundles that has the same name to a Windows managed device 
because only the first two bundles that are assigned to the device are displayed on the device.

Sample Scenario: Assume that bundles named test, Test, TEST are assigned to a Windows managed 
device. The first bundle that is assigned to the device has the specified name. The second bundle 
that is assigned to the device has the management zone name appended to the specified name. 
However, the third bundle is not displayed on the device.

D.2 Application Explorer Folder Naming Convention
If the Application Explorer Folder name for two or more bundles is the same but has a different case, 
then only one folder and containing all the bundle's shortcuts is displayed in the start menu and the 
Application Explorer window.

D.3 Creating Bundles with Large Content
By default, Endpoint Management Console has a 30-minute timeout value. If you choose to create 
bundles with a large amount of content, you must change the Endpoint Management Console 
timeout value as required. For information on the changing the timeout value for Endpoint 
Management Console, see “Changing the Timeout Value for Endpoint Management Console”in the 
Endpoint Management Console Reference.
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E ETroubleshooting

The following sections explains the scenarios that you might encounter while using the Bundles 
component of OpenText Endpoint Management.

 “Uninstallation of MSIX bundle fails when using Quick Tasks” on page 195
 “Bundle icons not displayed at their original positions after System restart” on page 195
 “Installation of MSIx bundle using Quick Tasks fails” on page 196
 “While launching applications, the window prompting for user input might not be displayed” on 

page 196
 “The Undo Install Actions fails to uninstall a directory” on page 196
 “Repairing an MSI that is installed on a device might reboot the device even if the norestart 

parameter is specified” on page 196
 “Unable to import an exported registry file into the Windows registry” on page 197
 “When you select either the Sandbox or an old version of a bundle or policy, the status is not 

displayed in the summary page of the bundle or policy” on page 197

Uninstallation of MSIX bundle fails when using Quick Tasks
Explanation: When you try to uninstall an MSIX bundle on a device using Quick Tasks > 

Uninstall Bundle, the uninstallation of the MSIX bundle fails.

Possible Cause: The Quick Tasks action initiated from server runs for targeted device in device 
session, whereas the MSIX installation and uninstallation are user specific 
actions and cannot be run for device. Because of this reason, the uninstall of 
MSIX bundle fails when run by Quick Tasks.

Action: None.

Bundle icons not displayed at their original positions after System restart
Explanation: When you change the position of bundle icons (bundle desktop shortcuts) on 

the desktop of any Windows device, and restart the device, then the icons on 
the desktop are displayed at a different position every time the device is 
restarted.

Possible Cause: Endpoint Management has a logic to delete all the bundle icons on the desktop 
during log-off and recreate bundle icons after log-in, which exposes an error in 
the Explorer shell implementation. The position of these icons is managed by 
the APP_SETTING_ENABLE_AUTO_CLEANUP registry key in Endpoint 
Management.

The deletion and creation of desktop icons when performed by Endpoint Agent, 
the Windows Explorer shell cannot handle this. This is a known behavior of 
Microsoft Windows Explorer.
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Action: The deletion and creation of desktop icons should be handled by Windows 
Explorer shell. To do so, set the APP_SETTING_ENABLE_AUTO_CLEANUP 
registry key value to false. This registry key is available at the path: 
HKEY_LOCAL_MACHINE\SOFTWARE\OpenText.

Installation of MSIx bundle using Quick Tasks fails
Explanation: When you try to install an MSIX bundle on a device using Quick Tasks > Install 

Bundle, the installation of the MSIx bundle fails.

Possible Cause: This issue occurs because the MSIx action runs in the ‘user’ space, while the 
quick task runs in the ‘system’ space.

Action: None

While launching applications, the window prompting for user input 
might not be displayed

Source: Endpoint Management; Software Distribution.

Explanation: If you use bundles to launch applications that require user input, the window 
prompting for the input might be hidden behind the application. This problem 
might occur if the applications are launched for the first time for each user login. 

Action: If you want to immediately view the window, minimize the application. To fix the 
problem, restart the system.

The Undo Install Actions fails to uninstall a directory
Source: Endpoint Management; Software Distribution.

Explanation: When you create an Install Directory File bundle, the directory is installed even 
if its name contains spaces; however, it cannot currently be uninstalled by using 
the Undo Install Actions action.

Action: Avoid spaces in directory names if you want to enable the uninstallation of that 
directory.

Repairing an MSI that is installed on a device might reboot the device 
even if the norestart parameter is specified 

Source: Endpoint Management; Software Distribution.

Explanation: If you run the Install MSI action to repair an MSI that has already been installed 
on a device, the device might reboot. This is because /f option that repairs a 
product can reboot the device. For more information, see Microsoft Support 
Site (http://support.microsoft.com/kb/961883/EN-US).

Action: Perform the following steps to repair a package without a reboot: 

1 In Endpoint Management Console, click the MSI Application Bundle you 
want to repair.

2 Click Actions > Install. 
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3 Click the Install MSI action to display the Edit Action - Install MSI dialog box. 

4 In the Repair Parameters option, Click  to display the Repair Parameters 
dialog box. 

5 In the Command Line Parameters option, specify /i instead of /f, then 
click OK.

6 In the MSI Properties panel, add the following properties:
 Name = REINSTALLMODE ; Value = omus 
 Name = REBOOT ; Value = ReallySupress 

7 Click OK.

Unable to import an exported registry file into the Windows registry
Source: Endpoint Management; Software Distribution.

Explanation: On platforms that use non-Western European languages, a registry file exported 
by using the Endpoint Management Registry Edit action might contain values 
that prevent the registry file from being imported into the Windows registry.

Action: To export the registry file:

1 In Endpoint Management Console, click a bundle.
2 Click Actions > Registry Edit.
3 Click Export to export the registry file.

To import the registry file into the Windows registry:

1 Edit the exported registry file to remove values such as 
ffffffffffffffb0 from the file.

2 Import the file into the Windows registry.
3 Use the Windows Regedit utility to reenter the values that you removed in 

Step 1.
For more information on reentering the values, refer to the Registry Edit 
Action page of Endpoint Management Console.

When you select either the Sandbox or an old version of a bundle or 
policy, the status is not displayed in the summary page of the bundle or 
policy

Source: Endpoint Management; Software Distribution

Explanation: After assigning a bundle that has the sandbox and the published versions to a 
device, if you select either an old version or a sandbox version of the bundle, 
the Bundle Status information is not displayed in the summary page of the 
bundle or policy.

Action: There is no workaround.
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